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CHAPTER
ONE

WHAT IS SCRIPTING?

A script is a series of commands that tells Illustrator to perform one or more tasks. These tasks can be simple, affecting
only one object in the current document, or complex, affecting objects in all your Illustrator documents.

The tasks might even involve other applications, like word processors, spreadsheets, and database management pro-
grams.

For the most part, the building blocks of scripting correspond to the Illustrator tools, menus, panels, and dialog boxes
with which you are already an expert. If you know what you want Illustrator to do, you can write a script to do it.

1.1 Why use scripting?

Graphic design is a field characterized by creativity, but aspects of the work are anything but creative. In fact, you
probably notice that the time you spend placing and replacing images, correcting errors in text, and preparing files for
printing at an image-setting service provider often reduces the time you have available for doing creative work.

With a small investment of time and effort, you can learn to write short, simple scripts that perform repetitive tasks for
you. As your scripting skills grow, you can move on to more complex scripts.

Scripting also can enhance your creativity, by quickly performing tasks you might not have time to try. For example,
you could write a script to systematically create a series of objects, modifying the new objects’ position, stroke, and
fill properties along the way. You also could write a script that accesses built-in transformation matrix functions to
stretch, scale, and distort a series of objects. Without scripting, you would likely miss out on the creative potential of
such labor-intensive techniques.

1.2 What about actions?

Both actions and scripts are ways of automating repetitive tasks, but they work very differently:

* Actions use a program’s user interface to do their work. As an action runs, menu choices are executed, objects
are selected, and recorded paths are created.

Scripts do not use a program’s user interface to perform tasks, and scripts can execute faster than actions.
» Actions have very limited facilities for getting and responding to information.

You cannot add conditional logic to an action; therefore, actions cannot make decisions based on the current
situation, like changing the stroke type of rectangles but not ellipses.

Scripts can get information and make decisions and calculations based on the information they receive from
Illustrator.
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* A script can execute an action, but actions cannot execute scripts.

2 Chapter 1. What is Scripting?



CHAPTER
TWO

What’s new and changed for scripting?

CHANGELOG

2.1 lllustrator 24.0 (CC 2020) <>

e Added: Document.getPageltemFromUuid()
e Added: Pageltem.uuid

2.2 lllustrator XX.X (CC 2017) <>

e Added: Application.getlsFileOpen()

2.3 lllustrator XX.X (CC) <>

?
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4 Chapter 2. Changelog



CHAPTER
THREE

SCRIPTING LANGUAGE SUPPORT IN ADOBE ILLUSTRATOR CC

Ilustrator scripting supports VBScript and JavaScript scripts for Windows, and AppleScript and JavaScript scripts for
Mac OS.

3.1 Script file extensions

For a file to be recognized by Adobe Illustrator CC 2017 as a valid script file, the file must have the correct file name
extension:

Script Type File type (extension) Platforms
AppleScript compiled script (.scpt ) OSAS file (no extension) | Mac OS
JavaScript or ExtendScript | text ( .js or .jsx) Windows Mac OS
VBScript text (.vbs) Windows

3.2 JavaScript development options

You can use the ExtendScript Toolkit to create JavaScript scripts explicitly for Illustrator, or you can use Adobe Exten-
sion Builder and the Creative Cloud SDK to develop extensions in ActionScript.

Extensions are Flash-based (SWF) and can potentially work in a variety of Creative Cloud applications.

3.2.1 Developing a CC extension using ActionScript

Creative Cloud applications have an extensibility infrastructure that allows developers to extend the capabilities of the
applications; the infrastructure is based on Flash/Flex technology, and each extension is delivered as compiled Flash
(SWF) file.

Creative Cloud includes the Extension Manager to enable installation of extensions.

An example of an extension that ships with the point products is Adobe Kuler. Kuler has a consistent user interface
across the different suite applications, but has different logic in each, adapted to the host application.

The user interface for an extension is written in ActionScript, using the Flex framework. An extension is typically
accessed through its own menu item in the application’s Extensions menu.
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Adobe Extension Builder allows you to design the user interface interactively using the Design view of Flash Builder.
The Creative Cloud SDK also allows you to develop all of the application logic for your extension in ActionScript; you
can develop and debug your extension in the familiar Flash Builder environment.

To develop your application logic, we recommend using the ActionScript Wrapper Library ( CSAWLIib ), which ex-
poses the scripting DOM of each host application as an ActionScript library. This is tightly integrated with the Adobe
Extension Builder environment, which includes wizards to help you build your extension’s basic structure, and run and
debug your code against suite applications such as Adobe InDesign, Photoshop and Illustrator.

The methods, properties, and behavior of the scripting DOM is as described in the JavaScript Scripting Reference for
the host application.

For details of how to use Adobe Extension Builder and the wrapper libraries, see the Creative Cloud SDK documenta-
tion, which is accessible from within Adobe Extension Builder.

3.2.2 Scripting plug-ins

The CC JavaScript scripting interface allows for limited scripting for plug-ins. A plug-in can define a command,
with an event and notifier, and a handler that performs some action. A JavaScript script can then use the app.
sendScriptMessage() method to send parameters to that plug-in-defined command, and receive a plug-in-defined
response.

For example, the Adobe Custom Workspace plug-in defines a command “Switch Workspace”. A script can invoke this
command with the following code

result = app.sendScriptMessage (
"Adobe Custom Workspace",
"Switch Workspace",
'<workspace="Essentials" >

)H

In this case, the value that the plug-in returns is the string

"<error= errNo>".

3.2.3 ExtendScript features
If you write Illustrator-specific scripts that use the Illustrator JavaScript DOM directly, you will create ExtendScript
files, which are distinguished by the .jsx extension.

Giving your JavaScript files a .jsx extension (rather than the standard .js extension for a JavaScript file) allows you to
take advantage of ExtendScript features and tools.

ExtendScript offers all standard JavaScript features, plus a development and debugging environment, the ExtendScript
Toolkit (ESTK).

The ESTK is installed with all scriptable Adobe applications, and is the default editor for JSX files. The ESTK includes
an Object Model Viewer that contains complete documentation of the methods and properties of JavaScript objects.
For information on accessing the ESTK and the Object Model Viewer see Viewing the object model.

ExtendScript also provides various tools and utilities, including the following:
* A localization utility
¢ Tools that allow you to combine scripts and direct them to particular applications

* Platform-independent file and folder representation

6 Chapter 3. Scripting language support in Adobe lllustrator CC
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* Tools for building user interfaces to your scripts

* A messaging framework that allows you to send and receive scripts and data among scripting-enabled Adobe
applications

All of these features are available whether you use the DOM directly with a JSX file, or indirectly through the Ac-

tionScript wrapper library and Adobe Extension Builder. For details of these and other features, see JavaScript Tools
Guide.

3.2. JavaScript development options 7
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8 Chapter 3. Scripting language support in Adobe lllustrator CC



CHAPTER
FOUR

VIEWING SAMPLE SCRIPTS

Adobe provides sample scripts for many objects, properties, and methods in the 1llustrator CC DOM. You can view
script samples in two locations:

* Inthe /Scripting/Sample Scripts/ folder in your lllustrator CC installation directory

e In this document :)
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10 Chapter 4. Viewing Sample Scripts



CHAPTER
FIVE

VIEWING THE OBJECT MODEL

Each of the supported scripting languages provides a facility for viewing the scripting objects defined by Illustrator,
with reference details.

5.1 Viewing the JavaScript object model

To view the JavaScript object model for Illustrator, follow these steps:

In a default Adobe installation, the ESTK is in the following location:

Win- \system drive\Program Files\Adobe\Adobe Utilities CC\ExtendScript Toolkit CC

dows

Mac OS \system drive\Applications\Utilities\Adobe Utilities CC\ExtendScript Toolkit
CcC

1. Start the ESTK.
2. In the ESTK, choose Help > Object Model Viewer.
3. In the Object Model Viewer window, select Adobe 1llustrator CC Type Library from the Browser drop-down list.

Several extended sample scripts are in the /Scripting/Sample Scripts/ folder in your Illustrator CC installation
directory.

You also can view script samples and information about individual classes, objects, properties, methods, and parameters
in Illustrator Scripting Reference: Javascript.

5.2 Viewing the AppleScript object model

Apple provides a Script Editor with all Mac OS systems. You can use Script Editor to view the AppleScript dictionary
that describes Illustrator objects and commands.

For details of how to use Script Editor, see Script Editor Help.

Note: In a default Mac OS installation, Script Editor is in Applications/AppleScript/Script Editor

If you cannot find the Script Editor application, you must reinstall it from your Mac OS system CD.

11



lllustrator Scripting Guide, Release 0.0.1

1. Start Script Editor.
2. Choose File > Open Dictionary. Script Editor displays an Open Dictionary dialog.
3. In the Open Dictionary dialog, find and select Adobe lllustrator CC, and click Open.

Script Editor displays a list of the Illustrator objects and commands, which include the properties and elements associ-
ated with each object and the parameters for each command.

Several extended sample scripts are in the /Scripting/Sample Scripts/ folder in your Illustrator CC installation
directory.

You also can view script samples and information about individual classes, objects, properties, methods, and parameters
in Illustrator Scripting Reference: Applescript.

5.3 Viewing the VBScript object model

VBScript provides a type library you can use to view Illustrator object properties and methods. This procedure explains
how to view the type library through any Microsoft Office program. Your VBScript editor probably provides access to
the library. For information see your editor’s Help.

1. In any Microsoft Office application, choose Tools > Macro > Visual Basic Editor.

2. In the Visual Basic Editor, choose Tools > References.

3. In the dialog that appears, select the check box for Adobe lllustrator CC Type Library, and click OK.

4. Choose View > Object Browser, to display the Object Browser window.

5. Choose “Illustrator” from the list of open libraries in the top-left pull-down menu of the Object Browser window.

Several extended sample scripts are in the /Scripting/Sample Scripts/ folder in your lllustrator CC installation
directory.

You also can view script samples and information about individual classes, objects, properties, methods, and parameters
in Illustrator Scripting Reference: VBScript.

12 Chapter 5. Viewing the object model



CHAPTER
SIX

EXECUTING SCRIPTS

The Illustrator interface includes a Scripts menu (File > Scripts) that provides quick and easy access to your scripts.
Scripts can be listed directly as menu items that run when you select them. See Installing scripts in the Scripts menu.

You can navigate from the menu to any script in your file system and then run the script. See Executing scripts from
the Other Scripts menu item.

You also can have JavaScript scripts with a .jsx extension start automatically when you launch the application. For
information, see Startup scripts (.jsx scripts only).

6.1 Installing scripts in the Scripts menu

To include a script in the Scripts menu (File > Scripts), save the script in the Scripts folder, located in the /111lustrator
CC/Presets folder in your lllustrator CC installation directory.

The script’s filename, minus the file extension, appears in the Scripts menu.

Scripts that you add to the Scripts folder while Illustrator is running do not appear in the Scripts menu until the next
time you launch Illustrator.

Any number of scripts can be installed in the Scripts menu. If you have many scripts, use subfolders in the Scripts
folder to help organize the scripts in the Scripts menu.

Each subfolder is displayed as a separate submenu containing the scripts in that subfolder.

6.2 Executing scripts from the Other Scripts menu item

The Other Scripts item at the end of the Scripts menu (File > Scripts > Other Scripts) allows you to execute
scripts that are not installed in the Scripts folder.

Selecting Other Scripts displays a Browse dialog, which you use to navigate to a script file. When you select the file,
the script is executed.

Only files that are of one of the supported file types are displayed in the browse dialog. For details, see Scripting
language support in Adobe Illustrator CC.

13
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6.3 Startup scripts (.jsx scripts only)

JavaScript scripts with a .jsx file extension can be installed in one of two folders, so the scripts run automatically when
you launch Illustrator and each time you run a script.

The folders are:
* An application-specific startup scripts folder, which contains scripts for IllustratorCC

* A general startup scripts folder, which contains scripts that run automatically when you start any Creative Cloud
application

6.3.1 Application-specific startup scripts folder
You must place application-specific startup scripts in a folder named Startup Scripts, which you create in the I1lustrator
installation directory.

For example, when IllustratorCC is installed to its default location, you would create the Startup Scripts folder at the
following location:

Windows | C:\Program Files\Adobe\Adobe lllustratorCC\Startup Scripts\
Mac OS /Applications/Adobe lllustrator CC/Startup Scripts/

JavaScript scripts with a .jsx extension placed in the Startup Scripts folder run automatically when:
* The application is launched.

* Any JavaScript file is selected from the Scripts menu (File > Scripts).

6.3.2 General startup scripts folder

The general startup scripts folder contains scripts that run automatically when you start any Creative Cloud application.

You create the folder in the following location:

Windows | /Program Files/Common Files/Adobe/Startup Scripts CC/Illustrator
Mac OS /Library/Application Support/Adobe/Startup Scripts CC/Illustrator

If a script in the general startup folder is meant to be executed only by Illustrator, the script must include the ExtendScript
#target directive ( #target illustrator ) or code like the following

if (BridgeTalk.appName == "illustrator") {
// continue executing script

}

14 Chapter 6. Executing Scripts




CHAPTER
SEVEN

THE ILLUSTRATOR SCRIPTING OBJECT MODEL

A good understanding of the Illustrator object model will improve your scripting abilities. The following figure shows
the containment hierarchy of the object model, starting with the application object.

Note that the layer and group item classes can contain nested objects of the same class which can, in turn, contain
additional nested objects.
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In addition to this application-specific object model, JavaScript provides certain utility objects, such as the File and
Folder objects, which give you operating-system-independent access to the file system.

For details, see JavaScript Tools Guide.

16 Chapter 7. The lllustrator Scripting Object Model
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CHAPTER
EIGHT

OBJECT NAMING CONVENTIONS

There is one object model for the Illustrator scripting interface, but actual object names vary slightly in the different
scripting languages:

* AppleScript names are lower case, and individual words are separated by a space; for example: graphic style

* VBScript names are capitalized, and additional words in the name are indicated by uppercase initial letters; for
example: GraphicStyle

* JavaScript names begin with lowercase letters, and additional words in the name are indicated by uppercase initial
letters; for example: graphicStyle

This chapter uses generic object and property names, but you can easily apply these conventions to determine the
corresponding language-specific names.

Throughout this document, names of properties, methods, and object are in a monospaced font.

17
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18 Chapter 8. Object Naming Conventions



CHAPTER
NINE

TOP-LEVEL (CONTAINING) OBJECTS

Use these objects to access global information about the Illustrator application or an individual document.

9.1 Application

The properties of the application object give your script access to global values, such as:

» User preferences, which a user sets interactively in the Illustrator application by using the Preferences dialog
(Edit > Preferences).

» System information like installed fonts (the text fonts property) and printers (the printer list property).

Also, there are properties that provide application-specific information and higher-level information about any open
documents:

* Application information like the installation path, version, and whether Illustrator is visible.
* The current active document; that is, the art canvas that is displayed and accepting user input.
e All open documents.
The application object’s methods or commands allow your script to perform application-wide actions; for example:
¢ Open files
¢ Undo and redo transactions

¢ Quit Illustrator

9.2 Document

The document object, which your scripts can create or access through the application object, represents an art
canvas or loaded Illustrator file.

The document object’s properties give you access to the document’s content; for example:
» The current selection, or art objects that the user selected in the document
* All contained art objects, called page items, that make up the artwork tree
* Art objects of particular types, like symbols and text frames

e All layers and the currently active layer

19
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Document properties also tell you about the state of the document itself; for example:
» User settings for the document, such as ruler units
* Whether the document was saved since the last alteration of content
¢ The path of the associated file
The document object’s methods allow your scripts to act on the document; for example:
* Save to an [llustrator file or save as the various supported file formats
e Activate or close a document

e Print the document. Your scripts can select a printer by referencing a print options object, or they can
reference available printers through the application object’s printer list property.

9.3 Layer

The layer object provides access to the contents, or artwork tree, of a specific layer.
You access the layer object through the document object.
The layer object properties provide access to, or information about, the layer, such as:
* Whether the layer is visible or locked.
* The layer’s opacity (overall transparency) and z order position (position in the stacking order).

* Art-creation preferences for the layer, like artwork knockout and blending mode.

20 Chapter 9. Top-Level (containing) Objects



CHAPTER
TEN

THE ARTWORK TREE

The content of an Illustrator document is called the artwork tree. Artwork is represented by the following objects:
e compound path item
e graph item
e group item
e legacy text item
e mesh item
* non native item
e path item
* placed item
e plugin item
* raster item
e symbol item (see Dynamic Objects)
e text frame
Your scripts can access and manipulate art objects through collections in the document and layer objects.
There are two types of art-object collections:

* Collection objects that correspond to each individual artwork object type, such as the graph items object or
the mesh items object.

* The page items object, which includes art objects of all types.
Also, you can use the group item object to reference a grouped set of art items.

You can create new art objects using the make command (AppleScript) or add method of an artwork item collection
object. For example, to create a new path item object:

AppleScript | set myPathItem to make new path item in current document
JavaScript var myPathItem = activeDocument.pathItems.add();
VBScript Set myPathItem = appRef.ActiveDocument.PathItems.Add()

The following artwork collections do not allow the creation of new objects using the make command or add method:
e graph items object
* mesh items object

* plugin items object

21
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* legacy text items object

For details on creating objects of these types, see the Adobe lllustrator CC Scripting Reference for your language.

10.1 Art styles

Your script can apply a graphic style to artwork using the graphic style object. To apply a graphic style, use the
graphic styles property of the document object to access the apply to method of the graphic style object.

Similarly, the brush object allows you to specify the brush to apply to artwork. You access any brush through the
brushes collection object, which is a property of the document object.

10.2 Color objects

Your script can apply a color, pattern or gradient to a path item object, using the £ill color or stroke color
properties:

e Scripts can define new color swatches using the make command or add method of the swatches object. Your
script also can create a new spot color, using the make command or add property of the spots object.

* You can define the attributes of an ink object using the ink info object, which is an ink object property. You
access ink objects through the ink 1ist property of the document object.

The following objects allow you to create colors within defined color spaces:
* The RGB color object, using the range 0.0 to 255.0 for the each of the three individual color values.

* The CMYK color object, using the percentage values 0.0 through 100.0 for each of the four individual color
values.

e The grayscale color or LAB color objects, using the same range and number of values that you use in the
Ilustrator application.

22 Chapter 10. The Artwork Tree



CHAPTER
ELEVEN

TEXT OBJECTS

When you type content in an Illustrator document, the type automatically becomes a text frame object and, at the
same time, a story object.

To observe this, open a new document in Illustrator and use the horizontal text tool to type some text, then use the
vertical text tool to type more text.

Finally, create a rectangle and type some text inside it.

Now run the following JavaScript script

var myDoc = app.activeDocument;
alert("There are " + myDoc.textFrames.length +
alert("There are " + myDoc.stories.length + "

text frames.'");
stories.");

11.1 Text Frames

There are three types of text frames:
* point
e area

* path

l.rh.. " _|
Jhis isan o

an
E}E_lmple of example of
point text.

Ig
area text, %

To create a specific kind of text frame, use the kind property of the text frames object in AppleScript.

23
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The JavaScript and VBScript text frames objects contain specific methods for creating area text frames and path
text frames.

As in the Illustrator application, you can thread area or path text frames.
To thread existing text frames, use the next frame or previous frame property of the text frame object.
Threaded frames make a single story object.

For information on creating or threading text frames, see the chapter in this manual for your scripting language.

11.1.1 Text Geometry

While the three kinds of text frames have common characteristics, like orientation, each has type-specific qualities,
as reflected in the text frame object’s properties. For example:

e An area text frame can have rows and columns, which you access through the row count and column count
properties.

* Path text has start T value and end T value properties that indicate where on the path the text begins and ends.

* Area and path text frames are associated with a text path object, which is specified using the text frame object’s
text path property. The text path defines the text frame’s position and orientation (horizontal or vertical) on
the artboard (while the text frame object’s orientation property defines the orientation of text within the
text frame). The text path property is not valid for point text, because point-text position and orientation are
defined completely by the properties of the text frame itself.

Note: A text path is not the same as a path art item. Text paths are associated with path art items that can be accessed
and manipulated to modify the appearance of the associated text frame.

11.2 Objects that represent text content

Within a text frame or story, the actual text content can be accessed as any of the following objects:
» characters
* words
e paragraphs
e lines
A line object is all the characters that fit on one line in a text frame or story object.
All text-art items have at least one line of text, defined as a 1ine object.

Text art can have multiple text lines, if the text contains hard line breaks or its characters flow to a new line because
they do not fit in the width of the text art.

Text objects are accessed and identified by collections within the text frame and story objects; for example

textFrame("My Text Frame").paragraphs

// or
story("My Story").paragraphs

24 Chapter 11. Text Objects
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Both text frame and story objects have insertion point and text selection properties.
The text frame object’s properties also include the defining features of the text frame, such as:
¢ The frame width, height, and position
* Whether the frame is hidden or locked

¢ Whether the text is editable

Note: A line object cannot be created in a script. Your script can create character, paragraph, and word objects.

11.2.1 Text ranges

The various text objects within a text frame or story also are represented collectively by the text range object.
For example, a character is a text range with a length of 1, and a word is a text range that has a space before it.

You can set the content of a text range object by passing a string using the contents property.

11.3 Text styles

Text-style elements, like font, capitalization, and justification, are represented by paragraph attribute
and character attribute objects.

These attribute objects are properties of the paragraph style and character style objects.

The paragraph style and character style objects have apply to and remove methods that allow your script
to assign or remove attributes in a specific paragraph, character, or text range.

You can change the display properties of a text range by applying an appropriate style or providing local overrides of
attributes at the text or paragraph levels:
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e character style objects apply to sets of one or more characters. They control character features like font,

alignment, leading, language, and capitalization, which are properties of the character attribute
object.

* paragraph style objects apply to paragraphs. They control paragraph features like first line indent,
left indent, and right indent, which are properties of the paragraph attribute object.
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CHAPTER
TWELVE

DYNAMIC OBJECTS

By creating dynamic objects, you can create data-driven graphics.

In the Illustrator application, you use the Variables panel to create or edit variables like graph data, linked file, text
string, and visibility, or variables whose type is not specified.

In scripting, you use the variable object to represent this type of variable.

The variable object’s kind property indicates the type of dynamic data that a variable object holds. Variable
objects are document-level objects; you create them in a document object.

Note: Do not confuse variable objects with scripting variables. For details on Illustrator variables, dynamic objects,
and data-driven graphics, see Illustrator Help.

Datasets, which collect variables and their associated dynamic data into one object, are represented in scripting by the
dataset object.

The dataset object provides methods to update and delete dataset objects in your scripts.
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CHAPTER
THIRTEEN

SYMBOLS

In Ilustrator, symbols are art items that are stored in the Symbols panel.
Your scripts can create, delete, and duplicate symbol objects.
When you create symbol objects in your script, [llustrator adds them to the Symbols panel for the target document.

A symbol itemis aninstance of a symbol objectin a document. Each symbol itemis linked to its symbol definition,
so changing the definition of a symbol updates all instances of the symbol.

Your script can create, delete, and duplicate symbol items. Symbol items are Illustrator art items; therefore, they can
be treated in the same way as other art items or page items.

You can rotate, resize, select, lock, hide, and perform other operations on symbol items.
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CHAPTER
FOURTEEN

TRANSFORMATIONS

The matrix object provides access to the power of geometric-transformation matrices.

Transformation matrices in Illustrator store the settings of an operation that scales, rotates, or moves (translates) an
object on a page.

There are advantages to using matrices:

* By storing transformation values in a matrix object, you can use the values repeatedly on different objects in
your script.

* By concatenating rotation, translation, and/or scaling matrices and applying the resulting matrix, you can perform
many geometric transformations with only one script statement.

¢ You can invert matrix values.
* You can compare the values of two matrices.
The application object. has commands or methods to create, get, invert, compare, or concatenate matrices.

The command or method used to apply a matrix is the transform command, which belongs to any type of object on
which transformations can be performed.
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CHAPTER
FIFTEEN

LAUNCHING AND QUITTING ILLUSTRATOR FROM A SCRIPT

Your scripts can control the activation and termination of Illustrator.

15.1 Launching and activating lllustrator

15.1.1 AppleScript

In AppleScript, you use a tell statement to target Illustrator.

The activate command activates Illustrator if it is not already active

tell application "Adobe Illustrator"
activate
end tell

15.1.2 JavaScript

Typically, you run JavaScript scripts from the application’s Scripts menu (File > Scripts) or start-up folder, so there is
no need to launch Illustrator from your script.

Information on launching Illustrator in JavaScript is beyond the scope of this guide.

For details, search for Interapplication Communication or Javascript Messaging Framework in JavaScript Tools Guide.

15.1.3 VBScript

In VBScript, there are several ways to create an instance of Illustrator:

¢ CreateObject launches Illustrator as an invisible application if it is not already running. If Illustrator is launched
as an invisible application you must manually activate the application to make it visible:

Set appRef = CreateObject("Illustrator.Application")

If you have multiple versions of Illustrator installed on the same machine and use the CreateObject method to obtain an
application reference, using “Illustrator. Application” creates a reference to the latest Illustrator version. To specifically
target an earlier version, use a version identifier at the end of the string:

33



https://javascript-tools-guide.readthedocs.io/1%20-%20Introduction/extendscript-overview.html#interapplication-communication-and-messaging
https://javascript-tools-guide.readthedocs.io/5%20-%20Interapplication%20Communication%20with%20Scripts/communications-overview.html#messaging-framework
http://estk.aenhancers.com

lllustrator Scripting Guide, Release 0.0.1

Mlustrator 10 “Ilustrator.Application.1”
Mlustrator CS “Ilustrator.Application.2”
Mlustrator CS2 “Ilustrator.Application.3”
Mustrator CS3 “INustrator.Application.4”
Mlustrator CS4 “INustrator.Application.CS4”
[lustrator CS5 “Illustrator. Application.CS5”
Mlustrator CS6 “Iustrator.Application.CS6”
Mlustrator CC “Illustrator.Application.CC”
Mlustrator CC 2014 | “Illustrator.Application.CC2014”
Mlustrator CC 2015 | “Illustrator.Application.CC2015”
Mlustrator CC 2017 | “Illustrator.Application.CC2017”

* Use the New operator if you added a reference to the Illustrator type library to the project. For example, the
following line creates a new reference to the Application object:

Set appRef = New Illustrator.Application

15.2 Quitting lllustrator

15.2.1 AppleScript

Use the quit command:

tell application "Adobe Illustrator"
quit
end tell

15.2.2 JavaScript

Use the app.quit() method:

app.quitQ);

15.2.3 VBScript

Use the Application object’s Quit method:

Set appRef = CreateObject("Illustrator.Application")
appRef.Quit
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CHAPTER
SIXTEEN

WORKING WITH OBJECTS

16.1 Getting the frontmost document or layer

To refer to the selected document, use the application object’s current document property in AppleScript or the
active document property in JavaScript or VBScript. Similarly, you can use the document object’s current layer

or active layer property to refer to the selected layer.

There are other types of “active” or “current” object properties, like active dataset or active view. For details,
see the Adobe llustrator CC 2017 Scripting Reference for your language.

16.2 Creating new objects

Several objects (besides the application object itself) cannot be obtained from containers or parent objects. Your

script must create these objects directly.

The following objects must be created explicitly:

CMYK color

document preset

EPS save options
export options AutoCAD
export options Flash
export options GIF
export options JPEG
export options Photoshop
export options PNG8
export options PNG24
export options SVG
export options TIFF
file

folder

gradient color
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gray color

Illustrator save options

ink

ink info

lab color

matrix

MXG save options

no color

open options

open options AutoCAD
open options FreeHand
open options PDF

open options Photoshop
paper info

Pattern color

PDF save options

PPD file

PPD file info

print color management options
print color separation options

print coordinate options

printer

printer info

print flattener options

print font options
print job options

print options

print page marks options

print paper options

print postscript options

raster effect options
rasterize options
screen

screen spot function
RGB color

spot color
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* tracing options

The file and folder objects are Adobe ExtendScript devices designed to provide platform-independent access to the
underlying file system. For information on using these objects, see JavaScript Tools Guide.

For information on creating an object explicitly, see the chapter for your scripting language.

16.3 Collection objects

Most collection objects must be obtained from a container. For example, a path items collection object can be
contained by a document object or a layer object; to obtain an object in a path items collection, refer to either
containing of these objects. For example, see the language-specific sections below.

16.3.1 AppleScript

To refer to a path items object in a document

path item 1 in document 1

To refer to a path items object in a layer

path item 1 in layer 1 in document 1

16.3.2 JavaScript

To refer to a path items object in a document

documents[0] .pathItems[1]

To refer to a path items object in a layer

documents[0] .layers[0].pathItems[0]

16.3.3 VBScript

To refer to a path items object in a document

Documents(1l) .PathItems(1)

To refer to a path items object in a layer

Documents(1l) .Layers(1l) .PathItems(1)

For more examples of collection-item containers, see the document object Elements table in Adobe 1llustrator CC 2017
Scripting Reference: AppleScript or the Properties table in Adobe lllustrator CC 2017 Scripting Reference: JavaScript
or Adobe lllustrator CC 2017 Scripting Reference: VBScript. A diagram of the 1llustrator CC 2017 object model is in
The Illustrator Scripting Object Model.
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16.4 Selected objects

Sometimes, you want to write scripts that act on the currently selected object or objects. For example, you might want
to apply formatting to selected text or change a selected path’s shape.

16.4.1 Selecting Text

To select text, use the select command or method of the text range object.

16.4.2 Selecting art items

You can select an art object (like graph items, mesh items, raster items, and symbol items) by setting its selected
property to true. (In AppleScript, selected is a property of the page items object.)

16.4.3 Referring to selected art items

To refer to all currently selected objects in a document, use the document object’s selection property. To work with
the objects in the selection array, you must determine their type, so you will know which properties and methods or
commands you can use with them. In JavaScript and VBScript, each artwork object type has a read-only typename
property that you can use to determine the object’s type. In AppleScript, use the class property.

16.5 Notes on renaming objects stored in the application’s panels

Several objects can be renamed; that is, their name property is writeable. The following types of objects can be sorted
alphabetically in the corresponding Illustrator panel. If a script modifies the name of such an object, references to that
object by index can become invalid.

* Brush

e Gradient

e Graphic Style
* Pattern

e Swatch

¢ Symbol

e Variable
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CHAPTER
SEVENTEEN

MEASUREMENT UNITS

Ilustrator uses points as the unit of measurement for almost all distances. One inch equals 72 points. The exception
is values for properties like kerning, tracking, and the aki properties (used for Japanese text composition), which
use em units. (See Em space units)

Ilustrator uses points when communicating with your scripts regardless of the current ruler units. If your script depends
on adding, subtracting, multiplying, or dividing specific measurement values for units other than points, it must perform
any unit conversions needed to represent your measurements as points. For example, to use inches for coordinates or
measurement units, you must multiply all inch values by 72 when entering the values in your script.

The following table shows conversion formulas for various units of measurement:

Unit Conversion formula

centimeters | 28.346 points = 1 centimeter

inches 72 points = 1 inch

millimeters | 2.834645 points = 1 millimeter

picas 12 points = 1 pica

Qs 0.709 point = 1 Q (1 Q equals 0.23 millimeter)

JavaScript provides the UnitValue object type, which offers unit-conversion utilities. For details, see JavaScript Tools
Guide

17.1 Em space units

Values that use em units instead of points are measured in thousandths of an em.
An em is proportional to the current font size.
For example, in a 6-point font, 1 em equals 6 points; in a 10-point font, 1 em equals 10 points.

In a 10-point font, a kerning value of 20 em units is equivalent to

(20 units x 10 points) / 1000 units/em = 0.2 points
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CHAPTER
EIGHTEEN

PAGE-ITEM POSITIONING AND DIMENSIONS

Ilustrator uses simple, two-dimensional geometry in the form of points to record the position of page item objects in
a document. Every page item object in a document has a position property that defines a fixed point as a pair of page
coordinates in the format [x, y]. The fixed point is the top-left corner of the object’s bounding box.

For information on the types of objects that comprise the page items collection, see “The artwork tree” on
A point is designated by a pair of coordinates:

* The horizontal position, x

* The vertical position, y
You can see these coordinates in the Info panel when you select or create an object in Illustrator.

For the artboard, the default coordinate origin, (0,0), is the top-left corner, reflected in the ruler origin property of the
artboard object. X coordinate values increase from left to right, and Y values increase from top to bottom. This changed
in the CS5 release; to maintain script compatability, a document created by a script still uses the older system, with the
origin at the bottom left of the artboard, and the Y value increasing from bottom to top. The page origin property of a
document object defines the bottom-left corner of the printable region of the document as a fixed point.

Each page item object has width and height properties. The maximum value allowed for the width or height of a page
item is 16348 points.

18.1 Art item bounds

Every page item object has three properties that use fixed rectangles to describe the object’s overall extent:

* The geometric bounds of a page item are the rectangular dimensions of the object’s bounding box, excluding
stroke width.

 The visible bounds of a page item are the dimensions of the object, including any stroke widths.
* The control bounds define the rectangular dimensions of the object, including in and out control points.

The following figure illustrates these properties, using JavaScript naming conventions.
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CHAPTER
NINETEEN

PATHS AND SHAPES

Paths are represented in the Illustrator DOM by the path item object. Path items include all artwork that contains
paths, such as rectangles, ellipses, and polygons, as well as freeform paths.

A freeform path consists of a series of path points. A path point can be specified in two ways:
* As an array of x and y page coordinates.

* Asapath point object, which defines an anchor point and two direction points or handles that define the path
segment’s curve:

pathPoint

rightDirection

pathltern

anchor

[ leftDirection

For details, samples, and information on creating shapes, see the chapter for your scripting language.
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CHAPTER
TWENTY

USER-INTERACTION LEVELS

When user feedback is required, an application typically presents a dialog. This is called user interaction. It is useful
and expected when you are directly interacting with the application; however, when a script is interacting with an
application, a dialog brings the execution of the script to a halt until the dialog is dismissed. This can be a serious
problem in an automation environment, where there is no one present to deal with dialogs.

The application object contains a user interaction level property that allows you to control the level of in-
teraction allowed during script execution. You can suppress interaction in an automation environment or allow some
interaction where scripts are being used in a more interactive fashion.

20.1 AppleScript

Using AppleScript, it is possible to send commands from one machine to another, so additional types of interaction are
possible. In AppleScript:, there are four possible values for the user interaction level property:

Property Value

Result

never interact

No interaction is allowed.

interact with self

Interact only with scripts executed from the Scripts menu (File > Scripts).

interact with local

Interact with scripts executed on the local machine (including self ).

interact with all

Interact with all scripts.

The four values allow you to control interaction based on the source of the script commands. For example, if the
application is acting as a server for remote users, it would be difficult for a remote user to dismiss a dialog, but it would
be no problem for someone sitting in front of the machine. In this case, an interaction level of interact with local would
prevent dialogs from halting remote scripts but would allow dialogs to be presented for local scripts.

20.2 JavaScript

In JavaScript, there are two possible values for the app.userInteractionLevel property:

Property Value

Result

DISPLAYALERTS

Interaction is allowed.

DONTDISPLAYALERTS

No interaction is allowed.

45



lllustrator Scripting Guide, Release 0.0.1

20.3 VBScript

In VBScript, there are two possible values for the UserInteractionLevel property of the Application object:

Property Value Result
aiDisplayAlerts Interaction is allowed.
aiDontDisplayAlerts | No interaction is allowed.
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CHAPTER
TWENTYONE

PRINTING ILLUSTRATOR DOCUMENTS

Using the print options scripting feature, you can capture and automate parts of your print workflow. Scripting
exposes the full capabilities of Illustrator printing, some of which may not be accessible through the application’s user
interface.

Ilustrator supports at most one print session at a time, because of limits in the current printing architecture.

The document object’s print command or method takes one optional parameter, which allows you to specify a print
options object.

The print options object allows you to define print settings like PPD, PostScript options, paper options, and color-
management options. The print options object also has a print preset property, which allows you to specify a
preset to define your print job.

When defining the properties of a print options object, you can find out which printers, PPDs, print presets, and
other items are available by using the application object’s read-only “list” properties, such as the printer list,
PPD file list, and print presets list properties.
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CHAPTER
TWENTYTWO

FOR MORE INFORMATION

Several extended sample scripts are in the /Scripting/Sample Scripts/ folder in your Illustrator CC 2017 instal-
lation directory.

For information about individual classes, objects, properties, commands, and parameters, as well as script samples that
demonstrate how to use many of these items, see asobjref/applescript-object-reference.

You also can view the lllustrator CC 2017 dictionary from the Script Editor application; see Viewing the AppleScript
object model

If you do not understand the concepts and terms used in this chapter, read Adobe Introduction to Scripting.
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CHAPTER
TWENTYTHREE

YOUR FIRST ILLUSTRATOR SCRIPT

The traditional first project in any programming language is displaying the message “Hello World!” In this example,
you create a new [llustrator document, then add a text frame containing this message. Follow these steps:

In a default Mac OS installation, Script Editor is in /Applications/AppleScript/Script Editor/.
If you cannot find the Script Editor application, you must reinstall it from your Mac OS system CD.
1. Open Script Editor.

2. Enter the following script:

--Send the following commands to Illustrator

tell application "Adobe Illustrator"”

--Create a new document

set docRef to make new document

--Create a new text frame with the string "Hello World"

set textRef to make new text frame in docRef

with properties {contents: "Hello World!", position:{200, 200}}
end tell

3. In the Script Editor toolbar, click Run.

Tip: To add the script to the Illustrator Scripts menu (File > Scripts), save the script in the Scripts folder. The script
will appear on the menu the next time you start [llustrator. For details, see Installing scripts in the Scripts menu.

23.1 Adding features to “Hello World”

Next, we create a new script that makes changes to the Illustrator document you created with your first script. Our
second script demonstrates how to:

* Get the active document.

* Get the width of the active document.

* Resize the text frame to match the document’s width.
If you already closed the Illustrator document, run your first script again to create a new document.
Follow these steps:

1. In Script Editor, choose File > New to create a new script.
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. Enter the following code:

tell application "Adobe Illustrator"

-- current document is always the active document
set docRef to the current document

set docWidth to the width of docRef

-- resize the text frame to match the page width
set width of text frame 1 of docRef to docWidth

-- alternatively, one can reference the item directly, as follows:
set width of text frame 1 of current document to docWidth

end tell

. Run the script.
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CHAPTER
TWENTYFOUR

OBJECT REFERENCES

In AppleScript, Illustrator returns object references by index position or name. For example, this is a reference to the
first path in layer 2

path item 1 of layer 2 of document 1

An object’s index position may change when other objects are created or deleted. For example, when a new path item
is created on layer 2, the new path item becomes path item 1 of layer 2 of document 1.

This new object displaces the original path item, forcing the original to index position 2; therefore, any references made
to path item 1 of layer 2 of document 1 refer to the new object. This method of applying index numbers
assures that lowest index number refers to the object that was worked on most recently.

Consider the following sample script:

-- Make 2 new objects and try to select both
tell application "Adobe Illustrator"
set newDocument to make new document
set rectPath to make new rectangle in newDocument
set starPath to make new star in newDocument
set selection of newDocument to {rectPath, starPath}
end tell

This script does not select both the rectangle and the star, as intended; instead, it selects only the star. Try running the
script with the Event Log window open, to observe the references returned from Illustrator for each consecutive make
command. (Choose Event Log at the bottom of the Script Editor window.) Notice that both commands return the same
object reference: path item 1 of layer 1 of document 1; therefore, the last line resolves to

set selection of document 1 to {path item 1 of layer 1 of document 1,
path item 1 of layer 1 of document 1}

A better approach is to reference the objects by name:

tell application "Adobe Illustrator"
set newDocument to make new document
make new rectangle in newDocument with properties {name:'"rectangle"}
make new star in newDocument with properties {name:"star"}
set selection of newDocument to
{path item "rectangle" of newDocument,
path item "star" of newDocument}
end tell

This example illustrates the need to uniquely identify objects in AppleScript scripts. We recommend that you assign
names or variables to objects you need to access at a later time, as there is no guarantee you are accessing the objects
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you expect when accessing them by index.

24.1 Obtaining objects from documents and layers

This script references an object as part of a document:

-- Get reference for first page item of document 1
tell application "Adobe Illustrator"

set pageltemRef to page item 1 of document 1
end tell

In the following script, the pageltemRef variable does not necessarily refer to the same object as in the previous script,
because this script includes a reference to a layer:

-- Get reference for first page item of layer 1 of document 1
tell application "Adobe Illustrator"

set pageltemRef to page item 1 of layer 1 of document 1
end tell

24.2 Creating new objects

To create a new object in AppleScript, use the make command.

24.3 Working with selections

When the user makes a selection in a document, the selected objects are stored in the document’s selection property.
To access all selected objects in the active document:

tell application "Adobe Illustrator"

set myDoc to current document

set selectedObjects to selection of myDoc
end tell

Depending on what is selected, the selection property value can be an array of any type of art objects. To get or
manipulate the properties of the selected art items, you must retrieve the individual items in the array. To find out an
object’s type, use the class property.

The following sample gets the first object in the array, then displays the object’s type:

tell application "Adobe Illustrator"
set myDoc to current document
set selectedObjects to selection of myDoc
set topObject to item 1 of selectedObjects
display dialog (class of topObject)

end tell

The first object in a selection array is the selected object that was last added to the page, not the last object selected.
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24.3.1 Working with selections

To select an art object, the object’s selected property.

24.3. Working with selections
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CHAPTER
TWENTYFIVE

WORKING WITH TEXT FRAMES

To create a text frame of a specific type in AppleScript, use the kind property of the text frame object

set myRect to make new rectangle in current document with properties
{position: {100, 700}, height:100, width:100}

set myAreaText to make new text frame in current document with properties
{kind:point text,contents:"Text Frame 1"}

25.1 Threaded frames

As in the Illustrator application, you can thread area text frames or path text frames.
To thread existing text frames, use the next frame or previous frame property of the text frame object.

When copying the following script to your script editor, place the value of the contents property on one line. The
long-line character (=) is not valid within a string value.

tell application "Adobe Illustrator"
make new document
make new rectangle in current document with properties
{position: {100, 500}, height:100, width:100}
make new text frame in current document with properties
{kind:area text, text path:the result, name:"tfl", contents:"This is two text frames.
—linked together as one story, with text flowing from the first to the last. First.
—frame content. "}
make new rectangle in current document with properties
{position: {300, 700}, height:100, width:100}
make new text frame in current document with properties
{kind:area text, text path:the result, name:"tf2", contents:"Second frame content." }
--use the next frame property to thread the frames
set next frame of text frame "tfl" of current document to
text frame "tf2" of current document
redraw
end tell
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25.1.1 Threaded frames make one story object

Threaded frames make a single story object. To observe this, run the following AppleScript after running the script

above.

display dialog ("There are

"
—

display dialog("There are

& (count(text frames of current document)) & " text frames.

& (count(stories of current document)) & " stories.")
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CHAPTER
TWENTYSIX

CREATING PATHS AND SHAPES

This section explains how to create items that contain paths.

26.1 Paths

To create line or a freeform path, specify a series of path points, as a series of x-y coordinates or path point objects.

Using x-y coordinates limits the path to straight segments. To created a curved path, you must create path point
objects. A path can comprise a combination of page coordinates and path point objects.

26.1.1 Specifying a series of x-y coordinates

To specify a path using page-coordinate pairs, use the entire path property of the path items object. The following
script specifies three pairs of x-y coordinates, to create a path with three points:

tell application "Adobe Illustrator"
set docRef to make new document
-- set stroked to true so we can see the path

set lineRef to make new path item in docRef with properties {stroked: }
set entire path of lineRef to {{220, 475},{200, 300},{375, 300}}
end tell

26.1.2 Using path point objects

To create a path point object, you must define three values for the point.
* A fixed anchor point, which is the point on the path.

* A pair of direction points— left direction and right direction —which allow you to control the path
segment’s curve.

You define each property as an array of page coordinates in the format [x, y]:

« If all three properties of a path point object have the same coordinates, and the properties of the next path
point in the line are equal to each other, you create a straight-line segment.

« If two or more properties in a path point object have different values, the segment connected to the point is
curved.
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To create a path or add points to an existing path using path point objects, create a path item object, then add the
path points as child objects in the path item:

tell application "Adobe Illustrator"”

set docRef to make new document

-- set stroked to true so we can see the path

set lineRef to make new path item in docRef with properties {stroked:true}
--giving the direction points the same value as the
--anchor point creates a straight line segment

set newPoint to make new path point of lineRef with properties
{anchor:{220, 475},left direction:{220, 475},right direction:{220, 475},
point type:corner}

set newPoint2 to make new path point of lineRef with properties
{anchor: {375, 300},left direction:{375, 300},right direction:{375, 300},
point type:corner}

--giving the direction points the different values
--creates a curve
set newPoint3 to make new path point of lineRef with properties
{anchor: {220, 300},left direction:{180, 260},right direction: {240, 320},
point type:corner}

end tell

26.1.3 Combining path point types

The following script sample creates a path with three points, by combining the entire path property with a path point
object

tell application "Adobe Illustrator"”

set docRef to make new document

-- set stroked to true so we can see the path

set lineRef to make new path item in docRef with properties {stroked:true}

set entire path of lineRef to {{220, 475},{375, 300}}

set newPoint to make new path point of lineRef with properties
{anchor: {220, 300},left direction:{180, 260},right direction:{240, 320},
point type:corner}

end tell

26.2 Shapes

To create a shape, you use the object that corresponds to the shape’s name (like ellipse, rectangle, or polygon),
and use the object’s properties to specify the shape’s position, size, and other information like the number of sides in a

polygon.

Remember:

» The scripting engine processes all measurements and page coordinates as points. For details, see Measurement
Units.
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* x and y coordinates are measured from the bottom-left corner of the document, as indicated in the Info panel in
the Illustrator application. For details, see Page-item positioning and dimensions.

26.2.1 Write-once access

Properties for path-item shapes use the “write-once” access status, which indicates that the property is writeable only
when the object is created. For existing path-item objects, the properties are read-only properties whose values cannot
be changed.

26.2.2 Creating a rectangle

Consider the following sample:

tell application "Adobe Illustrator"

set docRef to make new document

set rectRef to make new rectangle in docRef with properties
{bounds: {288, 360, 72, 144}}

end tell

The sample creates a rectangle with these properties:

* The top-right corner of the of the rectangle is inset 4 inches (288 points) from the bottom of the page and 5 inches
(360 points) from the left edge of the page.

¢ The lower-left corner of the rectangle is inset 1 inch (72 points) from the left edge of the page and 2 inches (144
points) from the bottom of the page.

26.2.3 Creating a polygon

Consider the following sample:

tell application "Adobe Illustrator"

set docRef to make new document

set pathRef to make new polygon in docRef with properties
{center point:{144, 288},sides:7,radius:72.0}%}

end tell

The sample creates a polygon with these properties:

* The center point of the object is inset is 2 inches (144 points) on the horizontal axis and 4 inches (288 points) on
the vertical axis.

* The polygon has 7 sides.

* The length of the radius from the center point to each corner is 1 inch (72 points).
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CHAPTER
TWENTYSEVEN

WORKING WITH THE PERSPECTIVE GRID

The Perspective Grid is a new feature in lllustrator CC 2017 that enables you to create and manipulate art in a spatial
environment using established laws of perspective. Enable Perspective Grid using the View > Perspective Grid menu
or the perspective tools in the toolbar.

The SDK provides an API for working with the perspective grid programmatically, and your scripts have some access
to this API. A script can:

 Set a the default grid parameters using preset values.
» Show or hide the grid.

* Set the active plane.

* Draw an object in perspective on the active plane.

* Bring an object into perspective.

27.1 Use perspective presets

[lustrator provides default grid-parameter presets for one-point, two-point, and three-point perspectives. The presets
are named "[1P-NormalView]", "[2P-NormalView]", and " [3P-NormalView]".

The script shows how to select the two-point perspective preset programmatically:

tell application "Adobe Illustrator"
--Create a new document
set docRef to make new document
tell docRef
--Select the default two-point perspective preset
select perspective preset perspective preset "[2P-Normal View]"
end tell
end tell

You can create new perspective presets, export presets to files, and import presets from files. These scripts shows how
to export and import presets:

tell application "Adobe Illustrator"
set docRef to make new document
set filePath to "Macintosh HD:scripting:PGPresetsExported"
export perspective grid preset of docRef to file filePath
end tell

(continues on next page)
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(continued from previous page)

tell application "Adobe Illustrator"

set docRef to make new document

set filePath to "Macintosh HD:scripting:PGPresets"

import perspective grid preset of docRef from file filePath
end tell

27.2 Show or hide the grid

This script shows or hides the Perspective Grid programmatically:

tell application "Adobe Illustrator"
--Create a new document
set docRef to make new document
tell docRef
--Display the perspective grid defined in the document
show perspective grid
--Hide the perspective grid defined in the document
hide perspective grid
end tell
end tell

27.3 Set the active plane

The perspective grid plane types are:

Left plane perspective grid plane leftplane
Right plane perspective grid plane rightplane
Floor plane perspective grid plane floorplane
Invalid plane | perspective grid plane noplane

For a one-point perspective grid, only the left and floor plane are valid.

This script sets the active perspective plane to the left plane:

tell application "Adobe Illustrator"
--Create a new document
set docRef to make new document
tell docRef
--Set the active plane to the left plane
set perspective active plane perspective grid plane leftplane
end tell
end tell

64 Chapter 27. Working with the perspective grid




lllustrator Scripting Guide, Release 0.0.1

27.4 Draw on a perspective grid

When the Perspective Grid is on, drawing methods allow you to draw or operate on objects in perspective. This script
creates a new document, shows a two-point perspective grid, and draws art objects on the left plane

tell application "Adobe Illustrator"
--Create a new document
set docRef to make new document
tell docRef
--Select the default two-point perspective preset
select perspective preset perspective preset "[2P-Normal View]"

--Display the perspective grid defined in the document
show perspective grid

--Check if active plane is set to left, otherwise set it to left
if (get perspective active plane) is not leftplane then

set perspective active plane perspective grid plane leftplane
end if

--Draw rectangle in perspective, then resize to 200% and move

set rectRef to make new rectangle with properties {bounds:{®, 0, 30, 30},.
—reversed: false}

scale rectRef horizontal scale 200 vertical scale 200 about top left with,
—transforming objects

translate rectRef delta x -420 delta y 480

--Draw ellipse in perspective
set ellipseRef to make new ellipse with properties {bounds:{60, -60, 90, -30},.
wreversed: false, inscribed:true}

--Draw rounded rectangle in perspective
set rrectRef to make new rounded rectangle with properties {bounds:{90, -90, 30, 30},
< horizontal radius:10, vertical radius:10, reversed:false}

--Draw polygon in perspective
set polyRef to make new polygon with properties {center point:{105, 105}, radius:15,.
—sides:7, reversed:false}

--Draw star in perspective
set starRef to make new star with properties {center point:{135, 135}, radius:15,.
—inner radius:10, point count:6, reversed:false}

--Draw path in perspective
set newPath to make new path item with properties {entire path:{{anchor: {0, 0}},
—{anchor:{60, 0}}, {anchor:{30, 45}}, {anchor:{90, 110}}}}
end tell
end tell
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27.5 Bring objects into perspective

If an art object is not in perspective, use the bringInPerspective () method to bring it into perspective and place it
on a plane.

This script creates a new document, draws an art object, and brings it into perspective on a three-point perspective grid:

tell application "Adobe Illustrator"”
--Create a new document
set docRef to make new document
tell docRef
--Draw star
set starRef to make new star with properties {center point:{135, 135}, radius:15,.
—inner radius:10, point count:6, reversed:false}

--Select the default three-point perspective preset
select perspective preset perspective preset "[3P-Normal View]"

--Display the perspective grid defined in the document
show perspective grid

--Check if active plane is set to left, otherwise set it to left
if (get perspective active plane) is not leftplane then

set perspective active plane perspective grid plane leftplane
end if

--Bring star to floor plane
bring in perspective starRef position x 100 position y 100 perspective grid plane.
—floorplane
end tell
end tell
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CHAPTER
TWENTYEIGHT

FOR MORE INFORMATION

Several extended sample scripts are in the /Scripting/Sample Scripts/ folder in your lllustrator CC 2017 instal-
lation directory.

For information about individual classes, objects, properties, methods, and parameters, as well as script samples that
demonstrate how to use many of these items, see Adobe lllustrator CC 2017 Scripting Reference: JavaScript, in the /
Scripting/Documentation/ folder in your lllustrator CC 2017 installation directory. You also can use the [llustrator
dictionary, which you access from the Object Model Viewer in the ESTK. For information on using the ExtendScript
Toolkit and the Object Model Viewer, see Viewing the JavaScript object model.

If you do not understand the concepts and terms used in this chapter, read Adobe Introduction to Scripting.
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CHAPTER
TWENTYNINE

YOUR FIRST ILLUSTRATOR SCRIPT

The traditional first project in any programming language is displaying the message “Hello World!” In this example,
you create a new [llustrator document, then add a text frame containing this message. Follow these steps:

For information on locating the ExtendScript Toolkit, see Viewing the JavaScript object model.

1.

Using any text editor (including Adobe” InDesign® or the ESTK), enter the following text:

//Hello World!

var myDocument = app.documents.add();

//Create a new text frame and assign it to the variable "myTextFrame"
var myTextFrame = myDocument.textFrames.add();

// Set the contents and position of the text frame
myTextFrame.position = [200,200];

myTextFrame.contents = "Hello World!"

To test the script, do either of the following:

If you are using the ESTK, select Adobe Illustrator CC 2017 from the drop-down list in the upper-left corner,
select Yes to start [llustrator, then choose Debug > Run in the ESTK to run the script.

If you are using a different text editor than the ESTK, save the file as text-only in a folder of your choice, using
the file extension .jsx , then start [llustrator. In Illustrator, choose File > Scripts > Other Scripts, and navigate to
and run your script file.

Tip:

To add the script to the Illustrator Scripts menu (File > Scripts), save the script in the Scripts folder. The script

will appear on the menu the next time you start [llustrator. For details, see Installing scripts in the Scripts menu.

29.1 Adding features to “Hello World”

Next, we create a new script that makes changes to the Illustrator document you created with your first script. Our
second script demonstrates how to:

¢ Get the active document.

¢ Get the width of the active document.

¢ Resize the text frame to match the document’s width.

If you already closed the Illustrator document, run your first script again to create a new document.

Follow these steps:
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. In Script Editor, choose File > New to create a new script.

. Enter the following code:

var docRef = app.activeDocument;
var docWidth = docRef.width

var frameRef = docRef.textFrames[0]
frameRef.width = docWidth

. Run the script.
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CHAPTER
THIRTY

WORKING WITH METHODS IN JAVASCRIPT

When you work with methods that have multiple parameters, you may omit optional parameters at the end of the
parameter list, but you may not omit parameters in the middle of the list. If you do not want to specify a particular
parameter in the middle of the list, you must insert the value undefined to use the parameter’s default value. For
example, the following definition describes the rotate () method for an art object.

rotate
(angle
[,changePositions]
[,changeFillPatterns]
[,changeFillGradients]
[,changeStrokePattern]
[,rotateAbout])

In the definition, taken from Adobe Illustrator CC 2017 Scripting Reference: JavaScript, optional parameters are en-
closed in square brackets ( [] ).

To rotate the object 30 degrees and change the fillGradients, you would use the following script statement

myObject.rotate(30, undefined, undefined, true);

You need to specify undefined for the changePositions and changeFillPatterns parameters. You do not have
to specify anything for the two optional parameters following changeFillGradients, since they are at the end of the
parameter list.

71




lllustrator Scripting Guide, Release 0.0.1

72

Chapter 30. Working with methods in JavaScript



CHAPTER
THIRTYONE

ACCESSING AND REFERENCING OBJECTS

When you write a script, you must first decide which file, or document, the script should act on. Through the
application object, the script can create a new document, open an existing document, or act on a document that
is already open.

The script can create new objects in the document, operate on objects that the user selected, or operate on objects
in one of the object collections. The following sections illustrate various techniques for accessing, referencing, and
manipulating Illustrator objects.

31.1 Referencing the application object

To obtain a reference to a specific object, you need to navigate the containment hierarchy. Because all JavaScript
scripts are executed from within the Illustrator application, however, a specific reference to the application object is not
required. For example, to assign the active document in Illustrator to the variable frontMostDocument, you could
reference the activeDocument property of the application object, as follows

var frontMostDocument = activeDocument;

It is permissible to use the application object in a reference. To reference the application object, use the app
global variable. The following two statements appear identical to the JavaScript engine:

var frontMostDocument = activeDocument;

var frontMostDocument = app.activeDocument;

31.2 Accessing objects in collections

All open documents, as well as the objects in a document, are collected into collection objects for the object type. A
collection object contains an array of the objects that you can access by index or name. The collection object takes the
plural form of the object name. For example, the collection object for the document object is documents.

The following script sample gets all graphic style objects in the graphic styles collection; that is, it gets all
graphic styles available to the active document

var myStyles = app.activeDocument.graphicStyles;
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All numeric collection references in JavaScript are zero-based: the first object in the collection has the index [0].

As a rule, JavaScript index numbers do not shift when you add an object to a collection. There is one exception:
documents [0 is always the active or frontmost document.

To access the first style in a graphic styles collection, you can use the variable declared in the previous script
sample, or you can use the containment hierarchy to refer to the collection:

» Using the myStyles variable

var firstStyle = myStyles[0];

* Using the containment hierarchy:

var firstStyle = app.activeDocument.graphicStyles[0];

The following statements assign the name of the first graphic style in the collection to a variable. You can use these
statements interchangeably.

var styleName = myStyles[0].name
var styleName = firstStyle.name

var styleName = app.activeDocument.graphicStyles[0].name

To get the total number of objects in a collection, use the length property:

alert ( myStyles.length );

The index of the last graphic style in the collection is myStyles.length - 1 (-1 because the collection starts the
index count at 0 and the length property counts from 1):

var lastStyle = myStyles[ myStyles.length - 1 ];

Note that an expression representing the index value is enclosed in square brackets ( [] ) as well as quotes.

If you know the name of an object, you can access the object in the collections using the name surrounded by square
brackets; for example:

var getStyle = myStyles["Ice Type"];

Each element in the collection is an object of the desired type, and you can access its properties through the collection.
For example, to get an object’s name, use the name property:

var styleName = app.activeDocument.graphicStyles[0].name;

To apply lastStyle to the first pageItem in the document, use its applyTo () method:

lastStyle.applyTo( app.activeDocument.pageltems[0] );
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31.3 Creating new objects

You can use a script to create new objects. To create objects that are available from collection objects, or containers,
use the container object’s add () method

var myDoc = app.documents.add()
var myLayer = myDoc.layers.add()

Some object types are not available from containers. To create an object of this type, define a variable, then use the new
operator with an object constructor to assign an object as the value. For example, to create a new CMYKColor object
using the variable name myColor:

‘var myColor = new CMYKColor()

31.4 Working with selections

When the user makes a selection in a document, the selected objects are stored in the document’s selection property.
To access all selected objects in the active document:

var selectedObjects = app.activeDocument.selection;

The selection property value can be an array of any type of art objects, depending on what types of objects are
selected. To get or manipulate the properties of the selected art items, you must retrieve the individual items in the
array. To find out an object’s type, use the typename property.

The following sample gets the first object in the array, then displays the object’s type

var topObject = app.activeDocument.selection[0];
alert(topObject.typename)

The first object in a selection array is the selected object that was last added to the page, not the last object selected.

31.4.1 Selecting artwork objects

To select an art object, the object’s selected property.

31.3. Creating new objects 75



lllustrator Scripting Guide, Release 0.0.1

76

Chapter 31. Accessing and referencing objects



CHAPTER
THIRTYTWO

WORKING WITH TEXT FRAMES

To create a text frame of a specific type in JavaScript, use the kind property of the text frame object:

var rectRef = docRef.pathItems.rectangle(700, 50, 100, 100);
//use the areaText method to create the text frame
var areaTextRef = docRef.textFrames.areaText(rectRef);

32.1 Threaded frames

As in the Illustrator application, you can thread area text frames or path text frames.
To thread existing text frames, use the nextFrame or previousFrame property of the text frame object.

When copying the following script to the ESTK, place the value of the contents property on one line:

var myDoc = documents.add();

var myPathIteml = myDoc.pathItems.rectangle(244, 64, 82, 76);
var myTextFramel = myDoc.textFrames.areaText(myPathIteml);

var myPathItem2 = myDoc.pathItems.rectangle(144, 144, 42, 116);
var myTextFrame2 = myDoc.textFrames.areaText(myPathItem2);

// use the nextFrame property to thread the text frames

myTextFramel.nextFrame = myTextFrame2;

var sText = "This is two text frames linked together as one story, with text
flowing from the first to the last. This is two text frames linked together as one
story, with text flowing from the first to the last. This is two text frames linked
together as one story. ";
myTextFramel.contents = sText;

redraw();
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32.1.1 Threaded frames make one story object

Threaded frames make a single story object. To observe this, run the following JavaScript after running the script

above.

var myDoc = app.activeDocument
alert("There are "

alert("There are

+ myDoc.textFrames.length +

+ myDoc.stories.length +

text frames.")
stories.")
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CHAPTER
THIRTYTHREE

CREATING PATHS AND SHAPES

This section explains how to create items that contain paths.

33.1 Paths

To create line or a freeform path, specify a series of path points, as a series of x-y coordinates or path point objects.

Using x-y coordinates limits the path to straight segments. To created a curved path, you must create pathPoint
objects. Your path can comprise a combination of page coordinates and pathPoint objects.

33.1.1 Specifying a series of x-y coordinates

To specify a path using page-coordinate pairs, use the setEntirePath() property of the pathItems object. The
following script specifies three pairs of x-y coordinates, to create a path with three points

var myDoc = app.activeDocument;

var myLine = myDoc.pathItems.add();

//set stroked to true so we can see the path
myLine.stroked = true;

myLine.setEntirePath([[220, 475], [375, 300], [200, 300]1);

33.1.2 Using path point objects

To create a pathPoint object, you must define three values for the point.
* A fixed anchor point, which is the point on the path.

* A pair of direction points— left direction and right direction —which allow you to control the path
segment’s curve.

You define each property as an array of page coordinates in the format [x, y]:

« Ifall three properties of a pathPoint object have the same coordinates, and the properties of the next pathPoint
in the line are equal to each other, you create a straight-line segment.

* If two or more properties in a pathPoint object have different values, the segment connected to the point is
curved.

To create a path or add points to an existing path using pathPoint objects, create a pathItem object, then add the
path points as child objects in the pathItem:
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var myDoc = app.activeDocument;
var myLine = myDoc.pathItems.add();

//set stroked to true so we can see the path
myLine.stroked = true;

var newPoint = myLine.pathPoints.add();
newPoint.anchor = [220, 475];

//giving the direction points the same value as the
//anchor point creates a straight line segment
newPoint.leftDirection = newPoint.anchor;
newPoint.rightDirection = newPoint.anchor;
newPoint.pointType = PointType.CORNER;

var newPointl = myLine.pathPoints.add();
newPointl.anchor = [375, 300];
newPointl.leftDirection = newPointl.anchor;
newPointl.rightDirection = newPointl.anchor;
newPointl.pointType = PointType.CORNER;

var newPoint2 = myLine.pathPoints.add();
newPoint2.anchor = [220, 300];

//giving the direction points different values
//than the anchor point creates a curve
newPoint2.leftDirection =[180, 260];
newPoint2.rightDirection = [240, 320];
newPoint2.pointType = PointType.CORNER;

33.1.3 Combining path point types

The following script sample creates a path with three points:

var myDoc = app.activeDocument;

var myLine = myDoc.pathItems.add();
myLine.stroked = true;

myLine.setEntirePath( [[220, 475], [375, 300]11);

// Append another point to the line

var newPoint = myDoc.myLine.pathPoints.add();
newPoint.anchor = [220, 300];
newPoint.leftDirection = newPoint.anchor;
newPoint.rightDirection = newPoint.anchor;
newPoint.pointType = PointType.CORNER;
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33.2 Shapes

To create a shape, you use the object that corresponds to the shape’s name (like ellipse, rectangle, or polygon),
and use the object’s properties to specify the shape’s position, size, and other information like the number of sides in a

polygon.

Remember:

» All measurements and page coordinates are processed as points by the scripting engine. For details, see Mea-
surement Units.

* x and y coordinates are measured from the bottom-left corner of the document, as indicated in the Info panel in
the Illustrator application. For details, see Page-item positioning and dimensions.

33.2.1 Creating a rectangle

Consider the following sample:

var myDocument = app.documents.add()
var artlLayer = myDocument.layers.add()
var rect = artlLayer.pathItems.rectangle( 144, 144, 72, 216 );

The sample uses the pathItems object’s rectangle () method to create a rectangle with these properties:
* The top of the rectangle is 2 inches (144 points) from the bottom edge of the page.
* The left edge is 2 inches (144 points) from the left edge of the page.
* The rectangle is 1 inch (72 points) wide and 3 inches (216 points) long.

33.2.2 Creating a polygon

Consider the following sample:

var myDocument = app.documents.add()
var artlLayer = myDocument.layers.add()
var poly = artlLayer.pathItems.polygon( 144, 288, 72.0, 7 );

The sample uses the polygon() method to create a polygon with these properties:

» The center point of the object is inset is 2 inches (144 points) on the horizontal axis and 4 inches (288 points) on
the vertical axis.

* The length of the radius from the center point to each corner is 1 inch (72 points).

* The polygon has 7 sides.
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CHAPTER
THIRTYFOUR

WORKING WITH THE PERSPECTIVE GRID

The Perspective Grid is a new feature in lllustrator CC 2017 that enables you to create and manipulate art in a spatial
environment using established laws of perspective. Enable Perspective Grid using the View > Perspective Grid menu
or the perspective tools in the toolbar.

The SDK provides an API for working with the perspective grid programmatically, and your scripts have some access
to this API. A script can:

 Set a the default grid parameters using preset values.
» Show or hide the grid.

* Set the active plane.

* Draw an object in perspective on the active plane.

* Bring an object into perspective.

34.1 Use perspective presets

[lustrator provides default grid-parameter presets for one-point, two-point, and three-point perspectives. The presets
are named " [1P-NormalView]", "[2P-NormalView]", and "[3P-NormalView]".

The script shows how to select the two-point perspective preset programmatically:

//Set the default one-point perspective preset
app.activeDocument.selectPerspectivePreset("[1P-Normal View]");

//Set the default two-point perspective preset
app.activeDocument.selectPerspectivePreset (" [2P-Normal View]");

//Set the default three-point perspective preset
app.activeDocument.selectPerspectivePreset (" [3P-Normal View]");

You can create new perspective presets, export presets to files, and import presets from files. These scripts shows how
to export and import presets:

//Create a new document

var mydoc = app.documents.add();

//Export perspective presets to a file

var exportPresetFile = new File("C:/scripting/PGPresetsExported")
mydoc . exportPerspectiveGridPreset (exportPresetFile);

(continues on next page)
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(continued from previous page)

//Create a new document

var mydoc = app.documents.add();

//Import perspective presets from a file

var importPresetFile = new File("C:/scripting/PGPresets")
mydoc.importPerspectiveGridPreset (importPresetFile);

34.2 Show or hide the grid

This script shows or hides the Perspective Grid programmatically:

//Show the Perspective Grid defined in the document
app.activeDocument .showPerspectiveGrid();

//Hide the Perspective Grid defined in the document
mydoc.hidePerspectiveGrid();

34.3 Set the active plane

The perspective grid plane types are:

Left plane PerspectiveGridPlaneType.LEFTPLANE
Right plane PerspectiveGridPlaneType.RIGHTPLANE
Floor plane PerspectiveGridPlaneType.FLOORPLANE
Invalid plane | PerspectiveGridPlaneType.NOPLANE

For a one-point perspective grid, only the left and floor plane are valid.

This script sets the active perspective plane:

//Set left plane as the active plane
app.activeDocument.setPerspectiveActivePlane (PerspectiveGridPlaneType.LEFTPLANE);

//Set right plane as the active plane
app.activeDocument.setPerspectiveActivePlane(PerspectiveGridPlaneType.RIGHTPLANE) ;

//Set floor plane as the active plane
app.activeDocument.setPerspectiveActivePlane(PerspectiveGridPlaneType.FLOORPLANE) ;
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34.4 Draw on a perspective grid

When the Perspective Grid is on, drawing methods allow you to draw or operate on objects in perspective. This script
creates a new document, shows a two-point perspective grid, and draws art objects on the left plane

//Create a new document
var mydoc = app.documents.add();

//Select the default two-point perspective preset
mydoc.selectPerspectivePreset (" [2P-Normal View]");

//Display the perspective grid defined in the document
mydoc . showPerspectiveGrid();

//Check if active plane is set to left; if not, set it to left

if (mydoc.getPerspectiveActivePlane() != PerspectiveGridPlaneType.LEFTPLANE) {
mydoc.setPerspectiveActivePlane (PerspectiveGridPlaneType.LEFTPLANE) ;

}

//Draw rectangle in perspective, then resize to 200% and move

var myrect = mydoc.pathItems.rectangle(30, -30, 30, 30, false);
myrect.resize(200, 200, true, false, false, false, 100, Transformation.TOPLEFT);
myrect.translate (-420, 480);

//Draw ellipse in perspective
var myellipse = mydoc.pathItems.ellipse(60, -60, 30, 30, false, true);

//Draw rounded rectangle in perspective
var myrrect = mydoc.pathItems.roundedRectangle(90, -90, 30, 30, 10, 10, false);

//Draw polygon in perspective
var mypoly = mydoc.pathItems.polygon(-105, 105, 15, 7, false);

//Draw star in perspective
var mystar = mydoc.pathItems.star(-135, 135, 15, 10, 6, false);

//Draw path in perspective

var newPath = mydoc.pathItems.add();
var linelList = new Array(4);
lineList[0] = new Array(0,0);
lineList[1] new Array(60,0);
lineList[2] = new Array(30,45);
lineList[3] = new Array(90,110);
newPath.setEntirePath(linelList);
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34.5 Bring objects into perspective

If an art object is not in perspective, use the bringInPerspective () method to bring it into perspective and place it
on a plane.

This script creates a new document, draws an art object, and brings it into perspective on a three-point perspective grid:

//Create a new document
var mydoc = app.documents.add();

//Draw ellipse
var myellipse = mydoc.pathItems.ellipse(60, -60, 30, 30, false, true);

//Draw polygon
var mypoly = mydoc.pathItems.polygon(-105, 105, 15, 7, false);

//Draw star
var mystar = mydoc.pathItems.star(-135, 135, 15, 10, 6, false);

//Select the default three-point perspective preset
mydoc.selectPerspectivePreset (" [3P-Normal View]");

//Display the perspective grid defined in the document
mydoc . showPerspectiveGrid();

//Check if active plane is set to left; if not, set it to left

if (mydoc.getPerspectiveActivePlane() != PerspectiveGridPlaneType.LEFTPLANE) {
mydoc.setPerspectiveActivePlane (PerspectiveGridPlaneType.LEFTPLANE) ;

}

//Bring the ellipse to the active plane (left plane)
myellipse.bringInPerspective(-100,-100, PerspectiveGridPlaneType.LEFTPLANE);

//Bring the polygon to the right plane
mypoly.bringInPerspective(100,-100,PerspectiveGridPlaneType.RIGHTPLANE);

//Bring the star to the floor plane
mystar.bringInPerspective (100, 100,PerspectiveGridPlaneType.FLOORPLANE) ;
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CHAPTER
THIRTYFIVE

FOR MORE INFORMATION

Several extended sample scripts are in the :Scripting:Sample Scripts folder in your Illustrator CC 2017 installation
directory.

For information about individual classes, objects, properties, commands, and parameters, as well as script samples
that demonstrate how to use many of these items, see Adobe llustrator CC 2017 Scripting Reference: VBScript, in
the /Scripting/Documentation/ folder in your lllustrator CC 2017 installation directory. You also can view the
Iustrator CC 2017 dictionary from the Script Editor application; see Viewing the VBScript object model.

If you do not understand the concepts and terms used in this chapter, read Adobe Introduction to Scripting.

87



lllustrator Scripting Guide, Release 0.0.1

88

Chapter 35. For more information



CHAPTER
THIRTYSIX

YOUR FIRST ILLUSTRATOR SCRIPT

The traditional first project in any programming language is displaying the message “Hello World!” In this example,
you create a new [llustrator document, then add a text frame containing this message. Follow these steps:

1. Start any text editor (for example, Notepad).

2. Type the following code:

Rem Hello World

Set appRef = CreateObject("Illustrator.Application")

Rem Create a new document and assign it to a variable

Set documentRef = appRef.Documents.Add

Rem Create a new text frame item and assign it to a variable
Set sampleText = documentRef.TextFrames.Add

Rem Set the contents and position of the TextFrame
sampleText.Position = Array(200, 200)

sampleText.Contents = "Hello World!"

3. Save the file as text-only in a folder of your choice, using the file extension .vbs.
4. To test the script, do one of the following:
* Double-click the file.

« Start Illustrator, choose File > Scripts > Other Scripts, and navigate to and run your script file.

Tip: To add the script to the Illustrator Scripts menu (File > Scripts), save the script in the Scripts folder. The script
will appear on the menu the next time you start [llustrator. For details, see Installing scripts in the Scripts menu.

In general, when you launch a VBScript script from the Scripts menu, any msgBox dialogs will not display correctly.

36.1 Adding features to “Hello World”

Next, we create a new script that makes changes to the Illustrator document you created with your first script. Our
second script demonstrates how to:

¢ Get the active document.
¢ Get the width of the active document.

¢ Resize the text frame to match the document’s width.
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If you already closed the Illustrator document, run your first script again to create a new document.

Follow these steps:

1. Copy the following script into your text editor, and save the file:

Set appRef = CreateObject("Illustrator.Application")
'Get the active document

Set documentRef = appRef.ActiveDocument

Set sampleText = documentRef.TextFrames(l)

' Resize the TextFrame item to match the document width
sampleText.Width = documentRef.Width

sampleText.Left = 0

2. Run the script.
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CHAPTER
THIRTYSEVEN

ACCESSING AND REFERENCING OBJECTS

When you write a script, you must first decide which file, or Document, the script should act on. Through the
Application object, the script can create a new document, open an existing document, or act on a document that
is already open.

The script can create new objects in the document, operate on objects that the user selected, or operate on objects in
one of the object collections. The following sections illustrate techniques for accessing, referencing, and manipulating
Illustrator objects

37.1 Obtaining objects from collections

Generally, to obtain a reference to a specific object, you can navigate the containment hierarchy. For example, to use
the myPath variable to store a reference to the first PathItem in the second layer of the active document

Set myPath = appRef.ActiveDocument.Layers(2).PathItems(1)

The following scripts demonstrate how to reference an object as part of a document:

Set documentRef = appRef.ActiveDocument

Set pageItemRef = documentRef.PageItems(1)

In the script below, the variable pageItemRef will not necessarily refer to the same object as the above script, since
this script includes a reference to a layer:

Set documentRef = appRef.ActiveDocument
Set pageItemRef = documentRef.Layers(1l).PageItems(1)

VBScript indexes start at 1 for object collections; however, VBScript allows you to specify whether array indexes start
at 1 or 0. For information on specifying the index start number for arrays, see any VBScript textbook or tutorial.
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37.2 Creating new objects

You can use a script to create new objects. To create objects that are available from collection objects, use the collection
object’s Add method:

Set myDoc = appRef.Documents.Add()

Set myLayer = myDoc.Layers.Add()

Some collection objects do not have an Add method. To create an object of this type, define a variable and use the
CreateObject method. For example, the following code creates a new CMYKColor object using the variable name
newColor

Set newColor = CreateObject ("Illustrator.CMYKColor")

37.3 Working with selections

When the user makes a selection in a document, the selected objects are stored in the document’s selection property.
To access all selected objects in the active document

Set appRef = CreateObject ("Illustrator.Application")
Set documentRef = appRef.ActiveDocument
selectedObjects = documentRef.Selection

Depending on what is selected, the selection property value can be an array of any type of art objects. To get or
manipulate the properties of the selected art items, you must retrieve the individual items in the array. To find out an
object’s type, use the typename property.

The following sample gets the first object in the array, then displays the object’s type

Set appRef = CreateObject ("Illustrator.Application")
Set documentRef = appRef.ActiveDocument
selectedObjects = documentRef.Selection

Set topObject = selectedObjects(®)

MsgBox (topObject.Typename)

The MsgBox method does not display a dialog when the script is run from the Illustrator Scripts menu (File > Scripts).

The first object in a selection array is the selected object that was last added to the page, not the last object selected.

37.3.1 Working with selections

To select an art object, the object’s Selected property.
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CHAPTER
THIRTYEIGHT

WORKING WITH TEXT FRAMES

To create a text frame of a specific type in VBScript, use the TextFrames method that corresponds to the type of frame
you want to create::

Set rectRef = docRef.PathItems.Rectangle(700, 50, 100, 100)

' Use the AreaText method to create the text frame
Set areaTextRef = docRef.TextFrames.AreaText(rectRef)

38.1 Threaded frames

As in the Illustrator application, you can thread area text frames or path text frames.
To thread existing text frames, use the NextFrame or PreviousFrame property of the TextFrames object.

When copying the following script to your script editor, place the value of the Contents property on one line. The
long-line character (_) is not valid within a string value.

Set appRef = CreateObject("Illustrator.Application")
Set myDoc = appRef.Documents.Add
Set myPathIteml = myDoc.PathItems.Rectangle(244, 64, 82, 76)
Set myTextFramel = myDoc.TextFrames.AreaText(myPathIteml)
myTextFramel.Contents = "This is two text frames linked together as one story, with.,
—text flowing from the first to the last."
Set myPathItem2 = myDoc.PathItems.Rectangle(144, 144, 42, 116)
Set myTextFrame2 = myDoc.TextFrames.AreaText(myPathItem2)

Use the NextFrame property to thread the frames
myTextFramel.NextFrame = myTextFrame2

appRef.Redraw()
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38.1.1 Threaded frames make one story object

Threaded frames make a single story object. To observe this, run the following VBScript after running the script above.

Set myDoc = appRef.ActiveDocument

myMsg = "alert(""There are " & CStr(myDoc.TextFrames.Count) & " text frames. "")"
appRef.DoJavaScript myMsg
myMsg = "alert(""There are " & CStr(myDoc.Stories.Count) & " storiess. "")"

appRef.DoJavaScript myMsg
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CHAPTER
THIRTYNINE

CREATING PATHS AND SHAPES

This section explains how to create items that contain paths.

39.1 Paths

To create line or a freeform path, specify a series of path points, as a series of x-y coordinates or PathPoint objects.

Using x-y coordinates limits the path to straight segments. To created a curved path, you must create PathPoint
objects. A path can comprise a combination of page coordinates and PathPoint objects.

39.1.1 Specifying a series of x-y coordinates

To specify a path using page-coordinate pairs, use the entire path property of the PathItems object. The following
script specifies three pairs of x-y coordinates, to create a path with three points

Set appRef = CreateObject ("Illustrator.Application")

Set firstPath = appRef.ActiveDocument.PathItems.Add
firstPath.Stroked = True
firstPath.SetEntirePath(Array(Array (220, 475),Array(375, 300),Array(200, 300)))

39.1.2 Using path point objects

To create a PathPoint object, you must define three values for the point.
* A fixed anchor point, which is the point on the path.

* A pair of direction points— left direction and right direction —which allow you to control the path
segment’s curve.

You define each property as an array of page coordinates in the format (Array (x,y)):

« Ifall three properties of a PathPoint object have the same coordinates, and the properties of the next PathPoint
in the line are equal to each other, you create a straight-line segment.

* If two or more properties in a PathPoint object hold different values, the segment connected to the point is
curved.

To create a path or add points to an existing path using PathPoint objects, create a PathItem object, then add the
path points as child objects in the PathItem
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Set appRef = CreateObject ("Illustrator.Application")

Set firstPath = appRef.ActiveDocument.PathItems.Add
firstPath.Stroked = true

Set newPoint = firstPath.PathPoints.Add

Using identical coordinates creates a straight segment

newPoint.Anchor = Array(75, 300)

newPoint.LeftDirection = Array(75, 300)

newPoint.RightDirection = Array(75, 300)

Set newPoint2 = firstPath.PathPoints.Add
newPoint2.Anchor = Array(175, 250)
newPoint2.LeftDirection = Array(175, 250)
newPoint2.RightDirection = Array(175, 250)

Set newPoint3 = firstPath.PathPoints.Add
'Using different coordinates creates a curve
newPoint3.Anchor = Array(275, 290)
newPoint3.LeftDirection = Array(135, 150)
newPoint3.RightDirection = Array(155, 150)

39.1.3 Combining path point types

The following script sample creates a path with three points

Set appRef = CreateObject("Illustrator.Application")
Set myDoc = appRef.ActiveDocument
Set myLine = myDoc.PathItems.Add
myLine.Stroked = True
myLine.SetEntirePath( Array( Array(320, 475), Array(375, 300)))

" Append another point to the line

Set newPoint = myLine.PathPoints.Add
Using identical coordinates creates a straight segment
newPoint.Anchor = Array(220, 300)
newPoint.LeftDirection = Array(220, 300)
newPoint.RightDirection = Array(220, 300)

39.2 Shapes

To create a shape, you use the object that corresponds to the shape’s name (like ellipse, rectangle, or polygon),
and use the object’s properties to specify the shape’s position, size, and other information like the number of sides in a

polygon.

Remember:

 The scripting engine processes all measurements and page coordinates as points. For details, see Measurement
Units.

* x and y coordinates are measured from the bottom-left corner of the document, as indicated in the Info panel in
the Illustrator application. For details, see Page-item positioning and dimensions.
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39.2.1 Creating a rectangle

Consider the following sample

Set appRef = CreateObject("Illustrator.Application")

Set frontDocument = appRef.ActiveDocument

' Create a new rectangle with

" top = 144, left side = 144, width = 72, height = 144

Set newRectangle = frontDocument.PathItems.Rectangle(144,144,72,144)

The sample creates a rectangle with these properties:
* The top of the rectangle is 2 inches (144 points) from the bottom edge of the page.
* The left edge is 2 inches (144 points) from the left edge of the page.
* The rectangle is 1 inch (72 points) wide and 2 inches (144 points) long.

39.2.2 Creating a polygon

Consider the following sample

Set appRef = CreateObject("Illustrator.Application")

Set frontDocument = appRef.ActiveDocument

' Create a new polygon with

" top = 144, left side = 288, width = 72, height = 144

Set newPolygon = frontDocument.PathItems.Polygon(144,288,72,7)

The sample creates a polygon with these properties:

» The center point of the object is inset is 2 inches (144 points) on the horizontal axis and 4 inches (288 points) on
the vertical axis.

* The polygon has 7 sides.

* The length of the radius from the center point to each corner is 1 inch (72 points).
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CHAPTER
FORTY

WORKING WITH ENUMERATION VALUES

Properties that use enumeration values in VBScript use a numeral rather than a text value. For example, the Orientation
property of the TextFrame object specifies whether text content in the text frame is horizontal or vertical. The property
uses the aiTextOrientation enumeration, which has two possible values, aiHorizontal and aiVertical.

To find the numeral values of enumerations, use either of the following:
» The object browser in your scripting editor environment. See Viewing the VBScript object model.

e The Adobe Illustrator CC 2017 Scripting Reference: VBScript, which lists the numeral values directly after the
constant value in the “Enumerations” chapter at the end of the book. The following example is from that table:

Enumeration type Values What it means
AiTextOrientation | aiHorizontal = ® aiVertical = 1 | The orientation of text in a text frame

The following sample specifies vertical text orientation

Set appRef = CreateObject ("Illustrator.Application")
Set docRef = appRef.Documents.Add

Set textRef = docRef.TextFrames.Add

textRef.Contents = "This is some text content."
textRef.Left = 50

textRef.Top = 700

textRef.Orientation = 1

Generally, it is considered good scripting practice to place the text value in a comment following the numeral value, as
in the following sample statement:

textRef.Orientation = 1 ' aiVertical
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CHAPTER
FORTYONE

WORKING WITH THE PERSPECTIVE GRID

The Perspective Grid is a new feature in lllustrator CC 2017 that enables you to create and manipulate art in a spatial
environment using established laws of perspective. Enable Perspective Grid using the View > Perspective Grid menu
or the perspective tools in the toolbar.

The SDK provides an API for working with the perspective grid programmatically, and your scripts have some access
to this API. A script can:

 Set a the default grid parameters using preset values.
» Show or hide the grid.

* Set the active plane.

* Draw an object in perspective on the active plane.

* Bring an object into perspective.

41.1 Use perspective presets

[lustrator provides default grid-parameter presets for one-point, two-point, and three-point perspectives. The presets
are named "[1P-NormalView]", "[2P-NormalView]", and " [3P-NormalView]".

The script shows how to select the two-point perspective preset programmatically:

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document
Set docRef = appRef.Documents.Add()

Rem Select the default two-point perspective preset
docRef.SelectPerspectivePreset (" [2P-Normal View]")

You can create new perspective presets, export presets to files, and import presets from files. These scripts shows how
to export and import presets:

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document

Set docRef = appRef.Documents.Add()

Rem Export perspective presets to a file
docRef.ExportPerspectiveGridPreset("C:/scripting/PGPresetsExported™)

(continues on next page)
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(continued from previous page)

Set appRef
Rem Create a new document

Set docRef = appRef.Documents.Add()

Rem Import perspective presets from a file

docRef.ImportPerspectiveGridPreset("C:/scripting/PGPresets")

CreateObject ("Illustrator.Application")

41.2 Show or hide the grid

This script shows or hides the Perspective Grid programmatically:

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document

Set docRef = appRef.Documents.Add()

Rem Show the Perspective Grid defined in the document

docRef.ShowPerspectiveGrid();

Rem Hide the Perspective Grid defined in the document

docRef.HidePerspectiveGrid();

41.3 Set the active plane

The perspective grid plane types are:

Left plane

aiLEFTPLANE (1)

Right plane

aiRIGHTPLANE (2)

Floor plane

aiFLOORPLANE (3)

Invalid plane

aiNOPLANE (4)

For a one-point perspective grid, only the left and floor plane are valid.

This script sets the active perspective plane to the left plane:

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document
Set docRef = appRef.Documents.Add()

Rem Set left plane as the active plane

docRef.SetPerspectiveActivePlane(1l) 'ailLEFTPLANE
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41.4 Draw on a perspective grid

When the Perspective Grid is on, drawing methods allow you to draw or operate on objects in perspective. This script
creates a new document, shows a two-point perspective grid, and draws art objects on the left plane

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document
Set docRef = appRef.Documents.Add()

Rem Select the default two point perspective preset
docRef.SelectPerspectivePreset (" [2P-Normal View]")

Rem Display the perspective grid defined in the document
docRef.ShowPerspectiveGrid()

Rem Check if active plane is set to left, otherwise set it to left

If docRef.GetPerspectiveActivePlane() <> 1 Then
docRef.SetPerspectiveActivePlane(l) 'ailLEFTPLANE

End If

Rem Draw rectangle in perspective, then resize to 200% and move
Set pathItemRect = docRef.PathItems.Rectangle(30, -30, 30, 30, False)

call pathItemRect.Resize(200, 200, True, False, False, False, 100, 2)
call pathItemRect.Translate(-420, 480)

Rem Draw ellipse in perspective
Set pathItemEllipse = docRef.PathItems.Ellipse(60, -60, 30, 30, False, True)

Rem Draw rounded rectangle in perspective
Set pathItemRRect = docRef.PathItems.RoundedRectangle(90, -90, 30, 30, 10, 10, False)

Rem Draw polygon in perspective
Set pathItemPoly = docRef.PathItems.Polygon(-105, 105, 15, 7, False)

Rem Draw star in perspective
Set pathItemStar = docRef.PathItems.Star(-135, 135, 15, 10, 6, False)

Rem Draw path in perspective
Set newPath = docRef.PathItems.Add()
newPath.SetEntirePath(Array(Array(0,0),Array(60,0),Array(30,45),Array(90,110)))
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41.5 Bring objects into perspective

If an art object is not in perspective, use the bringInPerspective () method to bring it into perspective and place it
on a plane.

This script creates a new document, draws an art object, and brings it into perspective on a three-point perspective grid

Set appRef = CreateObject ("Illustrator.Application")

Rem Create a new document
Set docRef = appRef.Documents.Add()

Rem Draw ellipse
Set pathItemEllipse = docRef.PathItems.Ellipse(60, -60, 30, 30, False, True)

Rem Draw polygon
Set pathItemPoly = docRef.PathItems.Polygon(-105, 105, 15, 7, False)

Rem Draw star
Set pathItemStar = docRef.PathItems.Star(-135, 135, 15, 10, 6, False)

Rem Select the default three-point perspective preset
docRef.SelectPerspectivePreset (" [3P-Normal View]")

Rem Display the perspective grid defined in the document
docRef.ShowPerspectiveGrid()

Rem Check if active plane is set to left, otherwise set it to left

If docRef.GetPerspectiveActivePlane() <> 1 Then
docRef.SetPerspectiveActivePlane(1l) 'ailLEFTPLANE

End If

Rem Bring the ellipse to the active plane (left plane)
Call pathItemEllipse.BringInPerspective(100,100, 1) 'ailLEFTPLANE

Rem Bring the polygon to the right plane
Call pathItemPoly.BringInPerspective(100,-100,2) 'aiRIGHTPLANE

Rem Bring the star to the floor plane
Call pathItemStar.BringInPerspective(100,100,3) 'aiFLOORPLANE
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CHAPTER
FORTYTWO

SCRIPTING CONSTANTS

This chapter lists and describes the enumerations defined for use with Illustrator JavaScript properties and methods.

42.1 AlternateGlyphsForm

The alternate glyphs form of text.

Value Description
AlternateGlyphsForm.DEFAULTFORM Defaultform
AlternateGlyphsForm.TRADITIONAL Traditional
AlternateGlyphsForm.EXPERT Expert
AlternateGlyphsForm.JIS78FORM JIS78FORM
AlternateGlyphsForm.JIS83FORM JIS§3FORM
AlternateGlyphsForm.HALFWIDTH Half Width
AlternateGlyphsForm.THIRDWIDTH Third Width
AlternateGlyphsForm.QUARTERWIDTH Quarter Width
AlternateGlyphsForm.FULLWIDTH Full Width
AlternateGlyphsForm.PROPORTIONALWIDTH | Proportional Width
AlternateGlyphsForm.JIS90FORM JISOSOFORM
AlternateGlyphsForm.JISQ4FORM JISO4FORM

Example

textRef.textRange.characters[i].characterAttributes.alternateGlyphs ==_

—AlternateGlyphsForm.DEFAULTFORM;

textRef.textRange.characters[i].characterAttributes.alternateGlyphs

—AlternateGlyphsForm.FULLWIDTH
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42.2 AntiAliasingMethod

The type of antialiasing method used in the rasterization.

Value

Description

AntiAliasingMethod.None

No antialiasing is allowed.

AntiAliasingMethod.ARTOPTIMIZED

Optimize for the art object.

AntiAliasingMethod.TYPEOPTIMIZED

Optimize for the type object.

42.3 ArtClippingOption

How the art should be clipped during output.

Value

Description

ArtClippingOption.OUTPUTARTBOUNDS

Output size is the size of the artwork.

ArtClippingOption.OUTPUTARTBOARDBOUNDS

Output size is the size of the artboard.

ArtClippingOption.OUTPUTCROPRECTBOUNDS

Output size is the size of the crop area.

42.4 AutoCADColors

Value Description
AutoCADColors.Max8Colors Max 8 CColors
AutoCADColors.Max16Colors Max 16 Colors
AutoCADColors.Max256Colors | Max 25 6Colors
AutoCADColors.TrueColors True Colors

42.5 AutoCADCompatibility

Value Description
AutoCADCompatibility.AutoCADReleasel3 | Release 13
AutoCADCompatibility.AutoCADReleasel8 | Release 18
AutoCADCompatibility.AutoCADReleaseld4 | Release 14
AutoCADCompatibility.AutoCADRelease2l | Release 21
AutoCADCompatibility.AutoCADReleasel5 | Release 15
AutoCADCompatibility.AutoCADRelease24 | Release 24
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42.6 AutoCADExportFileFormat

Value Description
AutoCADExportFileFormat.DXF | DXF
AutoCADExportFileFormat.DWG | DWG
42.7 AutoCADEXxportOption
Value Description

AutoCADExportOption.PreserveAppearance Preserve Appearance

AutoCADExportOption.MaximizeEditability | Maximize Editability

42.8 AutoCADGIlobalScaleOption

Value

Description

AutoCADGlobalScaleOption.OriginalSize | Original Size

AutoCADGlobalScaleOption.ScaleByValue | Scale by Value

AutoCADGlobalScaleOption.FitArtboard Fit Artboard

42.9 AutoCADRasterFormat

Value Description

AutoCADRasterFormat.PNG PNG

AutoCADRasterFormat.JPEG | JPEG

42.10 AutoCADUnit

Value Description
AutoCADUnit.Points Points
AutoCADUnit.Picas Picas
AutoCADUnit.Inches Inches
AutoCADUnit.Millimeters | Millimeters
AutoCADUnit.Centimeters | Centimeters
AutoCADUnit.Pixels Pixels

42.6. AutoCADExportFileFormat
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42.11 AutoKernType

The auto kern type.
Value Description
AutoKernType . NOAUTOKERN None
AutoKernType.AUTO Auto
AutoKernType.OPTICAL Optical
AutoKernType.METRICSROMANONLY | Metrics

42.12 AutolLeadingType

The auto leading type.
Value Description
AutoLeadingType.BOTTOMTOBOTTOM | Bottom to Bottom
AutoLeadingType.TOPTOTOP Top to Top

42.13 BaselineDirectionType

The baseline direction type.

Value Description
BaselineDirectionType.Standard Standard
BaselineDirectionType.VerticalRotated | Vertical Rotated
BaselineDirectionType.TateChuYoko TateChuYoko

42.14 BlendAnimationType

Value Description
BlendAnimationType.INBUILD In Build
BlendAnimationType.NOBLENDANIMATION | None
BlendAnimationType.INSEQUENCE In Sequence
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42.15 BlendModes

The blend mode used when compositing an object.

Value Description
BlendModes .COLORBLEND Color
BlendModes.COLORBURN Color Burn
BlendModes.COLORDODGE Color Dodge
BlendModes.DARKEN Darken
BlendModes.DIFFERENCE Difference
BlendModes .EXCLUSION Exclusion
BlendModes .HARDLIGHT Hard Light
BlendModes.HUE Hue
BlendModes.LIGHTEN Lighten
BlendModes.LUMINOSITY Luminosity
BlendModes.MULTIPLY Multiply
BlendModes .NORMAL Normal
BlendModes.OVERLAY Overlay
BlendModes.SATURATIONBLEND | Saturation
BlendModes.SCREEN Screen
BlendModes.SOFTLIGHT Soft Light

42.16 BlendsExpandPolicy

Policy used by FXG file format to expand blends.

Value Description

BlendsExpandPolicy.AUTOMATICALLYCONVERTBLENDS | Automatically convert blends

BlendsExpandPolicy.RASTERIZEBLENDS

Rasterize blends

42.17 BurasagariTypeEnum

The Burasagari type.

Value

Description

BurasagariTypeEnum.Forced

Forced

BurasagariTypeEnum.None

None

BurasagariTypeEnum.Standard

Standard

42.15. BlendModes
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42.18 CaseChangeType

The case change type.
Value Description
CaseChangeType.LOWERCASE Lowercase ("hello world")
CaseChangeType.SENTENCECASE | Sentence case ("Hello world")
CaseChangeType.TITLECASE Title case ("Hello World")
CaseChangeType.UPPERCASE Uppercase ("HELLO WORLD")

42.19 ColorConversion

The color conversion policy.

Value Description
ColorConversion.COLORCONVERSIONREPURPOSE | Color Conversion Repurpose
ColorConversion.COLORCONVERSIONTODEST Color Conversion to Dest
ColorConversion.None None

42.20 ColorConvertPurpose

The purpose of color conversion using the ConvertSampleColor method of the Application class.

Value Description
ColorConvertPurpose.defaultpurpose | Default
ColorConvertPurpose.exportpurpose Export
ColorConvertPurpose.previewpurpose | Preview
ColorConvertPurpose.dummypurpose Dummy

42.21 ColorDestination

Destination profile

Value Description
ColorDestination.COLORDESTINATIONDOCCMYK Doc CMYK
ColorDestination.COLORDESTINATIONDOCRGB Doc RGB
ColorDestination.COLORDESTINATIONPROFILE Profile

ColorDestination.COLORDESTINATIONWORKINGCMYK | Working CMYK
ColorDestination.COLORDESTINATIONWORKINGRGB Working RGB
ColorDestination.None None
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42.22 ColorDitherMethod

The method used to dither colors in exported GIF and PNGS8 images.

Value Description
ColorDitherMethod.DIFFUSION Diffusion
ColorDitherMethod.NOISE Noise

ColorDitherMethod.NOREDUCTION

No Reduction

ColorDitherMethod.PATTERNDITHER

Pattern Dither

42.23 ColorModel

The color model to use.

Value Description
ColorModel .PROCESS Process
ColorModel .REGISTRATION | Registration
ColorModel.SPOT Spot
42.24 ColorProfile
Value Description
ColorProfile.INCLUDEALLPROFILE Include All Profile
ColorProfile.INCLUDEDESTPROFILE Include Dest Profile
ColorProfile.INCLUDERGBPROFILE Include RGB Profile
ColorProfile.LEAVEPROFILEUNCHANGED | Leave Profile Unchanged
ColorProfile.None None

42.25 ColorReductionMethod

The method used to reduce the number of colors in exported GIF and PNG8 images.

Value Description
ColorReductionMethod.ADAPTIVE Adaptive
ColorReductionMethod.SELECTIVE Selective
ColorReductionMethod.PERCEPTUAL | Perceptual
ColorReductionlMethod.WEB Web

42.22. ColorDitherMethod
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42.26 ColorType

The color specification for an individual color.

Value Description
ColorType.CMYK Cmyk
ColorType.GRADIENT | Gradient
ColorType.GRAY Gray
ColorType.PATTERN Pattern
ColorType.RGB Rgb
ColorType.SPOT Spot
ColorType.NONE None

42.27 Compatibility

The version of the Illustrator file to create when saving an EPS or Illustrator file

Value Description
Compatibility.ILLUSTRATORS8 Illustrator 8
Compatibility.ILLUSTRATOR9 Illustrator 9
Compatibility.ILLUSTRATOR10 Illustrator 10
Compatibility.ILLUSTRATOR11 Illustrator 11
Compatibility.ILLUSTRATOR12 Illustrator 12
Compatibility.ILLUSTRATOR13 Illustrator 13
Compatibility.ILLUSTRATOR14 Illustrator 14
Compatibility.ILLUSTRATOR15 Illustrator 15
Compatibility.ILLUSTRATOR16 Illustrator 16
Compatibility.ILLUSTRATOR17 Illustrator 17
Compatibility.ILLUSTRATOR19 Illustrator 19
Compatibility.JAPANESEVERSION3 | Japanese Version 3

42.28 CompressionQuality

The quality of bitmap compression used when saving a PDF file
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Value Description
CompressionQuality.AUTOMATICIPEG2000HIGH todo
CompressionQuality.AUTOMATICIPEG200OLOSSLESS | todo
CompressionQuality.AUTOMATICIPEG2000LOW todo
CompressionQuality.AUTOMATICIPEG2000MAXIMUM todo
CompressionQuality.AUTOMATICIPEG2000MEDIUM todo
CompressionQuality.AUTOMATICIPEG2000MINIMUM todo
CompressionQuality.AUTOMATICIPEGHIGH todo
CompressionQuality.AUTOMATICIPEGLOW todo
CompressionQuality.AUTOMATICIPEGMAXIMUM todo
CompressionQuality.AUTOMATICIPEGMEDIUM todo
CompressionQuality.AUTOMATICIPEGMINIMUM todo
CompressionQuality.JPEG2000HIGH todo
CompressionQuality.JPEG200OLOSSLESS todo
CompressionQuality.JPEG2000LOW todo
CompressionQuality.JPEG2000MAXIMUM todo
CompressionQuality.JPEG200OMEDIUM todo
CompressionQuality.JPEG2000MINIMUM todo
CompressionQuality.JPEGHIGH todo
CompressionQuality.JPEGLOW todo
CompressionQuality.JPEGMAXIMUM todo
CompressionQuality.JPEGMEDIUM todo
CompressionQuality.JPEGMINIMUM todo
CompressionQuality.ZIP4BIT todo
CompressionQuality.ZIP8BIT todo
CompressionQuality.None todo
42.29 CoordinateSystem
The coordinate system used by Illustrator

Value Description

CoordinateSystem.ARTBOARDCOORDINATESYSTEM | todo

CoordinateSystem.DOCUMENTCOORDINATESYSTEM | todo

42.30 CropOptions

The style of a document’s cropping box

Value Description

CropOptions.Japanese | Japanese

CropOptions.Standard | Standard

42.29. CoordinateSystem
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42.31 DocumentArtboardLayout

The layout of in the new document.

Value Description
DocumentArtboardLayout .Column todo
DocumentArtboardLayout.GridByCol todo
DocumentArtboardLayout .GridByRow todo

DocumentArtboardLayout .RLGridByCol | todo
DocumentArtboardLayout.RLGridByRow | todo
DocumentArtboardLayout .RLRow todo
DocumentArtboardLayout.Row todo

42.32 DocumentColorSpace

The color space of a document

Value Description
DocumentColorSpace.CMYK | CMYK
DocumentColorSpace.RGB RGB

42.33 DocumentLayoutStyle

Layout style for the document

Value Description
DocumentLayoutStyle.CASCADE todo
DocumentLayoutStyle.CONSOLIDATEALL | todo
DocumentLayoutStyle.FLOATALL todo
DocumentLayoutStyle.HORIZONTALTILE | todo
DocumentLayoutStyle.VERTICALTILE todo

42.34 DocumentPresetType

The preset types available for new documents.
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Value Description
DocumentPresetType.BasicCMYK | Basic CMYK
DocumentPresetType.BasicRGB Basic RGB
DocumentPresetType.Mobile Mobile
DocumentPresetType.Print Print
DocumentPresetType.Video Video
DocumentPresetType.Web Web
42.35 DocumentPreviewMode
The document preview mode.
Value Description
DocumentPreviewMode.Defaul tPreview Default
DocumentPreviewMode.OverprintPreview | Overprint
DocumentPreviewMode.PixelPreview Pixel
42.36 DocumentRasterResolution
The preset document raster resolution.
Value Description

DocumentRasterResolution.ScreenResolution

Screen Resolution

DocumentRasterResolution.HighResolution

High Resolution

DocumentRasterResolution.MediumResolution

Medium Resolution

42.37 DocumentTransparencyGrid

Document transparency grid colors.

Value Description
DocumentTransparencyGrid.TransparencyGridBlue Blue
DocumentTransparencyGrid. TransparencyGridDark Dark

DocumentTransparencyGrid.TransparencyGridGreen Green

DocumentTransparencyGrid.TransparencyGridLight Light

DocumentTransparencyGrid.TransparencyGridMedium

Medium

DocumentTransparencyGrid.TransparencyGridNone None

DocumentTransparencyGrid.TransparencyGridOrange

Orange

DocumentTransparencyGrid.TransparencyGridPurple | Purple

DocumentTransparencyGrid.TransparencyGridRed Red

42.35. DocumentPreviewMode
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42.38 DocumentType

The file format used to save a file.

Value Description
DocumentType.EPS EPS
DocumentType.FXG FXG
DocumentType.ILLUSTRATOR | Illustrator
DocumentType.PDF PDF
42.39 DownsampleMethod
Value Description

DownsampleMethod.AVERAGEDOWNSAMPLE

Average Downsample

DownsampleMethod.BICUBICDOWNSAMPLE

Bicubic Downsample

DownsampleMethod.NODOWNSAMPLE

No Downsample

DownsampleMethod . SUBSAMPLE Subsample

42.40 ElementPlacement

Value Description

ElementPlacement.INSIDE Inside

ElementPlacement .PLACEAFTER Place After

ElementPlacement .PLACEATBEGINNING | Place At Beginning

ElementPlacement .PLACEATEND Place At End

ElementPlacement .PLACEBEFORE Place Before

42.41 EPSPostScriptLevelEnum

Value Description
EPSPostScriptLevelEnum.LEVEL2 | Level 2
EPSPostScriptLevelEnum.LEVEL3 | Level 3
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42.42 EPSPreview

The preview image format used when saving an EPS file

Value Description
EPSPreview.BWTIFF todo
EPSPreview.COLORTIFF todo
EPSPreview. TRANSPARENTCOLORTIFF | todo
EPSPreview.None todo
42.43 ExportType
The file format used to export a file
Value Description
ExportType.AutoCAD AutoCAD
ExportType.FLASH FLASH
ExportType.GIF GIF
ExportType. JPEG JPEG
ExportType.Photoshop | Photoshop
ExportType.PNG24 PNG24
ExportType.PNG8 PNGS8
ExportType.SVG SVG
ExportType.TIFF TIFF
42.44 FigureStyleType
Value Description
FigureStyleType.DEFAULTFIGURESTYLE todo
FigureStyleType.PROPORTIONAL todo
FigureStyleType.PROPORTIONALOLDSTYLE | todo
FigureStyleType.TABULAR todo
FigureStyleType.TABULAROLDSTYLE todo

42.42. EPSPreview
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42.45 FiltersPreservePolicy

The filters preserve policy used by the FXG file format.

Value

Description

FiltersPreservePolicy.EXPANDFILTERS

todo

FiltersPreservePolicy.KEEPFILTERSEDITABLE | todo

FiltersPreservePolicy.RASTERIZEFILTERS todo

42.46 FlashExportStyle

The method used to convert Illustrator images when exporting files
Value Description
FlashExportStyle.ASFLASHFILE todo
FlashExportStyle.LAYERSASFILES todo
FlashExportStyle.LAYERSASFRAMES todo
FlashExportStyle.LAYERSASSYMBOLS | todo
FlashExportStyle.TOFILES todo

42.47 FlashExportVersion

Version for exported SWF file.
Value Description
FlashExportVersion.FlashVersionl | Version 1
FlashExportVersion.FlashVersion2 | Version 2
FlashExportVersion.FlashVersion3 | Version 3
FlashExportVersion.FlashVersion4 | Version 4
FlashExportVersion.FlashVersion5 | Version 5
FlashExportVersion.FlashVersion6 | Version 6
FlashExportVersion.FlashVersion7 | Version 7
FlashExportVersion.FlashVersion8 | Version 8
FlashExportVersion.FlashVersion9 | Version 9
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42.48 FlashimageFormat

The format used to store flash images.

Value Description
FlashImageFormat.LOSSLESS | Lossless
FlashImageFormat.LOSSY Lossy

42.49 FlashJPEGMethod

The method used to store JPEG images.
Value Description
FlashJPEGMethod.Optimized | Optimized
FlashJPEGMethod. Standard Standard

42.50 FlashPlaybackSecurity

Value Description

FlashPlaybackSecurity.PlaybackLocal Local

FlashPlaybackSecurity.PlaybackNetwork | Network

42.51 FontBaselineOption

Value Description
FontBaselineOption.NORMALBASELINE | todo
FontBaselineOption.SUPERSCRIPT todo
FontBaselineOption.SUBSCRIPT todo
42.52 FontCapsOption
Value Description
FontCapsOption.ALLCAPS All Caps
FontCapsOption.ALLSMALLCAPS | All Smallcaps
FontCapsOption.NORMALCAPS Normal Caps
FontCapsOption.SMALLCAPS Small Caps
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42.53 FontOpenTypePositionOption

Value Description
FontOpenTypePositionOption.DENOMINATOR Denominator
FontOpenTypePositionOption.NUMERATOR Numerator
FontOpenTypePositionOption.OPENTYPEDEFAULT Opentype Default
FontOpenTypePositionOption.OPENTYPESUBSCRIPT Opentype Subscript
FontOpenTypePositionOption.OPENTYPESUPERSCRIPT | Opentype Superscript

42.54 FontSubstitutionPolicy

Value Description
FontSubstitutionPolicy.SUBSTITUTEDEVICE Device
FontSubstitutionPolicy.SUBSTITUTEOBLIQUE | Oblique
FontSubstitutionPolicy.SUBSTITUTETINT Tint

42.55 FXGVersion

The FXG file-format version.

Value Description
FXGVersion.VERSION1PT® | Version 1 PTO
FXGVersion.VERSION2PT® | Version 2 PTO

42.56 GradientsPreservePolicy

The gradients preserve policy used by the FXG file format.

Value Description
GradientsPreservePolicy.AUTOMATICALLYCONVERTGRADIENTS | Automaticaly Convert Gradients
GradientsPreservePolicy.KEEPGRADIENTSEDITABLE Keep Gradients Editable
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42.57 GradientType

The type of gradient.
Value Description
GradientType.LINEAR | Linear
GradientType.RADIAL | Radial
42.58 ImageColorSpace
The color space of a raster item or an exported file
Value Description
ImageColorSpace.CMYK CMYK
ImageColorSpace.DeviceN DeviceN

ImageColorSpace.Grayscale Grayscale

ImageColorSpace.Indexed Indexed
ImageColorSpace.LAB LAB
ImageColorSpace.RGB RGB

ImageColorSpace.Separation | Separation

42.59 InkPrintStatus

Value

Description

InkPrintStatus.CONVERTINK | Convert Ink

InkPrintStatus.ENABLEINK

Enable Ink

InkPrintStatus.DISABLEINK | Disable Ink

42.60 InkType

Value Description
InkType.BLACKINK Black Ink
InkType.CUSTOMINK Custom Ink
InkType.CYANINK Cyan Ink
InkType.MAGENTAINK | Magenta Ink
InkType.YELLOWINK Yellow Ink
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42.61 JavaScriptExecutionMode

Value Description
JavaScriptExecutionMode.BeforeRunning Before Running
JavaScriptExecutionMode.OnRuntimeError | On Runtime Error
JavaScriptExecutionMode.never Never

42.62 Justification

The alignment or justification for a paragraph of text.

Value Description
Justification.CENTER Center
Justification.FULLJUSTIFY Full Justify

Justification.FULLJUSTIFYLASTLINECENTER | Full Justify Last Line Center
Justification.FULLJUSTIFYLASTLINELEFT Full Justify Last Line Left
Justification.FULLJUSTIFYLASTLINERIGHT | Full Justify Last Line Right
Justification.LEFT Left
Justification.RIGHT Right

42.63 KinsokuOrderEnum

Value Description
KinsokuOrderEnum.PUSHIN todo
KinsokuOrderEnum.PUSHOUTFIRST | todo
KinsokuOrderEnum.PUSHOUTONLY todo

42.64 KnockoutState

The type of knockout to use on a page item.

Value Description
KnockoutState.DISABLED Disabled
KnockoutState.ENABLED Enabled
KnockoutState.INHERITED | Inherited
KnockoutState.Unknown Unknown
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42.65 LanguageType

Value Description
LanguageType . BOKMALNORWEGIAN todo
LanguageType .BRAZILLIANPORTUGUESE todo
LanguageType .BULGARIAN todo
LanguageType.CANADIANFRENCH todo
LanguageType.CATALAN todo
LanguageType.CHINESE todo
LanguageType .CZECH todo
LanguageType.DANISH todo
LanguageType .DUTCH todo
LanguageType .DUTCH2005REFORM todo
LanguageType .ENGLISH todo
LanguageType.FINNISH todo
LanguageType .GERMAN20O6REFORM todo
LanguageType . GREEK todo
LanguageType .HUNGARIAN todo
LanguageType.ICELANDIC todo
LanguageType.ITALIAN todo
LanguageType. JAPANESE todo
LanguageType.NYNORSKNORWEGIAN todo
LanguageType.OLDGERMAN todo
LanguageType.POLISH todo
LanguageType .RUMANIAN todo
LanguageType.RUSSIAN todo
LanguageType.SERBIAN todo
LanguageType.SPANISH todo
LanguageType . STANDARDFRENCH todo
LanguageType . STANDARDGERMAN todo
LanguageType.STANDARDPORTUGUESE todo
LanguageType.SWEDISH todo
LanguageType . SWISSGERMAN todo
LanguageType.SWISSGERMAN2OO6REFORM | todo
LanguageType . TURKISH todo
LanguageType.UKENGLISH todo
LanguageType .UKRANIAN todo
42.66 LayerOrderType

Value Description

LayerOrderType.TOPDOWN Top Down

LayerOrderType.BOTTOMUP | Bottom Up

42.66. LayerOrderType
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42.67 LibraryType

Mlustrator library type.

Value Description
LibraryType.Brushes Brushes
LibraryType.GraphicStyles Graphic Styles
LibraryType.IllustratorArtwork | Illustrator Artwork
LibraryType.Swatches Swatches
LibraryType.Symbols Symbols

42.68 MonochromeCompression

The type of compression to use on a monochrome bitmap item when saving a PDF file.

Value Description
MonochromeCompression.CCIT3 CCIT3
MonochromeCompression.CCIT4 CCIT4
MonochromeCompression.MONOZIP MONOZIP
MonochromeCompression.None None
MonochromeCompression.RUNLENGTH | RUNLENGTH

42.69 OutputFlattening

How transparency should be flattened when saving EPS and Illustrator file formats with compatibility set to versions
of Illustrator earlier than Illustrator 10

Value Description
OutputFlattening.PRESERVEAPPEARANCE | Preserve Appearance
OutputFlattening.PRESERVEPATHS Preserve Paths

42.70 PageMarksTypes

Value Description
PageMarksTypes.Japanese | Japanese
PageMarksTypes.Roman Roman
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42.71 PathPointSelection

Which points, if any, of a path are selected.

Value

Description

PathPointSelection.ANCHORPOINT todo

PathPointSelection.LEFTDIRECTION todo

PathPointSelection.LEFTRIGHTPOINT | todo

PathPointSelection.NOSELECTION todo

PathPointSelection.RIGHTDIRECTION | todo

42.72 PDFBoxType

Value Description
PDFBoxType .PDFARTBOX todo
PDFBoxType.PDFBLEEDBOX todo
PDFBoxType.PDFBOUNDINGBOX | todo
PDFBoxType . PDFCROPBOX todo
PDFBoxType.PDFMEDIABOX todo
PDFBoxType .PDFTRIMBOX todo
42.73 PDFChangesAllowedEnum
Value Description
PDFChangesAllowedEnum.CHANGE128ANYCHANGES | todo
PDFChangesAllowedEnum.CHANGE128COMMENTING | todo
PDFChangesAllowedEnum.CHANGE128EDITPAGE todo
PDFChangesAllowedEnum.CHANGE128FILLFORM todo
PDFChangesAllowedEnum.CHANGE128NONE todo
PDFChangesAllowedEnum.CHANGE40ANYCHANGES todo
PDFChangesAllowedEnum.CHANGE40OCOMMENTING todo
PDFChangesAllowedEnum . CHANGE4ONONE todo
PDFChangesAllowedEnum.CHANGE4OPAGELAYOUT todo
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42.74 PDFCompatibility

The version of the Acrobat file format to create when saving a PDF file

Value Description

PDFCompatibility.ACROBAT4 | Acrobat 4

PDFCompatibility.ACROBAT5 | Acrobat 5

PDFCompatibility.ACROBAT6 | Acrobat 6

PDFCompatibility.ACROBAT7 | Acrobat 7

PDFCompatibility.ACROBAT8 | Acrobat 8

42.75 PDFOverprint

Value Description

PDFOverprint .DISCARDPDFOVERPRINT Discard Pdf Overprint

PDFOverprint.PRESERVEPDFOVERPRINT | Preserve Pdf Overprint

42.76 PDFPrintAllowedEnum

Value Description
PDFPrintAllowedEnum.PRINT128HIGHRESOLUTION | 128 High Resolution
PDFPrintAllowedEnum.PRINT128LOWRESOLUTION 128 Low Resolution
PDFPrintAllowedEnum.PRINT128NONE 128 None
PDFPrintAllowedEnum.PRINT40HIGHRESOLUTION 40 High Resolution
PDFPrintAllowedEnum.PRINT40NONE 40 None
42.77 PDFTrimMarkWeight
Value Description
PDFTrimMarkWeight.TRIMMARKWEIGHTO125 | Weight 0125
PDFTrimMarkWeight . TRIMMARKWEIGHT®25 Weight 025
PDFTrimMarkWeight . TRIMMARKWEIGHT®5 Weight 05
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42.78 PDFXStandard

Value Description
PDFXStandard.PDFX1A2001 | PDFX1A2001
PDFXStandard.PDFX1A2003 | PDFX1A2003
PDFXStandard.PDFX32002 PDFX32002
PDFXStandard.PDFX32003 PDFX32003
PDFXStandard.PDFX42007 PDFX42007
PDFXStandard.PDFXNONE PDFXNONE

42.79 PerspectiveGridType

Value Description
PerspectiveGridType.OnePointPerspectiveGridType One Point Perspective Grid Type
PerspectiveGridType.TwoPointPerspectiveGridType Two Point Perspective Grid Type
PerspectiveGridType.ThreePointPerspectiveGridType | Three Point Perspective Grid Type
PerspectiveGridType.InvalidPerspectiveGridType Invalid Perspective Grid Type

42.80 PerspectiveGridPlaneType

Value Description
PerspectiveGridPlaneType.GRIDLEFTPLANETYPE Grid Left Plane Type
PerspectiveGridPlaneType.GRIDRIGHTPLANETYPE Grid Right Plane Type
PerspectiveGridPlaneType.GRIDFLOORPLANETYPE Grid Floor Plane Type
PerspectiveGridPlaneType.INVALIDGRIDPLANETYPE | Invalid Grid Plane Type

42.81 PhotoshopCompatibility

Value Description
PhotoshopCompatibility.Photoshop6 | Photoshop 6
PhotoshopCompatibility.Photoshop8 | Photoshop 8
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42.82 PointType

The type of path point selected

Value Description
PointType.CORNER | Corner
PointType.SMOOTH | Smooth

42.83 PolarityValues

Value Description
PolarityValues.NEGATIVE | Negative
PolarityValues.POSITIVE | Positive

42.84 PostScriptimageCompressionType

Value Description
PostScriptImageCompressionType.IMAGECOMPRESSIONNONE | todo
PostScriptImageCompressionType.JPEG todo
PostScriptImageCompressionType.RLE todo

42.85 PrintArtworkDesignation

Value Description
PrintArtworkDesignation.ALLLAYERS All Layers
PrintArtworkDesignation.VISIBLELAYERS Visible Layers
PrintArtworkDesignation.VISIBLEPRINTABLELAYERS | Visible Printable Layers

42.86 PrintColorintent

Value Description
PrintColorIntent.ABSOLUTECOLORIMETRIC | todo
PrintColorIntent.PERCEPTUALINTENT todo
PrintColorIntent.RELATIVECOLORIMETRIC | todo
PrintColorIntent.SATURATIONINTENT todo

128 Chapter 42. Scripting Constants



lllustrator Scripting Guide, Release 0.0.1

42.87 PrintColorProfile

Value Description
PrintColorProfile.CUSTOMPROFILE Custom Profile
PrintColorProfile.PRINTERPROFILE Printer Profile
PrintColorProfile.OLDSTYLEPROFILE | Oldstyle Profile
PrintColorProfile.SOURCEPROFILE Source Profile

42.88 PrintColorSeparationMode

Value Description
PrintColorSeparationlMode.COMPOSITE Composite
PrintColorSeparationMode.HOSTBASEDSEPARATION | Host-Based Separation
PrintColorSeparationMode.INRIPSEPARATION Inrip Separation

42.89 PrinterColorMode

Value Description
PrinterColorMode.BLACKANDWHITEPRINTER | Black & White
PrinterColorMode.COLORPRINTER Color
PrinterColorMode.GRAYSCALEPRINTER Grayscale

42.90 PrinterPostScriptLevelEnum

Value Description
PrinterPostScriptLevelEnum.PSLEVEL1 | PS LEVEL 1
PrinterPostScriptLevelEnum.PSLEVEL2 | PS LEVEL 2
PrinterPostScriptLevelEnum.PSLEVEL3 | PS LEVEL 3
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42.91 PrinterTypeEnum

Description
Non Postscript Printer
Postscript Printer

Value
PrinterTypeEnum.NONPOSTSCRIPTPRINTER
PrinterTypeEnum.POSTSCRIPTPRINTER

PrinterTypeEnum.Unknown Unknown
42.92 PrintFontDownloadMode
Value Description

Download None
Download Complete
Download Subset

PrintFontDownloadMode .DOWNLOADNONE
PrintFontDownloadMode .DOWNLOADCOMPLETE
PrintFontDownloadMode .DOWNLOADSUBSET

42.93 PrintingBounds

Description
Artboard Bounds
Artwork Bounds

Value
PrintingBounds.ARTBOARDBOUNDS
PrintingBounds.ARTWORKBOUNDS

42.94 PrintOrientation

The artwork printing orientation.

Value Description
PrintOrientation.AUTOROTATE Auto Rotate
PrintOrientation.LANDSCAPE Landscape
PrintOrientation.PORTRAIT Portrait

PrintOrientation

.REVERSELANDSCAPE

Reverse Landscape

PrintOrientation

.REVERSEPORTRAIT

Reverse Portrait
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42.95 PrintPosition

Value Description
PrintPosition.TRANSLATEBOTTOM Translate Bottom
PrintPosition.TRANSLATEBOTTOMLEFT Translate Bottom Left
PrintPosition.TRANSLATEBOTTOMRIGHT | Translate Bottom Right

PrintPosition.TRANSLATECENTER Translate Center
PrintPosition.TRANSLATELEFT Translate Left
PrintPosition.TRANSLATERIGHT Translate Right
PrintPosition.TRANSLATETOP Translate Top
PrintPosition.TRANSLATETOPLEFT Translate Top Left
PrintPosition.TRANSLATETOPRIGHT Translate Top Right

42.96 PrintTiling

Value Description
PrintTiling.TILEFULLPAGES Full Pages
PrintTiling.TILESINGLEFULLPAGE | Single Full Page
PrintTiling.TILEIMAGEABLEAREAS | Imageable Areas

42.97 RasterizationColorModel

The color model for the rasterization.

Value Description
RasterizationColorModel.BITMAP Bitmap
RasterizationColorModel .DEFAULTCOLORMODEL | Default Color Model
RasterizationColorModel.GRAYSCALE Grayscale

42.98 RasterLinkState

The status of a raster item’s linked image if the image is stored externally

Value Description
RasterLinkState.DATAFROMFILE | Data From File
RasterLinkState.DATAMODIFIED | Data Modified
RasterLinkState.NODATA No Data
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42.99 RulerUnits

The default measurement units for the rulers of a document

Value Description
RulerUnits.Centimeters | Centimeters
RulerUnits.Qs Qs
RulerUnits.Inches Inches
RulerUnits.Pixels Pixels
RulerUnits.Millimeters | Millimeters
RulerUnits.Unknown Unknown
RulerUnits.Picas Picas
RulerUnits.Points Points
42.100 SaveOptions
Save options provided when closing a document.
Value Description
SaveOptions.DONOTSAVECHANGES Do Not Save Changes
SaveOptions.SAVECHANGES Save Changes
SaveOptions.PROMPTTOSAVECHANGES | Prompt To Save Changes

42.101 ScreenMode

The mode of display for a view.

Value Description
ScreenMode .DESKTOP Desktop
ScreenMode.MULTIWINDOW | Multi Window
ScreenlMode . FULLSCREEN Fullscreen
42.102 SpotColorKind
The custom color kind of a spot color.
Value Description
SpotColorKind.SpotCMYK | CMYK
SpotColorKind.SpotLAB LAB
SpotColorKind. SpotRGB RGB
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42.103 StrokeCap

The type of line capping for a path stroke.

Value Description
StrokeCap.BUTTENDCAP Butt
StrokeCap.ROUNDENDCAP Round
StrokeCap.PROJECTINGENDCAP | Projecting
42.104 Strokedoin
The type of joints for a path stroke.
Value Description
StrokeJoin.BEVELENDJOIN | Bevel
StrokeJoin.ROUNDENDJOIN | Round
StrokeJoin.MITERENDJOIN | Miter
42.105 StyleRunAlignmentType
Value Description
StyleRunAlignmentType.bottom Bottom
StyleRunAlignmentType.icfTop ICF Top
StyleRunAlignmentType.center Center
StyleRunAlignmentType.ROMANBASELINE | Roman Baseline
StyleRunAlignmentType.icfBottom ICF Bottom
StyleRunAlignmentType.top Top

42.106 SVGCSSPropertyLocation

How should the CSS properties of the document be included in an exported SVG file

Value Description
SVGCSSPropertyLocation.ENTITIES Entities
SVGCSSPropertyLocation.STYLEATTRIBUTES Style Attributes
SVGCSSPropertyLocation.PRESENTATIONATTRIBUTES | Presentation Attributes
SVGCSSPropertyLocation.STYLEELEMENTS Style Elements

42.103. StrokeCap
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42.107 SVGDocumentEncoding

How should the text in the document be encoded when exporting an SVG file

Value Description
SVGDocumentEncoding.ASCII | ASCII
SVGDocumentEncoding.UTF8 UTF8
SVGDocumentEncoding.UTF16 | UTF16
42.108 SVGDTDVersion
SVG version compatibility for exported files
Value Description
SVGDTDVersion.SVG1_0 SVG1_0
SVGDTDVersion.SVG1_1 SVG1_1
SVGDTDVersion.SVGBASICI1_1 SVGBASICI1_1
SVGDTDVersion.SVGTINY1_1 SVGTINY1_1
SVGDTDVersion.SVGTINY1_1PLUS | SVGTINY1_1PLUS
SVGDTDVersion.SVGTINY1_2 SVGTINY1_ 2
42.109 SVGFontSubsetting
What font glyphs should be included in exported SVG files
Value Description
SVGFontSubsetting.ALLGLYPHS All Glyphs
SVGFontSubsetting.GLYPHSUSEDPLUSENGLISH | Glyphs Used Plus English
SVGFontSubsetting.COMMONENGLISH Common English
SVGFontSubsetting.GLYPHSUSEDPLUSROMAN Glyphs Used Plus Roman
SVGFontSubsetting . COMMONROMAN Common Roman
SVGFontSubsetting.GLYPHSUSED Glyphs Used
SVGFontSubsetting.None None
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42.110 SVGFontType

Types for fonts included in exported SVG files

Value

Description

SVGFontType.CEFFONT

CEF Font

SVGFontType.SVGFONT

SVG Font

SVGFontType .OUTLINEFONT

Outline Font

42.111 SymbolRegistrationPoint

Registration points for symbols.

The alignment of a tab stop.

Value Description
SymbolRegistrationPoint.SYMBOLBOTTOMLEFTPOINT Bottom Left Point
SymbolRegistrationPoint.SYMBOLBOTTOMMIDDLEPOINT | Bottom Middle Point
SymbolRegistrationPoint.SYMBOLBOTTOMRIGHTPOINT Bottom Right Point
SymbolRegistrationPoint.SYMBOLCENTERPOINT Center Point
SymbolRegistrationPoint.SYMBOLMIDDLELEFTPOINT Middle Left Point
SymbolRegistrationPoint.SYMBOLMIDDLERIGHTPOINT Middle Right Point
SymbolRegistrationPoint.SYMBOLTOPLEFTPOINT Top Left Point
SymbolRegistrationPoint.SYMBOLTOPMIDDLEPOINT Top Middle Point
SymbolRegistrationPoint.SYMBOLTOPRIGHTPOINT Top Right Point
42.112 TabStopAlignment
Value Description
TabStopAlignment.Center Center
TabStopAlignment.Decimal | Decimal
TabStopAlignment.Left Left
TabStopAlignment.Right Right

42.110. SVGFontType
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42.113 TextAntialias

The type of text anti-aliasing in a text art item.

Value Description
TextAntialias.CRISP Crisp
TextAntialias.NONE None

TextAntialias.SHARP Sharp
TextAntialias.STRONG | Strong

42.114 TextOrientation

The orientation of text in a text art item.

Value Description
TextOrientation.HORIZONTAL | Horizontal
TextOrientation.VERTICAL Vertical

42.115 TextPreservePolicy

The text-preserve policy used by the FXG file format.

Value Description
TextPreservePolicy.AUTOMATICALLYCONVERTTEXT | Automatically Convert Text
TextPreservePolicy.OUTLINETEXT Outline Text
TextPreservePolicy.KEEPTEXTEDITABLE Keep Text Editable
TextPreservePolicy.RASTERIZETEXT Rasterize Text

42.116 TexiType

The type of text art displayed by this object.

Value Description
TextType.AREATEXT Area Text
TextType.POINTTEXT | Point Text
TextType.PATHTEXT Path Text
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42.117 TIFFByteOrder

The byte order to use for an exported TIFF file.

Value Description
TIFFByteOrder.IBMPC IBM PC
TIFFByteOrder.MACINTOSH | Macintosh
42.118 TracingModeType
Value Description
TracingModeType . TRACINGMODEBLACKANDWHITE | Black & White
TracingModeType . TRACINGMODECOLOR Color
TracingModeType . TRACINGMODEGRAY Gray

42.119 Transformation

The point to use as the anchor point about which an object is rotated, resized, or transformed.

Value Description
Transformation.BOTTOM Bottom
Transformation.BOTTOMLEFT Bottom Left
Transformation.BOTTOMRIGHT Bottom Right
Transformation.CENTER Center
Transformation.DOCUMENTORIGIN | Document Origin
Transformation.LEFT Left
Transformation.RIGHT Right
Transformation.TOP Top
Transformation.TOPLEFT Top Left
Transformation.TOPRIGHT Top Right
42.120 TrappingType
Value Description
TrappingType . IGNOREOPAQUE todo
TrappingType.OPAQUE todo
TrappingType.NORMALTRAPPING | todo
TrappingType.TRANSPARENT todo

42.117. TIFFByteOrder
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42.121 UserinteractionlLevel

User interface settings

Value Description
UserInteractionlLevel .DISPLAYALERTS Display Alerts
UserInteractionLevel .DONTDISPLAYALERTS | Don’t Display Alerts

42.122 VariableKind

What type of variables are included in the document.

Value Description
VariableKind.GRAPH Graph
VariableKind.IMAGE Image
VariableKind.VISIBILITY | Visibility
VariableKind.TEXTUAL Textual
VariableKind.Unknown Unknown

42.123 ViewRasterType

The raster visualization mode for tracing.

Value Description
ViewRasterType.TRACINGVIEWRASTERADJUSTEDIMAGE Adjusted Image
ViewRasterType.TRACINGVIEWRASTERNOIMAGE No Image
ViewRasterType.TRACINGVIEWRASTERORIGINALIMAGE Original Image
ViewRasterType.TRACINGVIEWRASTERTRANSPARENTIMAGE | Transparent Image

42.124 ViewVectorType

The vector visualization mode for tracing.

Value Description
ViewVectorType.TRACINGVIEWVECTORNOTRACINGRESULT No Tracing Result
ViewVectorType.TRACINGVIEWVECTOROUTLINES Outlines
ViewVectorType.TRACINGVIEWVECTOROUTLINESWITHTRACING | Outlines With Tracing
ViewVectorType.TRACINGVIEWVECTORTRACINGRESULT Tracing Result
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42.125 WariChudustificationType

Value Description
WariChuJustificationType.Center Center
WariChuJustificationType.Left Left
WariChuJustificationType.Right Right
WariChuJustificationType.WARICHUAUTOJUSTIFY Warichu Auto Justify
WariChuJustificationType.WARICHUFULLJUSTIFY Warichu Full Justify
WariChuJustificationType.WARICHUFULLJUSTIFYLASTLINECENTER | Warichu Full Justify Last Line Center
WariChuJustificationType.WARICHUFULLJUSTIFYLASTLINELEFT Warichu Full Justify Last Line Left
WariChuJustificationType.WARICHUFULLJUSTIFYLASTLINERIGHT | Warichu Full Justify Last Line Right

42.126 ZOrderMeth

od

The method used to arrange an art item’s position in the stacking order of its parent group or layer, as specified with

the zOrder method

Value

Description

ZOrderMethod .BRINGFORWARD

Bring Forward

ZOrderMethod . SENDBACKWARD

Send Backward

ZOrderMethod.BRINGTOFRONT

Bring To Front

ZOrderMethod . SENDTOBACK

Send To Back

42.125. WariChudJustificationType
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CHAPTER
FORTYTHREE

JAVASCRIPT OBJECT REFERENCE

This section presents all of the object classes in the type library.
Each class listing includes the following:
* Properties of the class, including value type, read-only status, and an explanation.

* Methods for the class. Constants and value types needed by the method are shown in bold face. Required terms
are shown in plain face. All items surrounded by brackets [ ] are optional.

* Notes to explain special issues.
» Sample code to help illustrate the syntax and typical workflow usage of the object class.

These examples are intended to be clear demonstrations of syntax, and do not show the best or most efficient way to
construct a JavaScript script.

Error checking, for instance, is generally brief or missing.

However, the examples can be combined and expanded to make scripts with greater functionality.
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CHAPTER
FORTYFOUR

app

Description

APPLICATION

The Adobe® Illustrator® application object, referenced using the pre-defined global app object, which contains all

other Illustrator objects.

44.1 Properties

44.1.1 Application.activeDocument

app.activeDocument

Description

The active (frontmost) document in Illustrator.
Type

Document

44.1.2 Application.browserAvailable

app.browserAvailable
Description
If true, a web browser is available.

Type

Boolean; read-only.
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44.1.3 Application.buildNumber

app . buildNumber
Description

The application’s build number.
Type

String; read-only.

44.1.4 Application.colorSettingsList

app.colorSettingsList
Description
The list of color-settings files currently available for use.

Type
Object; read-only.

44.1.5 Application.coordinateSystem

app.coordinateSystem

Description

The coordinate system currently in use, document or artboard.
Type

CoordinateSystem

44.1.6 Application.defaultColorSettings

app.defaultColorSettings

Description

The default color-settings file for the current application locale.
Type

File; read-only.
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44.1.7 Application.documents

app.documents

Description

The documents in the application.
Type

Documents

44.1.8 Application.flattenerPresetList

app.flattenerPresetlList
Description
The list of flattener style names currently available for use.

Type
Object; read-only.

44.1.9 Application.freeMemory

app . freeMemory

Description

The amount of unused memory (in bytes) within the Illustrator partition.

Type
Number (long); read-only.

44.1.10 Application.locale

app.locale
Description
The application’s locale.

Type
String; read-only.

44.1. Properties
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44.1.11 Application.name

app.name

Description

The application’s name (not related to the filename of the application file).

Type
String; read-only.

44.1.12 Application.pasteRememberLayers

app.pasteRememberLayers
Description
If true, the paste operation maintains the layer structure.

Type

Boolean; read-only.

44.1.13 Application.path

app.path

Description

The file path to the application.
Type

File; read-only.

44.1.14 Application.PDFPresetsList

app.PDFPresetsList
Description
The list of preset PDF-options names available for use.

Type
Object; read-only.
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44.1.15 Application.PPDFileList

app.PPDFilelist

Description

The list of PPD files currently available for use.
Type

Object; read-only.

44.1.16 Application.preferences

app.preferences
Description
Ilustrator’s preference settings.

Type

Preferences

44.1.17 Application.printerList

app.printerList
Description
The list of installed printers.

Type

Array of Printer

44.1.18 Application.printPresetsList

app.printPresetsList

Description

The list of preset printing-options names available for use.

Type
Object; read-only.

44.1. Properties
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44.1.19 Application.scriptingVersion

app.scriptingVersion
Description

The version of the Scripting plug-in.
Type

String; read-only.

44.1.20 Application.selection

app.selection

Description

All currently selected objects in the active (frontmost) document.

Type
Array of Objects; read-only.

44.1.21 Application.startupPresetsList

app.startupPresetsList

Description

The list of presets available for creating a new document.
Type

Object; read-only.

44.1.22 Application.textFonts

app.textFonts
Description

The installed fonts.
Type

TextFonts
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44.1.23 Application.tracingPresetList

app.tracingPresetlist

Description

The list of preset tracing-options names available for use.
Type

Array of Strings; read-only.

44.1.24 Application.typename

app . typename
Description
The class name of the referenced object.

Type

String; read-only.

44.1.25 Application.userinteractionLevel

app.userInteractionLevel

Description

What level of interaction with the user should be allowed when handling script commands.

Type

UserlnteractionLevel

44.1.26 Application.version

app.version
Description
The application’s version.

Type
String; read-only.

44.1. Properties
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44.1.27 Application.visible

app.visible

Description

If true, the application is visible.
Type

Boolean; read-only.

44.2 Methods

44.2.1 Application.beep()

app.beep()
Description
Alerts the user.
Returns

Nothing.

44.2.2 Application.concatenateMatrix()

app.concatenateMatrix(matrix, secondMatrix)
Description

Joins two matrices together.

Parameters
Parameter Type Description
matrix Matrix | First matrix
secondMatrix | Matrix | Second matrix
Returns
jsobjref/Matrix.
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44.2.3 Application.concatenateRotationMatrix()

app.concatenateRotationMatrix(matrix, angle)
Description

Joins a rotation translation to a transformation matrix.

Parameters
Parameter | Type Description
matrix Matrix Matrix
angle Number (double) | Angle

Returns

jsobjref/Matrix.

44.2.4 Application.concatenateScaleMatrix()

app.concatenateScaleMatrix(matrix[, scaleX][, scaleY])
Description

Concatenates a scale translation to a transformation matrix.

Parameters
Parameter | Type Description
matrix Matrix Matrix
scaleX Number (double), optional | X Scale
scaleY Number (dobule), optional | Y Scale

Returns

Matrix

44.2.5 Application.concatenateTranslationMatrix()

app.concatenateTranslationMatrix(matrix[, deltaX][, deltaY])
Description

Joins a translation to a transformation matrix.

Parameters
Parameter | Type Description
matrix Matrix Matrix
deltaX Number (double), optional | X Delta
deltaY Number (dobule), optional | Y Delta
Returns

44.2. Methods
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Matrix

44.2.6 Application.convertSampleColor()
app.convertSampleColor(sourceColorSpace, sourceColor, destColorSpace,
colorConvertPurpose[, sourceHasAlpha][, destHasAlpha])

Description

Converts a sample-component color from one color space to another.

Parameters
Parameter Type Description
sourceColorSpace ImageColorSpace Color space of source color
sourceColor ColorComponents Source color to convert
destColorSpace ImageColorSpace Destination color space
colorConvertPurpose | ColorConvertPurpose | The purpose of the convert
sourceHasAlpha Boolean, optional Whether the source has alpha
destHasAlpha Boolean, optional Whether the destination has alpha
Returns

Array of ColorComponents

44.2.7 Application.copy()

app.copy Q)

Description

Copies current selection to the clipboard.
Returns

Nothing.

44.2.8 Application.cut()

app.cut()

Description

Cuts current selection to the clipboard.
Returns

Nothing.
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44.2.9 Application.deleteWorkspace()

app.deletellorkspace (workspaceName)
Description

Deletes an existing workspace.

Parameters
Parameter Type | Description
workspaceName | String | Name of workspace to delete
Returns
Boolean

44.2.10 Application.getldentityMatrix()

app.getIdentityMatrix()
Description

Returns an identity matrix.
Returns

Matrix

44.2.11 Application.getlsFileOpen()

app.getIsFileOpen(filePath)

Note: This functionality was added in Illustrator XX.X (CC2017)

Description

Returns whether the specified filePath is open

Parameters
Parameter | Type | Description
filePath | String | File path to check
Returns
Boolean

44.2. Methods
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44.2.12 Application.getPPDFilelnfo()

app.getPPDFileInfo(name)

Description

Gets detailed file information for specified PPD file.

Parameters

Returns

PPDFilelnfo

Parameter

Type

Description

name

String | File name to get info for

44.2.13 Application.getPresetFileOfType()

app.getPresetFileOfType(presetType)

Description

Returns the full path to the application’s default document profile for the specified preset type.

Parameters

Returns

File

Parameter

Type

Description

presetType

DocumentPresetType

Preset type to get file of

44.2.14 Application.getPresetSettings()

app.getPresetSettings(preset)

Description

Retrieves the tracing-option settings from the template with a given preset name.

Parameters
Parameter | Type | Description
preset String | Preset name to get settings from
Returns
DocumentPreset
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44.2.15 Application.getRotationMatrix()

app.getRotationMatrix([angle])

Description

Returns a transformation matrix containing a single rotation.

Note: Requires a value in degrees.

For example, 30 rotates the object 30 degrees counterclockwise; -30 rotates the object 30 degrees clockwise.

Type

Description

Number (double), optional

Angle to get matrix of

Parameters
Parameter
angle
Returns
Matrix

44.2.16 Application.getScaleMatrix()

app.getScaleMatrix([scaleX][,

Description

scaleY])

Returns a transformation matrix containing a single scale.

Note: Requires a value in percentage.

For example, 60 scales the object to 60% of its original size; 200 doubles the object’s bounds.

Type

Description

Number (double), optional

X scale to get matrix of

Number (double), optional

Y scale to get matrix of

Parameters
Parameter
scaleX
scaleY

Returns

Matrix

44.2. Methods
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44.2.17 Application.getScriptableHelpGroup()

app.getScriptableHelpGroup ()

Description

Gets the scriptable help group object that represents the search widget in the app bar.
Returns

Variant

44.2.18 Application.getTranslationMatrix()

app.getTranslationMatrix([deltaX] [, deltaY])
Description

Returns a transformation matrix containing a single translation.

Note: Requires a value in points.

For example, (100, 200) moves the object 100 pt. to the right and 200 pt. up; a minus before each number moves the
object left and down.

Parameters
Parameter | Type Description
deltaX Number (double), optional | X Delta
deltaY Number (dobule), optional | Y Delta

Returns

Matrix

44.2.19 Application.invertMatrix()

app.invertMatrix(matrix)
Description

Inverts a matrix.

Parameters
Parameter | Type Description
matrix Matrix | Matrix to invert
Returns
Matrix
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44.2.20 Application.isEqualMatrix()

app.isEqualMatrix(matrix, secondMatrix)
Description

Checks whether the two matrices are equal.

Parameters
Parameter Type Description
matrix Matrix | First matrix to check
secondMatrix | Matrix | Second matrix to check
Returns
Boolean

44.2.21 Application.isSingularMatrix()

app.isSingularMatrix(matrix)
Description

Checks whether a matrix is singular and cannot be inverted.

Parameters
Parameter | Type Description
matrix Matrix | Matrix to check
Returns
Boolean

44.2.22 Application.loadColorSettings()

app.loadColorSettings(fileSpec)
Description

Loads color settings from specified file, or, if file is empty, turns color management off.

Parameters
Parameter | Type | Description
fileSpec | File File to load settings from
Returns
Nothing.
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44.2.23 Application.open()

app.open(file[, documentColorSpace][, options])
Description

Opens the specified document file.

Note: If you open a pre-Illustrator 9 document that contains both RGB and CM YK colors and documentColorSpace
is supplied, all colors are converted to the specified color space.

If the parameter is not supplied, Illustrator opens a dialog so the user can choose the color space.

Parameters
Parameter Type Description
file File File to open
documentColorSpace | DocumentColorSpace, optional | Color space of document
options anything todo

Returns

Document

44.2.24 Application.paste()

app.paste()

Description

Pastes current clipboard content into the current document.
Returns

Nothing.

44.2.25 Application.quit()

app.quit()
Description

Quits Illustrator.

Note: If the clipboard contains data, Illustrator may show a dialog prompting the user to save the data for other
applications.

Returns

Nothing.
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44.2.26 Application.redo()

app.redo()

Description

Redoes the most recently undone transaction.
Returns

Nothing.

44.2.27 Application.redraw()

app.redraw()

Description

Forces Illustrator to redraw all its windows.
Returns

Nothing.

44.2.28 Application.resetWorkspace()

app.resetWorkspace()
Description

Resets the current workspace.
Returns

Boolean

44.2.29 Application.saveWorkspace()

app . saveWorkspace (workspaceName)
Description

Saves a new workspace.

Parameters
Parameter Type | Description
workspaceName | String | Name of workspace to save as
Returns
Boolean

44.2. Methods
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44.2.30 Application.sendScriptMessage()

app.sendScriptMessage(pluginName, messageSelector, inputString)

Description

Sends a plug-in-defined command message to a plug-in with given input arguments, and returns the plug-in-defined

result string.

Parameters
Parameter Type | Description
pluginName String | Name of plugin to send message to
messageSelector | String | Message to send to the plugin
inputString String | Data to pass into the command
Returns
String

44.2.31 Application.showPresets()

app . showPresets(fileSpec)
Description

Gets presets from the file.

Parameters
Parameter | Type | Description
fileSpec | File File to get presets from
Returns
PrintPresetList

44.2.32 Application.switchWorkspace()

app. switchWWorkspace (workspaceName)
Description

Switches to the specified workspace.

Parameters
Parameter Type | Description
workspaceName | String | Name to switch to
Returns
Boolean
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44.2.33 Application.translatePlaceholderText()

app.translatePlaceholderText(text)
Description

Translates the placeholder text to regular text (a way to enter Unicode points in hex values).

Parameters
Parameter | Type | Description
text String | String to translate
Returns
String

44.2.34 Application.undo()

app.undo()

Description

Undoes the most recent transaction.
Returns

Nothing.

44.3 Example

44.3.1 Duplicating the Active Document

// Duplicates any selected items from
// the active document into a new document.

var newltem;
var docSelected = app.activeDocument.selection;

if (docSelected.length > 0) {
// Create a new document and move the selected items to it.
var newDoc = app.documents.add();
if (docSelected.length > 0) {
for (var i = 0; i < docSelected.length; i++) {
docSelected[i] .selected = false;
newItem = docSelected[i].duplicate(newDoc, ElementPlacement.PLACEATEND);
}
} else {
docSelected.selected = false;
newItem = docSelected.parent.duplicate(newDoc, ElementPlacement.PLACEATEND);

(continues on next page)
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(continued from previous page)

}
} else {
alert("Please select one or more art objects");

}
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CHAPTER
FORTYFIVE

artboard

Description

ARTBOARD

An Artboard object represents a single artboard in a document. There can be between 1 to 100 artboards in one

document.

45.1 Properties

45.1.1 Artboard.artboardRect

artboard.artboardRect
Description
Size and position of the artboard.

Type
Rect

45.1.2 Artboard.name

artboard.name

Description

The unique identifying name of the artboard.

Type
String
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45.1.3 Artboard.parent

artboard.parent
Description

The parent of this object.
Type

Document; read-only.

45.1.4 Artboard.rulerOrigin

artboard.rulerOrigin
Description
Ruler origin of the artboard, relative to the top left corner of the artboard.

Type

Point

45.1.5 Artboard.rulerPAR

artboard.rulerPAR

Description

Pixel aspect ratio, used in ruler visualization if the units are pixels.
Range: 0.1 to 10.

Type
Number (double)

45.1.6 Artboard.showCenter

artboard. showCenter
Description
Show center mark.

Type

Boolean
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45.1.7 Artboard.showCrossHairs

artboard. showCrossHairs
Description

Show cross hairs.

Type

Boolean

45.1.8 Artboard.showSafeAreas

artboard.showSafeAreas
Description
Show title and action safe areas (for video).

Type

Boolean

45.1.9 Artboard.typename

artboard. typename

Description

Read-only. The class name of this object.
Type

String

45.2 Methods

45.2.1 Artboard.remove()

artboard.remove()

Description

Deletes this artboard object. You cannot remove the last artboard in a document.
Returns

Nothing.
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FORTYSIX

artboards
Description

A collection of Artboard objects.

46.1 Properties

46.1.1 Artboards.length

artboards.length
Description
The number of datasets in the collection

Type

Number; read-only.

ARTBOARDS

46.1.2 Artboards.parent

artboards.parent

Description

The name of the object that contains this dataset
Type

Artboard; read-only.
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46.1.3 Artboards.typename

artboards. typename

Description

The class name of the referenced object.
Type

String; read-only.

46.2 Methods

46.2.1 Artboards.add()

artboards.add(artboardRect)
Description

Creates a new Artboard object.

Description

Artboard dimensions

Parameters
Parameter Type
artboardRect | Rect
Returns
Artboard

46.2.2 Artboards.getActiveArtboardindex()

artboards.getActiveArtboardIndex ()

Description

Retrieves the index position of the active artboard in the document’s list.

Returns the 0-based index.
Returns

Number (long)
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46.2.3 Artboards.getByName()

artboards.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Returns

Artboard

Parameter | Type | Description

name

String | Name of element to get

46.2.4 Artboards.insert()

artboards.insert(artboardRect, index)

Description

Creates a new Artboard object and inserts it at the given index in the list.

Parameters

Returns

Nothing.

Parameter Type Description
artboardRect | Rect Artboard dimensions
index Number (long) | Index to insert artboard at

46.2.5 Artboards.remove()

artboards.remove (index)

Description

Deletes an artboard object. You cannot remove the last artboard in a document.

Parameters

Returns

Nothing.

Parameter

Type

Description

index

Number (long)

Index of artboard to remove

46.2. Methods
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46.2.6 Artboards.setActiveArtboardindex()

artboards.setActiveArtboardIndex (index)

Description

Makes a specific artboard active and makes it current in the iteration order.

Parameters
Parameter | Type Description
index Number (long) | Index of artboard to set active
Returns
Nothing.
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FORTYSEVEN

BRUSH

app.activeDocument.brushes[index
Description

A brush in an Illustrator document. Brushes are contained in documents. Additional brushes may be created by the
user within Illustrator. You can access brushes within a script, but you cannot create them.

47.1 Properties

47.1.1 Brush.name

app.activeDocument.brushes[index] .name
Description

The name of the brush

Type

String

47.1.2 Brush.parent

app.activeDocument.brushes[index] .parent
Description
The document that contains this brush.

Type

Document; read-only.
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47.1.3 Brush.typename

app.activeDocument .brushes[index] . typename
Description
The class name of the referenced object.

Type

String; read-only.

47.2 Methods

47.2.1 Brush.applyTo()

app.activeDocument.brushes[index] .applyTo(artItem)
Description

Applies the brush to a specific art item.

Parameters

Parameter | Type Description

artItem Pageltem | Artitem to apply brush to
Returns
Nothing.

47.3 Example

47.3.1 Applying a Brush

// Duplicates and groups all items in the current selection,
// then applies the same brush to each item in the group

if (app.documents.length > 0) {
var docSelection = app.activeDocument.selection;
if (docSelection.length > 0) {
var newGroup = app.activeDocument.groupItems.add();

for (var i = 0; i < docSelection.length; i++) {
var newlItem = docSelection[i].duplicate();
newItem.moveToBeginning (newGroup) ;

}

var brush = app.activeDocument.brushes[1];

(continues on next page)
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(continued from previous page)

}
}

brush. applyTo(newGroup) ;

47.3. Example
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FORTYEIGHT

app.activeDocument.brushes

Description

A collection of brush objects in a document.

BRUSHES

48.1 Properties

48.1.1 Brushes.length

app.activeDocument.brushes.length
Description
The number of objects in the collection

Type

Number; read-only.

48.1.2 Brushes.parent

app.activeDocument.brushes.parent

Description

The document that contains this brushes collection.

Type
Object; read-only.
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48.1.3 Brushes.typename

app.activeDocument.brushes. typename
Description

The class name of the referenced object.
Type

String; read-only.

48.2 Methods

48.2.1 Brushes.getByName()

app.activeDocument.brushes.getByName (name)
Description

Gets the first element in the collection with the specified name.

Parameters

Parameter | Type | Description

name String | Name of element to get
Returns
Brush

48.2.2 Brushes.index()

app.activeDocument.brushes.index (itemKey)
Description

Gets an element from the collection.

Parameters
Parameter | Type Description
itemKey String, Number | String or number key
Returns
Brush

176 Chapter 48. Brushes



lllustrator Scripting Guide, Release 0.0.1

48.3 Example

48.3.1 Counting brushes

// Counts all brushes in the active document

if (app.documents.length > 0) {
var numberOfBrushes = app.activeDocument.brushes.length;

}
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CHAPTER
FORTYNINE

CHARACTERATTRIBUTES

characterAttributes
Description

Specifies the properties of a character contained in a text frame. A CharacterStyle object associates these attributes
with a specific text range through its characterAttributes property.

Note: Character attributes do not have default values, and are undefined until explicitly set.

/' todo: get the absolute path to characterAttributes.. document . textFrames.textRef. textRange.
characters[index].characterAttributes ?

49.1 Properties

49.1.1 CharacterAttributes.akilLeft

characterAttributes.akileft
Description

The amount of inter-character spacing to be added to the left side of the character, in thousandths of an em (that amount
will not compress or expand during full-justification).

Type
Number (double)

49.1.2 CharacterAttributes.akiRight

characterAttributes.akiRight
Description

The amount of inter-character spacing to be added to the right side of the character, in thousandths of an em (that
amount will not compress or expand during full-justification).

Type
Number (double)
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49.1.3 CharacterAttributes.alignment

characterAttributes.alignment
Description
The character alignment type.

Type
StyleRunAlignmentType

49.1.4 CharacterAttributes.alternateGlyphs

characterAttributes.alternateGlyphs
Description

The alternate glyphs form.

Type

AlternateGlyphsForm

49.1.5 CharacterAttributes.autolLeading

characterAttributes.autolLeading
Description

If true, the automatic leading should be used.
Type

Boolean

49.1.6 CharacterAttributes.baselineDirection

characterAttributes.baselineDirection
Description
The Japanese text baseline direction.

Type

BaselineDirectionType
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49.1.7 CharacterAttributes.baselinePosition

characterAttributes.baselinePosition
Description
The baseline position of text.

Type

FontBaselineOption

49.1.8 CharacterAttributes.baselineShift

characterAttributes.baselineShift
Description

The amount of shift in points of the text baseline.
Type

Number (double)

49.1.9 CharacterAttributes.capitalization

characterAttributes.capitalization
Description

The case of text.

Type

FontCapsOption

49.1.10 CharacterAttributes.connectionForms

characterAttributes.connectionForms
Description
If true, the OpenType® connection forms should be used.

Type

Boolean

49.1. Properties
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49.1.11 CharacterAttributes.contextualLigature

characterAttributes.contextuallLigature
Description
If true, the contextual ligature should be used.

Type

Boolean

49.1.12 CharacterAttributes.discretionaryLigature

characterAttributes.discretionarylLigature
Description
If true, the discretionary ligature should be used.

Type

Boolean

49.1.13 CharacterAttributes.figureStyle

characterAttributes. figureStyle
Description

The number style in a OpenType font.
Type

FigureStyleType

49.1.14 CharacterAttributes.fillColor

characterAttributes.fillColor
Description

The color of the text fill.

Type

Color
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49.1.15 CharacterAttributes.fractions

characterAttributes. fractions
Description

If true, the OpenType fractions should be used.
Type

Boolean

49.1.16 CharacterAttributes.horizontalScale

characterAttributes.horizontalScale

Description

The character horizontal scaling factor expressed as a percentage (100 = 100%).

Type
Number (double)

49.1.17 CharacterAttributes.italics

characterAttributes.italics
Description
If true, the Japanese OpenType font supports italics.

Type

Boolean

49.1.18 CharacterAttributes.kerningMethod

characterAttributes.kerningMethod
Description
The automatic kerning method to use.

Type
AutoKernType

49.1. Properties
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49.1.19 CharacterAttributes.language

characterAttributes.language
Description

The language of text.

Type

LanguageType

49.1.20 CharacterAttributes.leading

characterAttributes.leading

Description

The amount of space between two lines of text, in points.

Type
Number (double)

49.1.21 CharacterAttributes.ligature

characterAttributes.ligature
Description

If true, the ligature should be used.
Type

Boolean

49.1.22 CharacterAttributes.noBreak

characterAttributes.noBreak
Description

If true, line breaks are not allowed.
Type

Boolean
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49.1.23 CharacterAttributes.openTypePosition

characterAttributes.openTypePosition
Description
The OpenType baseline position.

Type
FontOpenTypePositionOption

49.1.24 CharacterAttributes.ordinals

characterAttributes.ordinals
Description

If true, the OpenType ordinals should be used.
Type

Boolean

49.1.25 CharacterAttributes.ornaments

characterAttributes.ornaments
Description
If true, the OpenType ornaments should be used.

Type

Boolean

49.1.26 CharacterAttributes.overprintFill

characterAttributes.overprintFill
Description

If true, the fill of the text should be overprinted.
Type

Boolean

49.1. Properties
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49.1.27 CharacterAttributes.overprintStroke

characterAttributes.overprintStroke
Description

If true, the stroke of the text should be overprinted.
Type

Boolean

49.1.28 CharacterAttributes.parent

characterAttributes.parent
Description
The object’s container.

Type
Object, read-only.

49.1.29 CharacterAttributes.proportionalMetrics

characterAttributes.proportionalMetrics

Description

If true, the Japanese OpenType font supports proportional glyphs.

Type

Boolean

49.1.30 CharacterAttributes.rotation

characterAttributes.rotation
Description
The character rotation angle in degrees.

Type
Number (double)
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49.1.31 CharacterAttributes.size

characterAttributes.size
Description

Font size in points.

Type

Number (double)

49.1.32 CharacterAttributes.strikeThrough

characterAttributes.strikeThrough
Description

If true, characters use strike-through style.
Type

Boolean

49.1.33 CharacterAttributes.strokeColor

characterAttributes.strokeColor
Description
The color of the text stroke.

Type

Color

49.1.34 CharacterAttributes.strokeWeight

characterAttributes.strokeWeight
Description
Line width of stroke.

Type
Number (double)

49.1. Properties
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49.1.35 CharacterAttributes.stylisticAlternates

characterAttributes.stylisticAlternates
Description

If true, the OpenType stylistic alternates should be used.
Type

Boolean

49.1.36 CharacterAttributes.swash

characterAttributes. swash
Description

If true, the OpenType swash should be used.
Type

Boolean

49.1.37 CharacterAttributes.tateChuYokoHorizontal

characterAttributes.tateChuYokoHorizontal
Description

The Tate-Chu-Yoko horizontal adjustment in points.
Type

Number (long)

49.1.38 CharacterAttributes.tateChuYokoVertical

characterAttributes.tateChuYokoVertical
Description
The Tate-Chu-Yoko vertical adjustment in points.

Type
Number (long)
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49.1.39 CharacterAttributes.textFont

characterAttributes.textFont
Description

The text font.

Type

TextFont

49.1.40 CharacterAttributes.titling

characterAttributes.titling
Description
If true, the OpenType titling alternates should be used.

Type

Boolean

49.1.41 CharacterAttributes.tracking

characterAttributes.tracking

Description

The tracking or range kerning amount, in thousandths of an em.

Type
Number (long)

49.1.42 CharacterAttributes.Tsume

characterAttributes.Tsume
Description
The percentage of space reduction around a Japanese character.

Type
Number (double)

49.1. Properties
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49.1.43 CharacterAttributes.typename

characterAttributes. typename
Description

The class name of the object.

Type

String, read-only.

49.1.44 CharacterAttributes.underline

characterAttributes.underline
Description
If true, characters are underlined.

Type

Boolean

49.1.45 CharacterAttributes.verticalScale

characterAttributes.verticalScale

Description

Character vertical scaling factor expressed as a percentage (= 100%).

Type
Number (double)

49.1.46 CharacterAttributes.wariChuCharactersAfterBreak

characterAttributes.wariChuCharactersAfterBreak

Description

Specifies how the characters in Wari-Chu text (an inset note in Japanese text) are divided into two or more lines.

Type
Number (long)
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49.1.47 CharacterAttributes.wariChuCharactersBeforeBreak

characterAttributes.wariChuCharactersBeforeBreak
Description
Specifies how the characters in Wari-Chu text (an inset note in Japanese text) are divided into two or more lines.

Type
Number (long)

49.1.48 CharacterAttributes.waiChuEnabled

characterAttributes.waiChuEnabled
Description
If true, Wari-Chu is enabled.

Type

Boolean

49.1.49 CharacterAttributes.wariChudJustification

characterAttributes.wariChuJustification
Description

The Wari-Chu justification.

Type

WariChuJustificationType

49.1.50 CharacterAttributes.wariChuLineGap

characterAttributes.wariChuLineGap
Description

The Wari-Chu line gap.

Type

Number (long)
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49.1.51 CharacterAttributes.wariChuLines

characterAttributes.wariChulLines
Description
The number of Wari-Chu (multiple text lines fit into a space meant for one) lines.

Type
Number (long)

49.1.52 CharacterAttributes.wariChuScale

characterAttributes.wariChuScale
Description
The Wari-Chu scale.

Type
Number (double)

49.2 Example

49.2.1 Setting character attributes

// Creates a new document, adds a simple text item
// then incrementally increases the horizontal and
// vertical scale attributes of each character

var docRef = documents.add();

var textRef = docRef.textFrames.add();
textRef.contents = "I Love Scripting!";
textRef.top = 400;

textRef.left = 100;

// incrementally increase the scale of each character

var charCount = textRef.textRange.characters.length;

var size = 100;

for (var i = 0; i < charCount; i++, size *= 1.2) {
textRef.textRange.characters[i].characterAttributes.horizontalScale = size;
textRef.textRange.characters[i].characterAttributes.verticalScale = size;

}
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CHAPTER
FIFTY

CHARACTERS

app.activeDocument.textFrames[index].contents
Description
A collection of characters (TextRange objects of length 1).

The elements are not named; you must access them by index.

50.1 Properties

50.1.1 Characters.length

app.activeDocument.textFrames[index].contents.length
Description

The number of characters in the collection.

Type

Number; read-only.

50.1.2 Characters.parent

app.activeDocument.textFrames[index].contents.parent
Description
The text art item that contains this character.

Type
Object; read-only.
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50.1.3 Characters.typename

app.activeDocument.textFrames[index].contents. typename

Description

The class name of the referenced object.

Type
String; read-only.

50.2 Methods

50.2.1 Characters.add()

app.activeDocument.textFrames[index].contents.add(contents[,relativeObject][,
insertionLocation])

Description

Adds a new character with specified text contents at the specified location in the current document.

If a location is not specified, adds the new character to the containing text frame after the current text selection or

insertion point.

Parameters

Returns

TextRange

Parameter Type Description
contents String Text contents to add
relativeObject TextFrameltem, optional Object to add item to
insertionLocation | ElementPlacement, optional | Location to place text

50.2.2 Characters.addBefore()

app.activeDocument .textFrames[index].contents.addBefore(contents)

Description

Adds a character before the specified text selection.

Parameters
Parameter | Type | Description
contents | String | Text contents to add
Returns
TextRange
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50.2.3 Characters.index()

app.activeDocument.textFrames[index].contents. index (itemKey)

Description

Gets an element from the collection.

Type

Description

String, Number

String or number key

Parameters
Parameter
itemKey
Returns
TextRange

50.2.4 Characters.removeAll()

app.activeDocument.textFrames[index].contents.removeAll()

Description
Deletes all elements in the collection.
Returns

Nothing.

50.3 Example

50.3.1 Counting characters

// Counts all characters in the active document,

// including whitespace, and stores in numChars

if (app.documents.length > 0) {
var doc = app.activeDocument;
var numChars = 0;

for (var i = 0; i < doc.textFrames.length; i++) {
var textArtRange = doc.textFrames[i].contents;
numChars += textArtRange.length;

}

50.3. Example
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FIFTYONE

CHARACTERSTYLE

characterStyle
Description

Associates character attributes with characters. For an example, see CharacterStyles.

51.1 Properties

51.1.1 CharacterStyle.characterAttributes

characterStyle.characterAttributes
Description
The character properties for the style.

Type

CharacterAttributes, read-only.

51.1.2 CharacterStyle.name

characterStyle.name
Description

The character style’s name.
Type

String
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51.1.3 CharacterStyle.parent

characterStyle.parent
Description

The object’s container.
Type

Object, read-only.

51.1.4 CharacterStyle.typename

characterStyle. typename
Description
The class name of the object.

Type

String, read-only.

51.2 Methods

51.2.1 CharacterStyle.applyTo()

characterStyle.applyTo(textItem [,clearingOverrides])

Description

Applies the character style to the text object or objects.

Paramaters
Parameter Type Description
textItem Object Text item to apply style to
clearingOverrides | Boolean, optional | Whether to clear overrides
Returns
Nothing
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51.2.2 CharacterStyle.remove()

characterStyle.remove()
Description

Deletes the object.

Returns

Nothing.

51.2. Methods
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CHAPTER
FIFTYTWO

CHARACTERSTYLES

app.activeDocument.characterStyles
Description

A collection of CharacterStyle objects.

52.1 Properties

52.1.1 CharacterStyles.length

app.activeDocument.characterStyles.length
Description
The number of characters in the collection.

Type

Number; read-only.

52.1.2 CharacterStyles.parent

app.activeDocument.characterStyles.parent
Description

The object’s container.

Type

Object; read-only.
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52.1.3 CharacterStyles.typename

app.activeDocument.characterStyles. typename
Description

The class name of the object.

Type

String; read-only.

52.2 Methods

52.2.1 CharacterStyles.add()

add (name)
Description

Creates a named character style.

Parameters

Parameter | Type | Description

name String | Element name to create
Returns
CharacterStyle

52.2.2 CharacterStyles.getByName()

getByName (name)
Description

Gets the first element in the collection with the provided name.

Parameters

Parameter | Type | Description

name String | Name of element to get
Returns
CharacterStyle
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52.2.3 CharacterStyles.index()

index(itemKey)
Description

Gets an element from the collection.

Parameters
Parameter | Type Description
itemKey String, Number | String or number key
Returns
CharacterStyle

52.2.4 CharacterStyles.removeAll()

removeAll ()

Description

Deletes all elements in this collection.
Returns

Nothing.

52.3 Example

52.3.1 Using characters styles

// Creates 3 text frames in a new document then creates
// a character style and applies it to each text frame.

var docRef = documents.add();

var textRefl = docRef.textFrames.add();
textRefl.contents = "Scripting is fun!";
textRefl.top = 700;

textRefl.left = 50;

var textRef2 = docRef.textFrames.add();
textRef2.contents = "Scripting is easy!";
textRef2.top = 625;

textRef2.left = 100;

var textRef3 = docRef.textFrames.add();
textRef3.contents = "Everyone should script!";
textRef3.top = 550;

(continues on next page)
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(continued from previous page)

textRef3.left = 150;
redraw();

// Create a new character style
var charStyle = docRef.characterStyles.add("BigRed");

// set character attributes

var charAttr = charStyle.characterAttributes;
charAttr.size = 40;

charAttr.tracking = -50;

charAttr.capitalization = FontCapsOption.ALLCAPS;

var redColor = new RGBColor();
redColor.red 255;
redColor.green = 0;
redColor.blue = 0;
charAttr.fillColor = redColor;

// apply to each textFrame in the document
charStyle.applyTo(textRefl. textRange);
charStyle.applyTo(textRef2.textRange);
charStyle.applyTo(textRef3.textRange);
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CHAPTER
FIFTYTHREE

CMYKCOLOR

new cmykColor()
Description
A CMYK color specification, used where a color object is required.

If the color space of a document is RGB and you specify the color value for a page item in that document using CMYK,
lustrator will translate the CMYK color specification into an RGB color specification. The same thing happens if the
document’s color space is CMYK and you specify colors using RGB. Since this translation can lose information, you
should specify colors using the class that matches the document’s actual color space.

53.1 Properties

53.1.1 CMYKColor.black

cmykColor.black
Description
The black color value. Range 0.0-100.0. Default: 0.0

Type
Number (double)

53.1.2 CMYKColor.cyan

cmykColor.cyan

Description

The cyan color value. Range 0.0-100.0. Default: 0.0
Type

Number (double)
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53.1.3 CMYKColor.magenta

cmykColor.magenta
Description
The magenta color value. Range 0.0-100.0. Default: 0.0

Type
Number (double)

53.1.4 CMYKColor.typename

cmykColor. typename
Description
The class name of the referenced object.

Type
String; read-only.

53.1.5 CMYKColor.yellow

cmykColor.yellow
Description
The yellow color value. Range 0.0-100.0. Default: 0.0

Type
Number (double)

53.2 Example

53.2.1 Setting a CMYK color

// Sets the fill color of the frontmost path item in
// the current document to a light purple CMYK color

if (app.documents.length > 0 &% app.activeDocument.pathItems.length > 0) {
var frontPath = app.activeDocument.pathItems[0];

// Set color values for the CMYK object
var newCMYKColor = new cmykColor();
newCMYKColor.black = 0;
newCMYKColor.cyan = 30.4;

(continues on next page)
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(continued from previous page)

newCMYKColor.magenta = 32;
newCMYKColor.yellow = 0;

// Use the color object in the path item
frontPath.filled = true;
frontPath.fillColor = newCMYKColor;
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CHAPTER
FIFTYFOUR

COLOR

color
Description
An abstract parent class for all color classes used in Illustrator.

Subclasses are:

54.1 GradientColor

gradientColor
Description

A gradient color specification in a Gradient object. A script can create a new gradient color using a reference to an
existing gradient in the document. If no existing gradient object is referenced, a default gradient is supplied.

54.1.1 Properties

GradientColor.angle

gradientColor.angle

Description

The gradient vector angle in degrees. Default: 0.0.
Type

Number (double).
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GradientColor.gradient

gradientColor.gradient

Description

Reference to the object defining the gradient.
Type

Gradient

GradientColor.hiliteAngle

gradientColor.hiliteAngle

Description

The gradient highlight vector angle in degrees.
Type

Number (double).

GradientColor.hiliteLength

gradientColor.hiliteLength
Description
The gradient highlight vector length.

Type
Number (double).

GradientColor.length

gradientColor.length
Description
The gradient vector length.

Type
Number (double).
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GradientColor.matrix

gradientColor.matrix
Description
An additional transformation matrix to manipulate the gradient path.

Type

Matrix.

GradientColor.origin

gradientColor.origin

Description

The gradient vector origin, the center point of the gradient in this color.
Type

Array of 2 numbers.

GradientColor.typename

gradientColor.typename
Description

The class name of the referenced object.
Type

String, read-only.

54.1.2 Example

Changing a gradient stop color

// Creates a new RGB document, then changes the color of the first gradient stop of an.,

—indexed gradient
app . documents.add(DocumentColorSpace.RGB) ;

// Get a reference to the gradient that you want to change
var gradientRef = app.activeDocument.gradients[1];

// Create the new color

var startColor = new RGBColor();
startColor.red = 255;
startColor.green = 238;

(continues on next page)
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(continued from previous page)

startColor.blue = 98;

// apply new color to the first gradient stop
gradientRef.gradientStops[0].color = startColor;

54.2 GrayColor

new GrayColor()
Description

A grayscale color specification, used where a color object is required.

54.2.1 Properties

GrayColor.gray

grayColor.gray

Description

The tint of the gray. Range: 0.0 to 100.0, where 0.0 is black and 100.0 is white.
Type

Number (double).

GrayColor.typename

grayColor.typename

Description

The class name of the referenced object.
Type

String, read-only.

54.2.2 Example

Changing a color to gray
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// Sets the color of the first word in the active document to a shade of gray

if (app.documents.length > 0 &% app.activeDocument.textFrames.length > 0) {
var text = app.activeDocument.textFrames[0].textRange;
var firstWord = text.words[0];

// Create the new color
var textColor = new GrayColor();
textColor.gray = 45;

firstWord.filled = true;
firstWord.fillColor = textColor;

54.3 LabColor

labColor
Description

A color specification in the CIE Lab color space, used where a color object is required.

54.3.1 Properties
LabColor.a

labColor.a
Description
The a (red-green) color value. Range -128.0-128.0. Default: 0.0.

Type
Number (double).

LabColor.b

labColor.b
Description
The b (yellow-blue) color value. Range -128.0—128.0. Default: 0.0.

Type
Number (double).

54.3. LabColor
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LabColor.l

labColor.1
Description

The 1 (lightness) color value. Range -128.0-128.0. Default: 0.0.

Type
Number (double).

54.4 NoColor

new NoColor()

Description

Represents the “none” color. Assigning a NoColor object to the fill or stroke color of an art item is equivalent to setting

the filled or stroked property to false.

54.4.1 Properties

NoColor.typename

noColor. typename
Description
The class name of the object.

Type

String, read-only.

54.4.2 Example

Using NoColor to remove a fill color

// Creates 2 overlapping objects with different fill colors.
// Assign the top object a fill color of "NoColor"
// allowing the bottom object to become visible.

// Create 2 overlapping objects one blue, one red;

var docRef = documents.add();

var itemRefl = docRef.pathItems.rectangle(500, 200, 200, 100);
var itemRef2 = docRef.pathItems.rectangle(550, 150, 200, 200);
var rgbColor = new RGBColor();

rgbColor.red = 255;

itemRef2.fillColor = rgbColor;

(continues on next page)
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(continued from previous page)

rgbColor.blue = 255;
rgbColor.red = 0;
itemRefl.fillColor = rgbColor;
redraw();

// create a nocolor and assign it to the top object
var noColor = new NoColor();

itemRef2.fillColor = noColor;

redraw();

54.5 PatternColor

patternColor
Description

A pattern color specification. You can create a new pattern color by modifying an existing pattern in the document.
Any modification you make to a pattern affects that pattern in the Palette.

PatternColor objects can be used in any property that takes a color object, such as fillColor or strokeColor.

54.5.1 Properties

PatternColor.matrix

patternColor.matrix
Description
Additional transformation arising from manipulating the path.

Type

Matrix

PatternColor.pattern

patternColor.pattern

Description

A reference to the pattern object that defines the pattern to use in this color definition.
Type

Pattern
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PatternColor.reflect

patternColor.reflect

Description

If true, the prototype should be reflected before filling.
Default: false

Type

Boolean

PatternColor.reflectAngle

patternColor.reflectAngle
Description

The axis around which to reflect, in points.
Default: 0.0

Type

Number (double)

PatternColor.rotation

patternColor.rotation

Description

The angle in radians to rotate the prototype pattern before filling.
Default: 0.0

Type

Number (double)

PatternColor.scaleFactor

patternColor.scaleFactor
Description

The fraction to which to scale the prototype pattern before filling, represented as a point containing horizontal and
vertical scaling percentages.

Type

Array of 2 numbers
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PatternColor.shearAngle

patternColor.shearAngle

Description

The angle in radians by which to slant the shear.
Default: 0.0

Type

Number (double)

PatternColor.shearAxis

patternColor.shearAxis

Description

The axis to shear with respect to, in points.
Default: 0.0

Type

Number (double)

PatternColor.shiftAngle

patternColor.shiftAngle

Description

The angle in radians to which to translate the unscaled prototype pattern before filling.
Default: 0.0

Type

Number (double)

PatternColor.shiftDistance

patternColor.shiftDistance

Description

The distance in points to which to translate the unscaled prototype pattern before filling.
Default: 0.0

Type
Number (double)
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PatternColor.typename

patternColor. typename
Description
The class name of the referenced object.

Type

String; read-only.

54.5.2 Example

Modifying and applying pattern colors

// Rotates the color of each pattern in the current document,

// then applies the last pattern to the first path item

if (app.documents.length > 0 &% app.activeDocument.pathItems.length > 0) {
var doc = app.activeDocument;
var swatchIndex = 0;

for (i = 0; i < doc.swatches.length; i++) {
// Get the generic color object of the swatch
var currentSwatch = doc.swatches[i];
var swatchColor = currentSwatch.color;

// Only operate on patterns
if (currentSwatch.color.typename == "PatternColor") {

// Change a pattern property
currentSwatch.color.rotation = 10;
swatchIndex = ij;
}
}

// Apply the last pattern color swatch to the frontmost path
var firstPath = app.activeDocument.pathItems[0];
firstPath.filled = true;

firstPath.fillColor = doc.swatches[swatchIndex].color;

54.6 RGBColor

new RGBColor()
Description
An RGB color specification, used to apply an RGB color to a layer or art item.

If the color space of a document is RGB and you specify the color value for a page item in that document using CMYK,
Mlustrator will translate the CMYK color specification into an RGB color specification. The same thing happens if the
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document’s color space is CMYK and you specify colors using RGB. Since this translation can lose information, you
should specify colors using the class that matches the document’s actual color space.

54.6.1 Properties
RGBColor.blue

rgbColor.blue
Description
The blue color value. Range: 0.0 to 255.0.

Type
Number (double).

RGBColor.green

rgbColor.green

Description

The green color value. Range: 0.0 to 255.0.
Type

Number (double).

RGBColor.red

rgbColor.red
Description
The red color value. Range: 0.0 to 255.0.

Type
Number (double).

RGBColor.typename

rgbColor. typename

Description

The class name of the referenced object.
Type

String, read-only.
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54.6.2 Example

Setting an RGB color

// Sets the default fill color in the current document to yellow.

if (app.documents.length > 0) {
// Define the new color
var newRGBColor = new RGBColor();
newRGBColor.red = 255;
newRGBColor.green = 255;
newRGBColor.blue = 0;

app.activeDocument.defaultFillColor = newRGBColor;

54.7 SpotColor

new SpotColor()

Description

Color class used to apply the color value of a spot at a specified tint value. Can be used in any property that takes a

color object.

54.7.1 Properties

SpotColor.spot

spotColor. spot

Description

A reference to the spot color object that defines the color.
Type

Spot

SpotColor.tint

spotColor.tint
Description
The tint of the color. Range: 0.0 to 100.0

Type
Number (double)
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SpotColor.typename

spotColor. typename

Description

The class name of the referenced object.
Type

String; read-only.
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CHAPTER
FIFTYFIVE

COMPOUNDPATHITEM

app.activeDocument.activelLayer.compoundPathItems[index
Description

A compound path. These objects are composed of multiple intersecting paths, resulting in transparent interior spaces
where the component paths overlap. The pathltems property provides access to the paths that make up the compound
path.

Paths contained within a compound path or group in a document are returned as individual paths when a script asks for
the paths contained in the document. However, paths contained in a compound path or group are not returned when a
script asks for the paths in a layer that contains the compound path or group.

All paths within a compound path share property values. Therefore, if you set the value of a property of any one of the
paths in the compound path, the properties of all other component paths are updated with the new value.

55.1 Properties

55.1.1 CompoundPathltem.artworkKnockout

app.activeDocument.activelLayer.compoundPathItems[index] .artworkKnockout
Description

Is this object used to create a knockout, and if so, what kind of knockout.

Type

KnockoutState

55.1.2 CompoundPathltem.blendingMode

app.activeDocument.activelLayer.compoundPathItems[index].blendingMode
Description
The mode used when compositing an object.

Type
BlendModes
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55.1.3 CompoundPathltem.controlBounds

app.activeDocument.activelayer.compoundPathItems[index].controlBounds
Description

The bounds of the object including stroke width and controls.

Type

Array of 4 numbers, read-only.

55.1.4 CompoundPathitem.editable

app.activeDocument.activelLayer.compoundPathItems[index].editable
Description
If true, this item is editable.

Type

Boolean, read-only.

55.1.5 CompoundPathltem.geometricBounds

app.activeDocument.activelLayer.compoundPathItems[index].geometricBounds
Description

The bounds of the object excluding stroke width.

Type

Array of 4 numbers, read-only.

55.1.6 CompoundPathltem.height

app.activeDocument.activelLayer.compoundPathItems[index].height
Description
The height of the compound path item excluding stroke width.

Type
Number (double).

224 Chapter 55. CompoundPathltem



lllustrator Scripting Guide, Release 0.0.1

55.1.7 CompoundPathltem.hidden

app.activeDocument.activelayer.compoundPathItems[index].hidden
Description

If true, this compound path item is hidden.

Type

Boolean.

55.1.8 CompoundPathltem.islsolated

app.activeDocument.activelLayer.compoundPathItems[index].isIsolated
Description
If true, this object is isolated.

Type

Boolean.

55.1.9 CompoundPathltem.layer

app.activeDocument.activelLayer.compoundPathItems[index].layer
Description

The layer to which this compound path item belongs.

Type

Layer, read-only.

55.1.10 CompoundPathitem.left

app.activeDocument.activelLayer.compoundPathItems[index].left
Description
The position of the left side of the item (in points, measured from the left side of the page).

Type
Number (double).

55.1. Properties
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55.1.11 CompoundPathltem.locked

app.activeDocument.activelayer.compoundPathItems[index].locked
Description

If true, this compound path item is locked.

Type

Boolean.

55.1.12 CompoundPathltem.name

app.activeDocument.activelLayer.compoundPathItems[index].name
Description
The name of this compound path item.

Type
String.

55.1.13 CompoundPathltem.note

app.activeDocument.activelLayer.compoundPathItems[index].note
Description

The note assigned to this item.

Type

String.

55.1.14 CompoundPathltem.opacity

app.activeDocument.activelLayer.compoundPathItems[index].opacity
Description
The opacity of the object. Range: 0.0 to 100.0

Type
Number (double).
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55.1.15 CompoundPathltem.parent

app.activeDocument.activelayer.compoundPathItems[index] .parent
Description

The parent of this object.

Type

Layer or Groupltem, read-only.

55.1.16 CompoundPathltem.pathltems

app.activeDocument.activelLayer.compoundPathItems[index] .pathItems
Description
The path art items in this compound path.

Type

Pathltems, read-only.

55.1.17 CompoundPathltem.position

app.activeDocument.activelLayer.compoundPathItems[index].position
Description

The position (in points) of the top left corner of the compoundPathItem object in the format [x, y]. Does not include
stroke weight.

Type

Array of 2 numbers.

55.1.18 CompoundPathltem.selected

app.activeDocument.activelayer.compoundPathItems[index].selected
Description

If true, this compound path item is selected.

Type

Boolean.
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55.1.19 CompoundPathltem.sliced

app.activeDocument.activelayer.compoundPathItems[index].sliced
Description

If true, the item is sliced. Default: false

Type

Boolean.

55.1.20 CompoundPathltem.tags

app.activeDocument.activelLayer.compoundPathItems[index].tags
Description
The tags contained in this object.

Type
Tags, read-only.

55.1.21 CompoundPathltem.top

app.activeDocument.activelLayer.compoundPathItems[index].top
Description

The position of the top of the item (in points, measured from the bottom of the page).
Type

Number (double).

55.1.22 CompoundPathltem.typename

app.activeDocument.activelLayer.compoundPathItems[index] .typename
Description
The class name of the referenced object.

Type
String, read-only.
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55.1.23 CompoundPathltem.uRL

app.activeDocument.activelayer.compoundPathItems[index].uRL
Description

The value of the Adobe URL tag assigned to this compound path item.

Type

String.

55.1.24 CompoundPathltem.visibilityVariable

app.activeDocument.activelLayer.compoundPathItems[index].visibilityVariable
Description
The visibility variable bound to the item.

Type

Variant.

55.1.25 CompoundPathltem.visibleBounds

app.activeDocument.activelLayer.compoundPathItems[index].visibleBounds
Description

The visible bounds of the compound path item including stroke width.

Type

Array of 4 numbers, read-only.

55.1.26 CompoundPathltem.width

app.activeDocument.activelLayer.compoundPathItems[index].width
Description
The width of the compound path item excluding stroke width.

Type
Number (double).

55.1. Properties

229



lllustrator Scripting Guide, Release 0.0.1

55.1.27 CompoundPathltem.wraplnside

app.activeDocument.activelayer.compoundPathItems[index].wrapInside
Description

If true, the text frame object should be wrapped inside this object.

Type

Boolean.

55.1.28 CompoundPathltem.wrapOffset

app.activeDocument.activelLayer.compoundPathItems[index].wrapOffset
Description
The offset to use when wrapping text around this object.

Type
Number (double).

55.1.29 CompoundPathltem.wrapped

app.activeDocument.activelLayer.compoundPathItems[index].wrapped
Description

If true, wrap text frame objects around this object (text frame must be above the object).
Type

Boolean.

55.1.30 CompoundPathltem.zOrderPosition

app.activeDocument.activelLayer.compoundPathItems[index] .zOrderPosition
Description
The position of this art item within the stacking order of the group or layer (Parent) that contains the art item.

Type
Number (long), read-only.
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55.2 Methods

55.2.1 CompoundPathltem.duplicate()

app.activeDocument.activelayer.compoundPathItems[index].duplicate([relativeObject][,

insertionLocation])

Description

Creates a duplicate of the selected object.

Parameters
Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element
Returns

CompoundPathltem

55.2.2 CompoundPathltem.move()

app.activeDocument.activelLayer.compoundPathItems[index].move(relativeObject,

insertionLocation)
Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionLocation | ElementPlacement, optional | Location to move element to

Returns

Nothing.

55.2.3 CompoundPathltem.remove()

app.activeDocument.activelLayer.compoundPathItems[index].remove()

Description
Deletes this object.
Returns

Nothing.

55.2. Methods

231



lllustrator Scripting Guide, Release 0.0.1

55.2.4 CompoundPathltem.resize()

app.activeDocument.activelLayer.compoundPathItems[index].resize(
scaleX, scaleY [,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,scaleAbout]

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =
100%.

Parameters
Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

55.2.5 CompoundPathltem.rotate()

app.activeDocument.activelLayer.compoundPathItems[index].rotate(
angle [,changePositions] [,changeFillPatterns]
[,changeFillGradients] [,changeStrokePattern] [,rotateAbout]

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
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Nothing.

55.2.6 compoundPathltem.transform()

app.activeDocument.activelLayer.compoundPathItems[index].transform(
transformationMatrix [,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,transformAbout]

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

55.2.7 CompoundPathltem.translate()

app.activeDocument.activelLayer.compoundPathItems[index].translate(
deltaX [,deltaY] [,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltaY is the vertical

offset.
Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects

transformFillPatterns

Boolean, optional

Whether to transform Fill Patterns

transformFillGradients

Boolean, optional

Whether to transform Fill Gradients

transformStrokePatterns

Boolean, optional

Whether to transform Stroke Patterns

55.2. Methods
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Returns

Nothing.

55.2.8 CompoundPathltem.zOrder()

app.activeDocument.activelLayer.compoundPathItems[index].zOrder (zOrderCmd)
Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters

Parameter | Type Description

zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.

55.3 Example

55.3.1 Selecting paths in a document

// Selects all paths not part of a compound path
if ( app.documents.length > 0 ) {
var doc = app.activeDocument;
var count = 0;
if ( doc.pathItems.length > 0 ) {
var thePaths = doc.pathItems;
var numPaths = thePaths.length;
for (var i = 0; i < doc.pathItems.length; i++ ) {
var pathArt = doc.pathItems[i];

if ( pathArt.parent.typename != "compoundPathItem" ) {
pathArt.selected = true;
count++;

}
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55.3.2 Creating and modifying a compound path item

// Creates a new compound path item containing 3 path
// items, then sets the width and the color of the stroke
// to all items in the compound path

if (app.documents.length > 0) {
var doc = app.activeDocument;
var newCompoundPath = doc.activelLayer.compoundPathItems.add();

// Create the path items
var newPath = newCompoundPath.pathItems.add();
newPath.setEntirePath(Array(Array (30, 50), Array(30, 100)));

newPath = newCompoundPath.pathItems.add();
newPath.setEntirePath(Array(Array (40, 100), Array(100, 100)));

newPath = newCompoundPath.pathItems.add();
newPath.setEntirePath(Array(Array (100, 110), Array(100, 300)));

// Set stroke and width properties of the compound path
newPath.stroked = true;

newPath.strokeWidth = 3.5;

newPath.strokeColor = app.activeDocument.swatches[3].color;

55.3. Example
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FIFTYSIX

COMPOUNDPATHITEMS

app.activeDocument.activelLayer.compoundPathItems
Description

A collection of CompoundPathltem objects.

56.1 Properties

56.1.1 CompoundPathltems.length

app.activeDocument.activelayer.compoundPathItems.length
Description
The number of objects in the collection.

Type

Number, read-only.

56.1.2 CompoundPathltems.parent

app.activeDocument.activelLayer.compoundPathItems.parent
Description

The parent of this collection (either a Layer or a GroupItem).

Type

Object, read-only.
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56.1.3 CompoundPathltems.typename

app.activeDocument.activelLayer.compoundPathItems. typename

Description

The class name of the referenced object.
Type

String, read-only.

56.2 Methods

56.2.1 CompoundPathltems.add()

app.activeDocument.activelLayer.compoundPathItems.add()
Description

Creates a new CompoundPathItem.

Returns

CompoundPathltem

56.2.2 CompoundPathltems.getByName()

app.activeDocument.activelLayer.compoundPathItems.getByName (name)

Description
Gets the first element in the collection with the specified name.

Parameters

Parameter | Type | Description

name String | Name of element to get

Returns

CompoundPathltem
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56.2.3 CompoundPathltems.index()

app.activeDocument.activelayer.compoundPathItems.index (itemKey)
Description
Gets an element from the collection.

Parameters

Parameter | Type Description
itemKey String, Number | String or number key

Returns

CompoundPathltem

56.2.4 CompoundPathltems.removeAll()

app.activeDocument.activelLayer.compoundPathItems.removeAll ()
Description

Deletes all elements in this collection.

Returns

Nothing.

56.3 Example

56.3.1 Counting compound paths

// Counts all compound path items in layer 1 of the current document
if (app.documents.length > 0) {

var doc = app.activeDocument;

var numCompoundPaths = doc.layers[0].compoundPathItems.length;

}

56.3. Example
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CHAPTER
FIFTYSEVEN

app.activeDocument.dataSets[index

Description

DATASET

A set of data used for dynamic publishing. A dataset allows you to collect a number of variables and their dynamic
data into one object. You must have at least one variable bound to an art item in order to create a dataset. See the class

Variable.

57.1 Properties

57.1.1 Dataset.name

app.activeDocument.dataSets[index] .name
Description

Then name of the dataset.

Type

String.

57.1.2 Dataset.parent

app.activeDocument.dataSets[index].parent
Description
The name of the object that contains this dataset.

Type

Document, read-only.
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57.1.3 Dataset.typename

app.activeDocument.dataSets[index] . typename
Description

The class name of the referenced object.

Type

String.

57.2 Methods

57.2.1 Dataset.display()

app.activeDocument.dataSets[index].display()
Description

Displays the dataset.

Returns

Nothing.

57.2.2 Dataset.remove()

app.activeDocument.dataSets[index].remove()
Description

Deletes this object.

Returns

Nothing.

57.2.3 Dataset.update()

app.activeDocument.dataSets[index].update()
Description

Updates the dataset.

Returns

Nothing.
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57.3 Example

57.3.1 Using variables and datasets

// Creates two variables, 1 visibility and 1 text,
// creates two datasets each with different values for the variables,
// then displays both datasets

var docRef = documents.add();

// Create visibility variable

var itemRef = docRef.pathItems.rectangle(600, 200, 150, 150);
var colorRef = new RGBColor;

colorRef.red = 255;

itemRef.fillColor = colorRef;

var visibilityVar = docRef.variables.add();
visibilityVar.kind = VariableKind.VISIBILITY;
itemRef.visibilityVariable = visibilityVar;

// Create text variable

var textRef = docRef.textFrames.add();
textRef.contents = "Text Variable, dataset 1";
textRef.top = 400;

textRef.left = 200;

var textVar = docRef.variables.add(Q);
textVar.kind = VariableKind.TEXTUAL;
textRef.contentVariable = textVar;
redraw();

// Create dataset 1
var dsl = docRef.dataSets.add();

// Change variable values and create dataset 2
itemRef.hidden = true;

textRef.contents = "Text Variable, dataset 2";
redraw();

var ds2 = docRef.dataSets.add();

// display each dataset
dsl.display(Q);
redraw();
ds2.display(Q);
redraw();

57.3. Example
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FIFTYEIGHT

DATASETS

app.activeDocument.dataSets
Description

A collection of Dataset objects.

58.1 Properties

58.1.1 Datasets.length

app.activeDocument.dataSets.length
Description
The number of datasets in the collection.

Type

Number, read-only.

58.1.2 Datasets.parent

app.activeDocument.dataSets.parent
Description

The name of the object that contains this dataset.
Type

Document, read-only.
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58.1.3 Datasets.typename

app.activeDocument.dataSets.typename
Description

The class name of the referenced object.

Type

String, read-only.

58.2 Methods

58.2.1 Datasets.add()

app.activeDocument.dataSets.add()
Description

Creates a new dataset object.

Returns

Dataset

58.2.2 Datasets.getByName()

app.activeDocument.dataSets.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters
Parameter | Type | Description
name String | Name of element to get
Returns
Dataset
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58.2.3 Datasets.index()

app.activeDocument.dataSets.index (itemKey)

Description

Gets an element from the collection.

Parameters

Returns

Dataset

Parameter

Type

Description

itemKey

String, Number

String or number key

58.2.4 Datasets.removeAll()

app.activeDocument.dataSets.removeAll()

Description

Removes all elements in the collection.

Returns

Nothing.

58.2. Methods
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CHAPTER
FIFTYNINE

app.activeDocument

Description

An Illustrator document. Documents are contained in the Application object.

DOCUMENT

The default document settings—those properties starting with the word “default”—are global settings that affect the
current document. Be sure to modify these default properties only when a document is open. Note that if you set
default properties to desired values before creating new objects, you can streamline your scripts, eliminating the need

to specify specific properties such as fillColor and stroked that have default properties.

A document’s color space, height, and width can only be set when the document is created. You cannot modify these
properties in an existing document. See Application.open() for more information on how document color spaces are

handled.

59.1 Properties

59.1.1 Document.activeDataset

app.activeDocument.activeDataset
Description

The currently opened dataset.

Type

Dataset

59.1.2 Document.activeLayer

app.activeDocument.activelLayer
Description

The active layer in the document.

Type

Layer
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59.1.3 Document.activeView

app.activeDocument.activeView
Description

The document’s current view.

Type

View, read-only.

59.1.4 Document.artboards

app.activeDocument.artboards
Description
All artboards in the document.

Type

Artboards, read-only.

59.1.5 Document.brushes

app.activeDocument.brushes
Description

The brushes contained in the document.
Type

Brushes, read-only.

59.1.6 Document.characterStyles

app.activeDocument.characterStyles
Description
The list of character styles in this document.

Type

CharacterStyles, read-only.
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59.1.7 Document.compoundPathltems

app.activeDocument . compoundPathItems
Description

The compound path items contained in the document.
Type

CompoundPathltems, read-only.

59.1.8 Document.cropBox

app.activeDocument.cropBox
Description
The boundary of the document’s cropping box for output, or null if no value has been set.

Type

Array of 4 numbers.

59.1.9 Document.cropStyle

app.activeDocument.cropStyle
Description

The style of the document’s cropping box.
Type

CropOptions

59.1.10 Document.dataSets

app.activeDocument.dataSets
Description

The datasets contained in the document.
Type

Datasets, read-only.
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59.1.11 Document.defaultFillColor

app.activeDocument.defaultFillColor

Description

The color to use to fill new paths if defaultFilled is true.

Type

Color

59.1.12 Document.defaultFilled

app.activeDocument.defaultFilled
Description

If true, a new path should be filled.
Type

Boolean.

59.1.13 Document.defaultFillOverprint

app.activeDocument.defaultFillOverprint

Description

If true, the art beneath a filled object should be overprinted by default.

Type

Boolean.

59.1.14 Document.defaultStrokeCap

app.activeDocument .defaultStrokeCap
Description

Default type of line capping for paths created.
Type

StrokeCap
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59.1.15 Document.defaultStrokeColor

app.activeDocument .defaultStrokeColor
Description

The stroke color for new paths if default stroked is true.
Type

Color

59.1.16 Document.defaultStroked

app.activeDocument.defaultStroked
Description
If true, a new path should be stroked.

Type

Boolean.

59.1.17 Document.defaultStrokeDashes

app.activeDocument .defaultStrokeDashes
Description

Default lengths for dashes and gaps in dashed lines, starting with the first dash length, followed by the first gap length,
and so on. Set to an empty object, { }, for solid line.

Type
Object.

59.1.18 Document.defaultStrokeDashOffset

app.activeDocument.defaultStrokeDashOffset

Description

The default distance into the dash pattern at which the pattern should be started for new paths.
Type

Number (double).
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59.1.19 Document.defaultStrokedJoin

app.activeDocument.defaultStrokeJoin
Description

Default type of joints in new paths.

Type

StrokeJoin

59.1.20 Document.defaultStrokeMiterLimit

app.activeDocument.defaultStrokeMiterLimit

Description

When a default stroke join is set to mitered, this property specifies when the join will be converted to beveled (squared-
off ) by default. The default miter limit of 4 means that when the length of the point reaches four times the stroke weight,
the join switches from a miter join to a bevel join. Range: 1 to 500; a value of 1 specifies a bevel join.

Type
Number (double).

59.1.21 Document.defaultStrokeOverprint

app.activeDocument.defaultStrokeOverprint

Description

If true, the art beneath a stroked object should be overprinted by default.

Type

Boolean.

59.1.22 Document.defaultStrokeWidth

app.activeDocument.defaultStrokeWidth
Description

Default width of stroke for new paths.

Type

Number (double).
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59.1.23 Document.documentColorSpace

app.activeDocument .documentColorSpace

Description

The color specification system to use for this document’s color space.
Type

DocumentColorSpace

59.1.24 Document.fullName

app.activeDocument. fullName

Description

The file associated with the document, which includes the complete path to the file.
Type

File, read-only.

59.1.25 Document.geometricBounds

app.activeDocument .geometricBounds
Description
The bounds of the illustration excluding the stroke width of any objects in the document.

Type

Array of 4 numbers, read-only.

59.1.26 Document.gradients

app.activeDocument.gradients
Description

The gradients contained in the document.
Type

Gradients, read-only.
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59.1.27 Document.graphicStyles

app.activeDocument.graphicStyles
Description

The graphic styles defined in this document.
Type

GraphicStyles, read-only.

59.1.28 Document.graphltems

app.activeDocument.graphltems
Description
The graph art items in this document.

Type

Graphltems, read-only.

59.1.29 Document.groupltems

app.activeDocument.groupltems
Description

The group items contained in the document.
Type

Groupltems, read-only.

59.1.30 Document.height

app.activeDocument.height
Description
The height of the document.

Type
Number (double), read-only.
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59.1.31 Document.inkList

app.activeDocument.inkList
Description

The list of inks in this document.
Type

Object, read-only.

59.1.32 Document.kinsokuSet

app.activeDocument .kinsokuSet

Description

The Kinsoku set of characters that cannot begin or end a line of Japanese text.

Type
Object, read-only.

59.1.33 Document.layers

app.activeDocument.layers
Description

The layers contained in the document.
Type

Layers, read-only.

59.1.34 Document.legacyTextltems

app.activeDocument.legacyTextItems
Description
The legacy text items in the document.

Type

LegacyTextltems, read-only.

59.1. Properties

257



lllustrator Scripting Guide, Release 0.0.1

59.1.35 Document.meshltems

app.activeDocument .meshItems
Description

The mesh art items contained in the document.
Type

Meshltems, read-only.

59.1.36 Document.mojikumiSet

app.activeDocument.mojikumiSet

Description

A list of names of predefined Mojikumi sets which specify the spacing for the layout and composition of Japanese text.

Type
Object, read-only.

59.1.37 Document.name

app.activeDocument .name

Description

The document’s name (not the complete file path to the document).

Type
String, read-only.

59.1.38 Document.nonNativeltems

app.activeDocument.nonNativeItems
Description
The non-native art items in this document.

Type

NonNativeltems, read-only.
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59.1.39 Document.outputResolution

app.activeDocument .outputResolution

Description

The current output resolution for the document in dots per inch (dpi).
Type

Number (double), read-only.

59.1.40 Document.pageltems

app.activeDocument.pageltems
Description
The page items (all art item classes) contained in the document.

Type

Pageltems, read-only.

59.1.41 Document.pageOrigin

app.activeDocument.pageOrigin

Description

The zero-point of the page in the document without margins, relative to the overall height and width.
Type

Array of 2 numbers.

59.1.42 Document.paragraphStyles

app.activeDocument .paragraphStyles
Description
The list of paragraph styles in this document.

Type

ParagraphStyles, read-only.
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59.1.43 Document.parent

app.activeDocument.parent
Description

The application that contains this document.
Type

Application, read-only.

59.1.44 Document.path

app.activeDocument.path

Description

The file associated with the document, which includes the complete path to the file.

Type

File, read-only.

59.1.45 Document.pathltems

app.activeDocument.pathItems
Description

The path items contained in this document.
Type

Pathltems, read-only.

59.1.46 Document.patterns

app.activeDocument.patterns
Description
The patterns contained in this document.

Type

Patterns, read-only.
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59.1.47 Document.placeditems

app.activeDocument.placedItems
Description

The placed items contained in this document.
Type

Placedltems, read-only.

59.1.48 Document.pluginltems

app.activeDocument.pluginItems
Description
The plug-in items contained in this document.

Type

Pluginltems, read-only.

59.1.49 Document.printTiles

app.activeDocument.printTiles

Description

If true, this document should be printed as tiled output.

Type

Boolean, read-only.

59.1.50 Document.rasterEffectSettings

app.activeDocument.rasterEffectSettings
Description
The document’s raster effect settings.

Type

RasterEffectOptions, read-only.
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59.1.51 Document.rasterltems

app.activeDocument.rasterItems
Description

The raster items contained in this document.
Type

Rasterltems, read-only.

59.1.52 Document.rulerOrigin

app.activeDocument.rulerOrigin
Description
The zero-point of the rulers in the document relative to the bottom left of the document.

Type

Array of 2 numbers.

59.1.53 Document.rulerUnits

app.activeDocument.rulerUnits

Description

The default measurement units for the rulers in the document.
Type

RulerUnits, read-only.

59.1.54 Document.saved

app.activeDocument.saved
Description
If true, the document has not been changed since last time it was saved.

Type

Boolean.
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59.1.55 Document.selection

app.activeDocument.selection
Description
References to the objects in this document’s current selection, or null when nothing is selected.

A reference to an insertion point is returned when there is an active insertion point in the contents of a selected text art
item. Similarly, a reference to a range of text is returned when characters are selected in the contents of a text art item.

Type
Array of objects.

59.1.56 Document.showPlacedimages

app.activeDocument.showPlacedImages

Description

If true, placed images should be displayed in the document.
Type

Boolean, read-only.

59.1.57 Document.splitLongPaths

app.activeDocument.splitLongPaths
Description
If true, long paths should be split when printing.

Type

Boolean, read-only.

59.1.58 Document.spots

app.activeDocument.spots
Description

The spot colors contained in this document.
Type

Spots, read-only.
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59.1.59 Document.stationery

app.activeDocument.stationery
Description

If true, the file is a stationery file.
Type

Boolean, read-only.

59.1.60 Document.stories

app.activeDocument.stories
Description
The story items in this document.

Type

Stories, read-only.

59.1.61 Document.swatches

app.activeDocument.swatches
Description

The swatches in this document.
Type

Swatches, read-only.

59.1.62 Document.swatchGroups

app.activeDocument . swatchGroups
Description
The swatch groups in this document.

Type

SwatchGroups, read-only.
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59.1.63 Document.symbolltems

app.activeDocument.symbolItems
Description

The art items in the document linked to symbols.
Type

Symbolltems, read-only.

59.1.64 Document.symbols

app.activeDocument.symbols
Description
The symbols in this document.

Type
Symbols, read-only.

59.1.65 Document.tags

app.activeDocument.tags
Description

The tags in this document.
Type

Tags, read-only.

59.1.66 Document.textFrames

app.activeDocument . textFrames
Description
The text frames in this document.

Type

TextFrameltems, read-only.
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59.1.67 Document.tileFullPages

app.activeDocument.tileFullPages

Description

If true, full pages should be tiled when printing this document.
Type

Boolean, read-only.

59.1.68 Document.typename

app.activeDocument. typename
Description
The class name of the referenced object.

Type

String, read-only.

59.1.69 Document.useDefaultScreen

app.activeDocument.useDefaultScreen

Description

If true, the printer’s default screen should be used when printing this document.

Type

Boolean, read-only.

59.1.70 Document.variables

app.activeDocument.variables
Description
The variables defined in this document.

Type

Variables, read-only.

266

Chapter 59. Document



lllustrator Scripting Guide, Release 0.0.1

59.1.71 Document.variablesLocked

app.activeDocument.variablesLocked
Description

If true, the variables are locked.

Type

Boolean.

59.1.72 Document.views

app.activeDocument.views
Description
The views contained in this document.

Type

Views, read-only.

59.1.73 Document.visibleBounds

app.activeDocument.visibleBounds

Description

The visible bounds of the document, including stroke width of any objects in the illustration.

Type

Array of 4 numbers, read-only.

59.1.74 Document.width

app.activeDocument.width
Description
The width of this document.

Type
Number (double), read-only.
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59.1.75 Document.XMPString

app.activeDocument .XMPString

Description

The XMP metadata packet associated with this document.
Type

String.

59.2 Methods

59.2.1 Document.activate()

app.activeDocument.activate()

Description

Brings the first window associated with the document to the front.

Returns

Nothing.

59.2.2 Document.arrange()

app.activeDocument.arrange([layoutStyle])
Description
Arranges multiple documents in the given layout style.

Parameters

Parameter Type Description

layoutStyle | DocumentLayoutStyle, optional | The layout style to arrange documents in

Returns

Boolean.
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59.2.3 Document.close()

app.activeDocument.close([saveOptions])

Description

Closes a document using specified save options.

When you close a document, you should set your document reference to null to prevent your script from accidentally
trying to access closed documents.

Parameters

Returns

Nothing.

Parameter

Type

Description

saveOptions

SaveOptions

Save options to close with

59.2.4 Document.closeNoUI()

app.activeDocument.closeNoUI()

Description

Closes the specified non-UI document.

Returns

Nothing.

59.2.5 Document.convertCoordinate()

app.activeDocument.convertCoordinate(coordinate, source, destination)

Description

Converts the given point between artboard and document coordinate systems. Returns the converted point coordinates.

Parameters

Returns

Point.

Parameter Type

Description

coordinate Point

Point to convert

source CoordinateSystem

Source coordinate system

destination | CoordinateSystem

Destination coordinate system
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59.2.6 Document.exportFile()

app.activeDocument.exportFile(exportFile, exportFormat [,options])
Description

Exports the document to the specified file using one of the predefined export file formats. The appropriate file extension
is automatically appended to the file name, except for Photoshop® documents. For these, you must include the file
extension (PSD) in the file specification.

Parameters
Parameter Type Description
exportFile File File to save
exportFormat | ExportType Export file format
options Variable, optional | todo

Returns

Nothing.

59.2.7 Document.exportPDFPreset()

app.activeDocument .exportPDFPreset(file)
Description

Exports the current PDF preset values to the file.

Parameters

Parameter | Type | Description

file File Preset file to export to
Returns
Nothing.

59.2.8 Document.exportPerspectiveGridPreset()

app.activeDocument . exportPerspectiveGridPreset(file)
Description
Exports the current perspective grid preset values to the file.

Parameters

Parameter | Type | Description
file File Preset file to export to

Returns
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Nothing.

59.2.9 Document.exportPrintPreset()

app.activeDocument.exportPrintPreset(file)

Description

Exports the current print preset values to the file.

Parameters

Returns

Nothing.

Parameter

Type | Description

file

File

Preset file to export to

59.2.10 Document.exportVariables()

app.activeDocument .exportVariables(fileSpec)

Description

Saves datasets into an XML library. The datasets contain variables and their associated dynamic data.

Parameters

Returns

Nothing.

Parameter

Type

Description

fileSpec

File

XML Library file to export to

59.2.11 Document.fitArtboardToSelectedArt()

app.activeDocument . fitArtboardToSelectedArt([index])

Description

Resizes the artboard at the given index to fit currently selected art. Index default is 0. Returns true on success.

Parameters

Returns

Parameter | Type

Description

index Number (long), optional | Artboard index to resize
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Boolean.

59.2.12 Document.getPageltemFromUuid()

app.activeDocument .getPageItemFromUuid(uuid)

Note: This functionality was added in Illustrator 24.0. (CC2020)

Description
Retrieves the pageitem using Uuid.

Parameters

Returns

Pageltem.

Parameter

Type

Description

uuid

String

uuid of Pageltem

59.2.13 Document.getPerspectiveActivePlane()

app.activeDocument.getPerspectiveActivePlane()

Description

Retrieves the active plane of the active perspective grid of the document.

Returns

PerspectiveGridPlaneType

59.2.14 Document.hidePerspectiveGrid()

app.activeDocument.hidePerspectiveGrid()

Description

Hides the current active grid for the document. If no grid is visible, does nothing. Returns true if a grid is hidden.

Returns

Boolean.
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59.2.15 Document.imageCapture()

app.activeDocument .imageCapture(imageFile [,clipBounds] [,options])
Description

Captures the artwork content within the clipping boundaries in this document as a raster image, and writes the image
data to a specified file.

If the bounds parameter is omitted, captures the entire artwork.

Parameters
Parameter Type Description
imageFile File Image file to write to
clipBounds | Rect, optional Clipping bounds
options ImageCaptureOptions, optional | todo

Returns

Nothing.

59.2.16 Document.importCharacterStyles()

app.activeDocument.importCharacterStyles(fileSpec)
Description

Loads the character styles from the Illustrator file.

Parameters

Parameter | Type | Description

fileSpec | File File to load character styles from
Returns
Nothing.

59.2.17 Document.importParagraphStyles()

app.activeDocument.importParagraphStyles(fileSpec)
Description
Loads the paragraph styles from the Illustrator file.

Parameters

Parameter | Type | Description
fileSpec | File File to load paragraph styles from

Returns
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Nothing.

59.2.18 Document.importPDFPreset()

app.activeDocument .importPDFPreset (fileSpec [, replacingPreset])

Description

Loads all PDF presets from a file.

Parameters

Returns

Nothing.

Parameter Type Description
fileSpec File File to load PDF presets from
replacingPreset | String, optional | Whether to replace existing presets

59.2.19 Document.importPrintPreset()

app.activeDocument.importPrintPreset (printPreset, fileSpec)

Description

Loads the named print preset from the file.

Parameters

Returns

Nothing.

Parameter Type | Description
printPreset | String | Name of preset to load
fileSpec File File to load print presets from

59.2.20 Document.importVariables()

app.activeDocument.importVariables(fileSpec)

Description

Imports a library containing datasets, variables, and their associated dynamic data. Importing variables overwrites
existing variables and datasets.

Parameters

Parameter | Type

Description

fileSpec File

File to import variables from
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Returns

Nothing.

59.2.21 Document.print()

app.activeDocument.print([options])

Description
Prints the document.

Parameters

Returns

Nothing.

Parameter

Type

Description

options

PrintOptions, optional

todo

59.2.22 Document.rasterize()

app.activeDocument.rasterize(sourceArt [, clipBounds] [, options])

Description

Rasterizes the source art(s) within the specified clip bounds. The source art(s) is disposed of as a result of the rasteri-

zation.

Parameters

Returns

Rasterltem

Parameter Type Description
sourceArt Variable Source art to rasterize
clipBounds | Rect, optional Clipping bounds
options RasterizeOptions, optional | todo

59.2.23 Document.rearrangeArboards()

app.activeDocument.rearrangeArboards([artboardLayout] [, artboardRowsOrCols] [,

artboardSpacing] [, artboardMoveArtwork])

Description

Rearranges artboards in the document. All arguments are optional.

Default layout style is DocumentArtboard Layout.GridByRow.
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The second argument specifies the number of rows or columns, as appropriate for the chosen layout style, in the range
1. .docNumArtboards-1, or 1 (the default) for single row/column layouts.

Spacing is a number of pixels, default 20.

When last argument is true (the default), artwork is moved with the artboards.

Parameters
Parameter Type Description
artboardLayout DocumentArtboardLayout, optional | Artboard layout
artboardRowsOrCols Integer, optional Number of rows or columns
artboardSpacing Number, optional Number of pixels for spacing
artboardMoveArtwork | Boolean, optional Whether to move artwork with the artboards
Returns
Boolean.

59.2.24 Document.save()

app.activeDocument.save()
Description

Saves the document in it current location.
Returns

Nothing.

59.2.25 Document.saveAs()

app.activeDocument.saveAs(saveIn [, options])
Description

Saves the document in the specified file as an Illustrator, EPS, or PDF file.

Parameters
Parameter | Type Description
saveln File File to save the document as
options SaveOptions, optional | Save options to close with
Returns
Nothing.
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59.2.26 Document.saveNoUI()

app.activeDocument.saveNoUI(savelIn)

Description

Saves the non-UI document at the specified path

Parameters

Parameter | Type | Description

saveln File File to save the document as
Returns
Nothing.

59.2.27 Document.selectObjectsOnActiveArtboard()

app.activeDocument.selectObjectsOnActiveArtboard()

Description

Selects the objects on the currently active artboard. Returns true on success.

Returns

Boolean.

59.2.28 Document.setActivePlane()

app.activeDocument.setActivePlane(gridPlane)

Description

Sets the active plane of the active perspective grid of the document. Returns true on success.

Parameters

Parameter | Type

Description

gridPlane | PerspectiveGridPlaneType | Grid plane type

Returns

Boolean.
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59.2.29 Document.selectPerspectivePreset()

app.activeDocument.selectPerspectivePreset(gridType, presetName)

Description

Selects a predefined preset to define grid for the current document. Returns true on success.

Parameters

Returns

Boolean.

Parameter Type Description
gridType PerspectiveGridType | Grid type
presetName | String Preset name to select

59.2.30 Document.showPerspectiveGrid()

app.activeDocument . showPerspectiveGrid()

Description

Shows the current active grid for the document, or if no grid is active, shows the default grid. Returns true on success.

Returns

Boolean.

59.2.31 Document.windowCapture()

app.activeDocument .windowCapture(imageFile, windowSize)

Description

Captures the current document window to the target TIFF image file.

Parameters
Parameter Type Description
imageFile File Image file to save as
windowSize | Array of 2 numbers | Window size
Returns
Nothing.
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59.3 Example

59.3.1 Deselecting all objects in the current document

Note: The frontmost document can be referred to as either activeDocument or documents[0.

var docRef = activeDocument;
docRef.selection = null;

59.3.2 Closing a document

// Closes the active document without saving changes
if ( app.documents.length > 0 ) {
var aiDocument = app.activeDocument;
aiDocument.close( SaveOptions.DONOTSAVECHANGES );
aiDocument = null;

59.3.3 Creating a document with defaults

// Creates a new document if none exists then sets fill and stroke defaults to true
var doc;
if (app.documents.length == 0) {
doc = app.documents.add();
} else {
doc = app.activeDocument;

}

doc.defaultFilled = true;
doc.defaultStroked = true;
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SIXTY

DOCUMENTPRESET

documentPreset
Description

A preset document template to use when creating a new document. See Documents.addDocument().

60.1 Properties

60.1.1 DocumentPreset.artboardLayout

documentPreset.artboardLayout
Description
The layout of artboards in the new document. Default: GridByRow.

Type

DocumentArtboardLayout

60.1.2 DocumentPreset.artboardRowsOrCols

documentPreset.artboardRowsOrCols
Description

The number of rows (for rows layout) or columns (for column layout) of artboards. Range: 1 to (numArtboards - 1)
or 1 for single row or column layouts. Default: 1

Type
Number (long).
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60.1.3 DocumentPreset.artboardSpacing

documentPreset.artboardSpacing
Description
The spacing between artboards in the new document. Default: 20.0

Type
Number (double).

60.1.4 DocumentPreset.colorMode

documentPreset.colorMode
Description

The color space for the new document.
Type

DocumentColorSpace

60.1.5 DocumentPreset.documentBleedLink

documentPreset.documentBleedLink
Description

The document link for bleed values.

Type

Boolean.

60.1.6 DocumentPreset.documentBleedOffsetRect

documentPreset.documentBleedOffsetRect
Description

The document bleed offset rectangle.

Type

Rectangle.
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60.1.7 DocumentPreset.height

documentPreset.height
Description
The height in document points. Default: 792.0

Type
Number (double).

60.1.8 DocumentPreset.numArtboards

documentPreset.numArtboards

Description

The number of artboards for the new document. Range: 1 to 100. Default: 1.
Type

Number (long).

60.1.9 DocumentPreset.previewMode

documentPreset.previewMode
Description
The preview mode for the new document.

Type

DocumentPreviewMode

60.1.10 DocumentPreset.rasterResolution

documentPreset.rasterResolution
Description
The raster resolution for the new document.

Type

DocumentRasterResolution
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60.1.11 DocumentPreset.title

documentPreset.title
Description

The document title.

Type

String.

60.1.12 DocumentPreset.transparencyGrid

documentPreset.transparencyGrid

Description

The transparency grid color for the new document.

Type

DocumentTransparencyGrid

60.1.13 DocumentPreset.typename

documentPreset.typename
Description
The class name of the referenced object.

Type

String, read-only.

60.1.14 DocumentPreset.units

documentPreset.units
Description

The ruler units for the new document.
Type

RulerUnits
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60.1.15 DocumentPreset.width

documentPreset.width

Description

The width in document points. Default: 612.0
Type

Number (double).

60.1. Properties

285



lllustrator Scripting Guide, Release 0.0.1

286 Chapter 60. DocumentPreset



CHAPTER
SIXTYONE

app.documents
Description

A collection of Document objects.

DOCUMENTS

61.1 Properties

61.1.1 Documents.length

app.documents.length

Description

The number of objects in the collection.

Type

Number, read-only.

61.1.2 Documents.parent

app.documents.parent
Description

The parent of this object.
Type

Object, read-only.
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61.1.3 Documents.typename

app.documents.typename
Description

The class name of the referenced object.
Type

String, read-only.

61.2 Methods

61.2.1 Documents.add()

app.documents.add([documentColorSpace] [, width] [, height] [, numArtBoards]
[, artboardLayout] [, artboardSpacing] [, artboardRowsOrCols]
)

Description

Creates a new document using optional parameters and returns a reference to the new document.

Parameters
Parameter Type Description
documentColorSpace | DocumentColorSpace, optional Color space of document
width Number (double), optional Width of document to add
height Number (double), optional Height of document to add
numArtBoards Number (long), optional Number of artboards to create
artboardLayout DocumentArtboardLayout, optional | Artboard layout
artboardSpacing Number, optional Number of pixels for spacing
artboardRowsOrCols | Integer, optional Number of rows or columns

Returns

Document

61.2.2 Documents.addDocument()

app.documents.addDocument (startupPreset [, presetSettings] [, showOptionsDialog])
Description
Creates a document from the preset, replacing any provided setting values, and returns a reference to the new document.

Parameters
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Parameter Type Description

startupPreset String Startup preset to use
presetSettings DocumentPreset, optional | Preset document template
showOptionsDialog | Boolean, optional Whether to show options dialog

Returns

Document

61.2.3 Documents.addDocumentNoUI()

app.documents.addDocumentNoUI (startupPreset)

Description

Creates a document without showing in UL

Parameters

Parameter

Type

Description

startupPreset | String

Startup preset to use

Returns

Document

61.2.4 Documents.getByName()

app . documents.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Parameter

Type | Description

name

String | Name of element to get

Returns

Document

61.2. Methods
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61.2.5 Documents.index()

app.documents.index(itemKey)
Description
Gets an element from the collection.

Parameters

Parameter

Type

Description

itemKey

String, Number

String or number key

Returns

Document

61.3 Example

61.3.1 Creating a new document

// Creates a new document with an RGB color space

app.documents.add(DocumentColorSpace.RGB);
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SIXTYTWO

EPSSAVEOPTIONS

epsSaveOptions
Description
Options for saving a document as an Illustrator EPS file, used with the Document.saveAs() method.

All properties are optional.

62.1 Properties

62.1.1 EPSSaveOptions.artboardRange

epsSaveOptions.artboardRange
Description

If saveMultipleArtboards is true, this is considered for multi-asset extraction, which specifies the artboard range.
An empty string extracts all the artboards. Default: empty string

Type
String.

62.1.2 EPSSaveOptions.cmykPostScript

epsSaveOptions.cmykPostScript
Description

If true, use CMYK PostScript.

Type

Boolean.
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62.1.3 EPSSaveOptions.compatibility

epsSaveOptions.compatibility

Description

Specifies the version of the EPS file format to save.
Default: Compatibility.ILLUSTRATOR1719.
Type

Compatibility

62.1.4 EPSSaveOptions.compatibleGradientPrinting

epsSaveOptions.compatibleGradientPrinting

Description

If true, create a raster item of the gradient or gradient mesh so that PostScript Level 2 printers can print the object.
Default: false.

Type

Boolean.

62.1.5 EPSSaveOptions.embedAllFonts

epsSaveOptions.embedAllFonts

Description

If true, all fonts used by the document should be embedded in the saved file (version 7 or later).
Default: false.

Type

Boolean.

62.1.6 EPSSaveOptions.embedLinkedFiles

epsSaveOptions.embedLinkedFiles

Description

If true, linked image files are to be included in the saved document.
Type

Boolean.
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62.1.7 EPSSaveOptions.flattenOuput

epsSaveOptions.flattenOuput
Description
How should transparency be flattened for file formats older than Illustrator 9.

Type

OutputFlattening

62.1.8 EPSSaveOptions.includeDocumentThumbnails

epsSaveOptions.includeDocumentThumbnails

Description

If true, thumbnail image of the EPS artwork should be included.
Type

Boolean.

62.1.9 EPSSaveOptions.overprint

epsSaveOptions.overprint

Description

Whether to preserve, discard, or simulate the overprint.
Default: PDFOverprint . PRESERVEPDFOVERPRINT.
Type

PDFOverprint

62.1.10 EPSSaveOptions.postScript

epsSaveOptions.postScript

Description

PostScript Language Level to use (Level 1 valid for file format version 8 or older).
Default: EPSPostScriptLevelEnum.LEVEL2.

Type

EPSPostScriptLevel Enum
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62.1.11 EPSSaveOptions.preview

epsSaveOptions.preview
Description
The format for the EPS preview image.

Type
EPSPreview

62.1.12 EPSSaveOptions.saveMultipleArtboards

epsSaveOptions.saveMultipleArtboards
Description

If true, all artboards or range of artboards are saved.
Default: false.

Type

Boolean.

62.1.13 EPSSaveOptions.typename

epsSaveOptions.typename
Description

The class name of the referenced object.
Type

String, read-only.

62.2 Example

62.2.1 Exporting to EPS format

// Exports current document to destFile as an EPS file with specified options,
// destFile contains the full path including the file name

function exportFileAsEPS(destFile) {
var newFile = new File(destFile);
var saveDoc;
if (app.documents.length == 0) {
saveDoc = app.documents.add();
} else {

(continues on next page)
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(continued from previous page)

saveDoc = app.activeDocument;

}
var saveOpts = new ePSSaveOptions();
saveOpts.cmykPostScript = true;

saveOpts.embedAllFonts = true;

saveDoc.saveAs(newFile, saveOpts);
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EXPORTOPTIONSAUTOCAD

exportOptionsAutoCAD
Description

Options for exporting a document as an AutoCAD file, used with the Document.exportFile() method. All properties
are optional.

When you export a document, a file extension is appended automatically. You should not include any file extension in
the file specification.

To override the default AutoCAD export format (DWG), use the ExportOptionsAutoCAD.exportFileFormat property.

63.1 Properties

63.1.1 ExportOptionsAutoCAD.alterPathsForAppearance

exportOptionsAutoCAD.alterPathsForAppearance
Description

If true, paths are altered if needed to maintain appearance.
Default: false.

Type

Boolean.

63.1.2 ExportOptionsAutoCAD.colors

exportOptionsAutoCAD.colors
Description
The colors exported into the AutoCAD file.

Type
AutoCADColors
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63.1.3 ExportOptionsAutoCAD.convertTextToOutlines

exportOptionsAutoCAD. convertTextToOutlines

Description

If true, text is converted to vector paths; preserves the visual appearance of type.
Default: false.

Type

Boolean.

63.1.4 ExportOptionsAutoCAD.exportFileFormat

exportOptionsAutoCAD. exportFileFormat
Description

The format to which the file is exported.
Default: AutoCADExportFileFormat.DWG.
Type

AutoCADExportFileFormat

63.1.5 ExportOptionsAutoCAD.exportOption

exportOptionsAutoCAD. exportOption

Description

Specifies whether to preserve appearance or editability during export.
Default: AutoCADExportOption.MaximizeEditability.

Type
AutoCADExportOption

63.1.6 ExportOptionsAutoCAD.exportSelectedArtOnly

exportOptionsAutoCAD. exportSelectedArtOnly
Description

If true, only selected artwork is exported.

Default: false.

Type

Boolean.
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63.1.7 ExportOptionsAutoCAD.rasterFormat

exportOptionsAutoCAD.rasterFormat
Description
The format in which raster art is exported.

Type
AutoCADRasterFormat

63.1.8 ExportOptionsAutoCAD.scaleLineweights

exportOptionsAutoCAD.scalelLineweights

Description

If true, line weights are scaled by the same scaling factor as the rest of the drawing.

Default: false.
Type

Boolean.

63.1.9 ExportOptionsAutoCAD.typename

exportOptionsAutoCAD. typename
Description
The class name of the referenced object.

Type

String, read-only.

63.1.10 ExportOptionsAutoCAD.unit

exportOptionsAutoCAD.unit
Description

The measurement units from which to map.
Type

AutoCADUnit

63.1. Properties
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63.1.11 ExportOptionsAutoCAD.unitScaleRatio

exportOptionsAutoCAD.unitScaleRatio
Description

The ratio (as a percentage) by which output is scaled.
Range: 0 to 1000

Type

Number (double).

63.1.12 ExportOptionsAutoCAD.version

exportOptionsAutoCAD.version
Description

The release of AutoCAD to which the file is exported.

Default: AutoCADCompatibility.AutoCADRelease24.

Type
AutoCADCompatibility
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exportOptionsFlash
Description

Options for exporting a document as a Macromedia® Flash® (SWF) file, used with the Document.exportFile() method.
All properties are optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

64.1 Properties

64.1.1 ExportOptionsFlash.artClipping

exportOptionsFlash.artClipping
Description
How the art should be clipped during output. Default: ArtClippingOption.OUTPUTARTBOUNDS.

Type
ArtClippingOption

64.1.2 ExportOptionsFlash.artboardRange

exportOptionsFlash.artboardRange
Description

If saveMultipleArtboards is true, this is considered for multi-asset extraction, which specifies the artboard range.
An empty string extracts all the artboards. Default: empty String.

Type
String.
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64.1.3 ExportOptionsFlash.backgroundColor

exportOptionsFlash.backgroundColor
Description

The background color of the exported Flash frames.
Type

RGBColor

64.1.4 ExportOptionsFlash.backgroundLayers

exportOptionsFlash.backgroundLayers
Description
A list of layers to be included as the static background of the exported Flash frames.

Type

Array of Layers

64.1.5 ExportOptionsFlash.blendAnimation

exportOptionsFlash.blendAnimation

Description

The animation type for blended objects. Default: BlendAnimationType . NOBLENDANIMATION.
Type

BlendAnimationType

64.1.6 ExportOptionsFlash.compressed

exportOptionsFlash.compressed
Description
If true, the exported file should be exported compressed. Default: false.

Type

Boolean.
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64.1.7 ExportOptionsFlash.convertTextToOutlines

exportOptionsFlash.convertTextToOutlines
Description

If true, all text is converted to vector paths; preserves the visual appearance of type in all Flash players. Default:
false.

Type

Boolean.

64.1.8 ExportOptionsFlash.curveQuality

exportOptionsFlash.curveQuality
Description
The amount of curve information that should be presented. Default: 7.

Type
Number (long).

64.1.9 ExportOptionsFlash.exportAllSymbols

exportOptionsFlash.exportAllSymbols

Description

If true, export all symbols defined in the palette. Default: false.
Type

Boolean.

64.1.10 ExportOptionsFlash.exportStyle

exportOptionsFlash.exportStyle

Description

The style in which the exported data should be created in Flash. Default: FlashExportStyle.ASFLASHFILE.
Type

FlashExportStyle
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64.1.11 ExportOptionsFlash.exportVersion

exportOptionsFlash.exportVersion

Description

The version of the exported SWF file. Default: FlashExportVersion.FlashVersion9.
Type

FlashExportVersion

64.1.12 ExportOptionsFlash.frameRate

exportOptionsFlash. frameRate

Description

The display rate in frames per second. Range: 0.01-120.0. Default: 12.0.
Type

Number (double).

64.1.13 ExportOptionsFlash.ignoreTextKerning

exportOptionsFlash.ignoreTextKerning

Description

If true, ignore kerning information in text objects. Default: false.
Type

Boolean.

64.1.14 ExportOptionsFlash.imageFormat

exportOptionsFlash.imageFormat

Description

How should the image in the exported Flash file be compressed. Default: FlashImageFormat.LOSSLESS.
Type

FlashlmageFormat
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64.1.15 ExportOptionsFlash.includeMetadata

exportOptionsFlash.includeMetadata

Description

If true, include minimal XMP metadata in the SWF file. Default: false.
Type

Boolean.

64.1.16 ExportOptionsFlash.jpegMethod

exportOptionsFlash. jpegMethod
Description
Specifies the JPEG method to use. Default: FlashJPEGMethod. Standard.

Type
FlashJPEGMethod

64.1.17 ExportOptionsFlash.jpegQuality

exportOptionsFlash. jpegQuality
Description
Level of compression to use. Range 1 to 10. Default: 3.

Type
Number (long).

64.1.18 ExportOptionsFlash.layerOrder

exportOptionsFlash.layerOrder

Description

The order in which layers are exported to Flash frames. Default: LayerOrderType .BOTTOMUP.
Type

LayerOrderType

64.1. Properties
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64.1.19 ExportOptionsFlash.looping

exportOptionsFlash.looping

Description

If true, the Flash file is set to loop when run. Default: false.
Type

Boolean.

64.1.20 ExportOptionsFlash.playbackAccess

exportOptionsFlash.playbackAccess
Description
The access level for the exported SWF file. Default: FlashPlaybackSecurity.PlaybackLocal.

Type
FlashPlaybackSecurity

64.1.21 ExportOptionsFlash.preserveAppearance

exportOptionsFlash.preserveAppearance
Description
If true, preserve appearance. If false, preserve editability. Default: false.

Type

Boolean.

64.1.22 ExportOptionsFlash.readOnly

exportOptionsFlash.readOnly

Description

If true, export as read-only file. Default: false.
Type

Boolean.
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64.1.23 ExportOptionsFlash.replacing

exportOptionsFlash.replacing

Description

If a file with the same name already exists, should it be replaced. Default: SaveOptions.PROMPTTOSAVECHANGES.

Type

SaveOptions

64.1.24 ExportOptionsFlash.resolution

exportOptionsFlash.resolution

Description

The resolution in pixels per inch. Range: 72-2400. Default: 72.
Type

Number (double).

64.1.25 ExportOptionsFlash.saveMultipleArtboards

exportOptionsFlash.saveMultipleArtboards

Description

If true, all artboards or range of artboards are saved. Default: false.
Type

Boolean.

64.1.26 ExportOptionsFlash.typename

exportOptionsFlash. typename
Description

The class name of the referenced object.
Type

String, read-only.

64.1. Properties
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64.2 Example

64.2.1 Exporting to Flash format

// Exports current document to destFile as a flash file with specified options,
// destFile contains the full path including the file name

function exportToFlashFile(destFile) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsFlash();
exportOptions.resolution = 150;

var type = ExportType.FLASH;
var fileSpec = new File(destFile);

app.activeDocument .exportFile(fileSpec, type, exportOptions);

}
}
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EXPORTOPTIONSGIF

exportOptionsGIF
Description

Options for exporting a document as a GIF file, used with the Document.exportFile() method. All properties are
optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

65.1 Properties

65.1.1 ExportOptionsGlIF.antiAliasing

exportOptionsGIF.antiAliasing
Description
If true, the exported image should be anti-aliased. Default: true.

Type

Boolean.

65.1.2 ExportOptionsGlIF.artBoardClipping

exportOptionsGIF.artBoardClipping

Description

If true, the exported image should be clipped to the art board. Default: false.
Type

Boolean.
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65.1.3 ExportOptionsGIF.colorCount

exportOptionsGIF.colorCount

Description

The number of colors in the exported image’s color table. Range: 2 to 256. Default: 128.
Type

Number (long).

65.1.4 ExportOptionsGIF.colorDither

exportOptionsGIF.colorDither
Description
The method used to dither colors in the exported image. Default: ColorDitherMethod.DIFFUSION.

Type
ColorDitherMethod

65.1.5 ExportOptionsGIF.colorReduction

exportOptionsGIF.colorReduction
Description

The method used to reduce the number of colors in the exported image. Default: ColorReductionMethod.
SELECTIVE.

Type
ColorReductionMethod

65.1.6 ExportOptionsGIF.ditherPercent

exportOptionsGIF.ditherPercent

Description

How much should the colors of the exported image be dithered, where 100.0 is 100%.
Type

Number (long).
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65.1.7 ExportOptionsGIF.horizontalScale

exportOptionsGIF.horizontalScale

Description

The horizontal scaling factor to apply to the exported image, where 100.0 is 100%. Default: 100.0.
Type

Number (double).

65.1.8 ExportOptionsGlIF.infoLossPercent

exportOptionsGIF.infoLossPercent

Description

The level of information loss allowed during compression, where 100.0 is 100%.
Type

Number (long).

65.1.9 ExportOptionsGliF.interlaced

exportOptionsGIF.interlaced
Description
If true, the exported image should be interlaced. Default: false.

Type

Boolean.

65.1.10 ExportOptionsGIF.matte

exportOptionsGIF.matte
Description
If true, the art board should be matted with a color. Default: true.

Type

Boolean.

65.1. Properties
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65.1.11 ExportOptionsGIF.matteColor

exportOptionsGIF.matteColor

Description

The color to use when matting the art board. Default: WHITE.
Type

RGBColor

65.1.12 ExportOptionsGlIF.saveAsHTML

exportOptionsGIF.saveAsHTML
Description
If true, the exported image should be saved with an accompanying HTML file. Default: false.

Type

Boolean.

65.1.13 ExportOptionsGIF.transparency

exportOptionsGIF. transparency

Description

If true, the exported image should use transparency. Default: true.
Type

Boolean.

65.1.14 ExportOptionsGIF.typename

exportOptionsGIF.typename
Description

The class name of the referenced object.
Type

String, read-only.
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65.1.15 ExportOptionsGlIF.verticalScale

exportOptionsGIF.verticalScale
Description
The vertical scaling factor to apply to the exported image, where 100.0 is 100%. Default: 100.0.

Type
Number (double).

65.1.16 ExportOptionsGIF.webSnap

exportOptionsGIF.webSnap

Description

Howmuchshouldthecolortablebechangedtomatch the web palette, where 100 is maximum. Default: 0.
Type

Number (long).

65.2 Example

65.2.1 Exporting to GIF format

// Exports current document to dest as a GIF file with specified options,
// dest contains the full path including the file name

function exportToGIFFile(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsGIF(Q);
exportOptions.antiAliasing = false;
exportOptions.colorCount = 64;
exportOptions.colorDither = ColorDitherMethod.DIFFUSION;

var type = ExportType.GIF;
var fileSpec = new File(dest);

app.activeDocument .exportFile(fileSpec, type, exportOptions);
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SIXTYSIX

exportOptionsJPEG

Description

EXPORTOPTIONSJPEG

Options for exporting a document as a JPEG file, used with the Document.exportFile() method. All properties are

optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file

extension in the file specification.

66.1 Properties

66.1.1 ExportOptionsJPEG.antiAliasing

exportOptionsJPEG.antiAliasing

Description

If true, the exported image should be anti-aliased. Default: true.

Type

Boolean.

66.1.2 ExportOptionsJPEG.artBoardClipping

exportOptionsJPEG. artBoardClipping

Description

If true, the exported image should be clipped to the art board.
Type

Boolean.
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66.1.3 ExportOptionsJPEG.blurAmount

exportOptionsJPEG.blurAmount

Description

The amount of blur to apply to the exported image. Range: 0.0 to 2.0. Default: 0.0.
Type

Number (double).

66.1.4 ExportOptionsJPEG.horizontalScale

exportOptionsJPEG.horizontalScale

Description

The horizontal scaling factor to apply to the exported image, where 100.0 is 100%. Default: 100.0.

Type
Number (double).

66.1.5 ExportOptionsJPEG.matte

exportOptionsJPEG.matte
Description
If true, the art board should be matted with a color. Default: true.

Type

Boolean.

66.1.6 ExportOptionsJPEG.matteColor

exportOptionsJPEG.matteColor

Description

The color to use when matting the art board. Default: white.
Type

RGBColor
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66.1.7 ExportOptionsJPEG.optimization

exportOptionsJPEG.optimization

Description

If true, the exported image should be optimized for web viewing. Default: true.
Type

Boolean.

66.1.8 ExportOptionsJPEG.qualitySetting

exportOptionsJPEG.qualitySetting
Description
The quality of the exported image. Range: 0 to 100. Default: 30.

Type
Number (long).

66.1.9 ExportOptionsJPEG.saveAsHTML

exportOptionsJPEG. saveAsHTML

Description

If true, the exported image should be saved with an accompanying HTML file. Default: false.
Type

Boolean.

66.1.10 ExportOptionsJPEG.typename

exportOptionsJPEG. typename
Description
The class name of the referenced object.

Type

String, read-only.

66.1. Properties
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66.1.11 ExportOptionsJPEG.verticalScale

exportOptions]JPEG.verticalScale
Description
The vertical scaling factor to apply to the exported image. Range: 0.0 to 776.19. Default: 100.0.

Type
Number (double)

66.2 Example

66.2.1 Exporting to JPEG format

// Exports current document to dest as a JPEG file with specified options,
// dest contains the full path including the file name

function exportFileToJPEG(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsJPEG(Q);
exportOptions.antiAliasing = false;
exportOptions.qualitySetting = 70;

var type = ExportType.JPEG;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);
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EXPORTOPTIONSPHOTOSHOP

exportOptionsPhotoshop
Description

Options for exporting a document as a Photoshop file, used with the Document.exportFile() method. All properties are
optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

67.1 Properties

67.1.1 ExportOptionsPhotoshop.antiAliasing

exportOptionsPhotoshop.antiAliasing
Description
If true, the exported image should be anti-aliased. Default: true.

Type

Boolean.

67.1.2 ExportOptionsPhotoshop.artboardRange

exportOptionsPhotoshop.artboardRange
Description

If saveMultipleArtboards is true, this is considered for multi-asset extraction, which specifies the artboard range.
An empty string extracts all the artboards. Default: empty String.

Type
String.
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67.1.3 ExportOptionsPhotoshop.editableText

exportOptionsPhotoshop.editableText

Description

If true, text objects should be exported as editable text layers. Default: true.
Type

Boolean.

67.1.4 ExportOptionsPhotoshop.embedICCProfile

exportOptionsPhotoshop.embedICCProfile

Description

If true, an ICC profile should be embedded in the exported file. Default: false.
Type

Boolean.

67.1.5 ExportOptionsPhotoshop.imageColorSpace

exportOptionsPhotoshop.imageColorSpace

Description

The color space of the exported file. Default: ImageColorSpace.RGB.
Type

ImageColorSpace

67.1.6 ExportOptionsPhotoshop.maximumEditability

exportOptionsPhotoshop.maximumEditability

Description

Preserve as much of the original document’s structure as possible when exporting. Default: true.
Type

Boolean.
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67.1.7 ExportOptionsPhotoshop.resolution

exportOptionsPhotoshop.resolution

Description

Resolution of the exported file in dots per inch (dpi). Range: 72.0 to 2400.0. Default: 150.0.

Type
Number (double).

67.1.8 ExportOptionsPhotoshop.saveMultipleArtboards

exportOptionsPhotoshop.saveMultipleArtboards
Description

If true, all artboards or range of artboards are saved. Default: false.
Type

Boolean.

67.1.9 ExportOptionsPhotoshop.typename

exportOptionsPhotoshop.typename
Description
The class name of the referenced object.

Type

String, read-only.

67.1.10 ExportOptionsPhotoshop.warnings

exportOptionsPhotoshop.warnings

Description

If true, a warning dialog should be displayed in case of conflicts in the export settings. Default: true.

Type

Boolean.

67.1. Properties
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67.1.11 ExportOptionsPhotoshop.writeLayers

exportOptionsPhotoshop.writelLayers
Description
If true, the document layers should be presented in the exported document. Default: true.

Type

Boolean.

67.2 Example

67.2.1 Exporting to Photoshop format

// Exports current document to dest as a PSD file with specified options,
// dest contains the full path including the file name

function exportFileToPSD(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsPhotoshop();
exportOptions.resolution = 150;

var type = ExportType.PHOTOSHOP;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);
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EXPORTOPTIONSPNG24

exportOptionsPNG24
Description

Options for exporting a document as a 24-bit PNG file, used with the Document.exportFile() method. All properties
are optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

68.1 Properties

68.1.1 ExportOptionsPNG24.antiAliasing

exportOptionsPNG24.antiAliasing
Description
If true, the exported image be anti-aliased. Default: true.

Type

Boolean.

68.1.2 ExportOptionsPNG24.artBoardClipping

exportOptionsPNG24.artBoardClipping

Description

If true, the exported image be clipped to the art board. Default: false.
Type

Boolean.
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68.1.3 ExportOptionsPNG24.horizontalScale

exportOptionsPNG24.horizontalScale

Description

The horizontal scaling factor to apply to the exported image, where 100.0 is 100%. Default: 100.0.

Type
Number (double).

68.1.4 ExportOptionsPNG24.matte

exportOptionsPNG24.matte

Description

If true, the art board be matted with a color. Default: true.
Type

Boolean.

68.1.5 ExportOptionsPNG24.matteColor

exportOptionsPNG24.matteColor

Description

The color to use when matting the art board. Default: white.

Type
RGBColor

68.1.6 ExportOptionsPNG24.saveAsHTML

exportOptionsPNG24.saveAsHTML

Description

If true, the exported image be saved with an accompanying HTML file. Default: false.

Type

Boolean.
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68.1.7 ExportOptionsPNG24.transparency

exportOptionsPNG24.transparency
Description
If true, the exported image use transparency. Default: true.

Type

Boolean.

68.1.8 ExportOptionsPNG24.typename

exportOptionsPNG24.typename
Description
The class name of the referenced object.

Type
String, read-only.

68.1.9 ExportOptionsPNG24.verticalScale

exportOptionsPNG24.verticalScale
Description
The vertical scaling factor to apply to the exported image, where 100.0 is 100. Default: 100.0.

Type
Number (double).

68.2 Example

68.2.1 Exporting to PNG24 format

// Exports current document to dest as a PNG24 file with specified options,
// dest contains the full path including the file name,
// saveAsHTML option creates an HTML version with the PNG file in an images folder

function exportFileToPNG24(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsPNG24();
exportOptions.antiAliasing = false;
exportOptions.transparency = false;
exportOptions.saveAsHTML = true;

(continues on next page)
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(continued from previous page)

var type = ExportType.PNG24;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);
}
}
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CHAPTER
SIXTYNINE

EXPORTOPTIONSPNGS

exportOptionsPNG8
Description

Options for exporting a document as an 8-bit PNG file, used with the Document.exportFile() method. All properties
are optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

69.1 Properties

69.1.1 ExportOptionsPNGS8.antiAliasing

exportOptionsPNG8.antiAliasing
Description
If true, the exported image should be anti-aliased. Default: true.

Type

Boolean.

69.1.2 ExportOptionsPNGS8.artBoardClipping

exportOptionsPNG8.artBoardClipping

Description

If true, the exported image should be clipped to the art board. Default: false.
Type

Boolean.
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69.1.3 ExportOptionsPNG8.colorCount

exportOptionsPNG8.colorCount

Description

The number of colors in the exported image’s color table. Range: 2 to 256. Default: 128.
Type

Number (long).

69.1.4 ExportOptionsPNG8.colorDither

exportOptionsPNGS8.colorDither
Description
The method used to dither colors in the exported image. Default: ColorDitherMethod.Diffusion.

Type
ColorDitherMethod

69.1.5 ExportOptionsPNGS8.colorReduction

exportOptionsPNG8.colorReduction
Description

The method used to reduce the number of colors in the exported image. Default: ColorReductionMethod.
SELECTIVE.

Type
ColorReductionMethod

69.1.6 ExportOptionsPNGS8.ditherPercent

exportOptionsPNG8.ditherPercent
Description

The amount (as a percentage) that the colors of the exported image are dithered, where 100.0 is 100%. Range: O to
100. Default: 88.

Type
Number (long).
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69.1.7 ExportOptionsPNG8.horizontalScale

exportOptionsPNG8.horizontalScale

Description

The horizontal scaling factor to apply to the exported image, where 100.0 is 100%. Default: 100.0.
Type

Number (double).

69.1.8 ExportOptionsPNG8.interlaced

exportOptionsPNG8.interlaced

Description

If true, the exported image should be interlaced. Default: false.
Type

Boolean.

69.1.9 ExportOptionsPNG8.matte

exportOptionsPNG8.matte
Description
If true, the art board should be matted with a color. Default: true.

Type

Boolean.

69.1.10 ExportOptionsPNG8.matteColor

exportOptionsPNG8.matteColor
Description
The color to use when matting the art board. Default: white.

Type
RGBColor

69.1. Properties
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69.1.11 ExportOptionsPNG8.saveAsHTML

exportOptionsPNG8.saveAsHTNML

Description

If true, the exported image be saved with an accompanying HTML file. Default: false.

Type

Boolean.

69.1.12 ExportOptionsPNG8.transparency

exportOptionsPNG8.transparency

Description

If true, the exported image use transparency. Default: true.

Type

Boolean.

69.1.13 ExportOptionsPNG8.typename

exportOptionsPNG8. typename
Description

The class name of the referenced object.
Type

String, read-only.

69.1.14 ExportOptionsPNG8.verticalScale

exportOptionsPNG8.verticalScale

Description

The vertical scaling factor to apply to the exported image, where 100.0 is 100. Default: 100.0.

Type
Number (double).
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69.1.15 ExportOptionsPNG8.webSnap

exportOptionsPNG8.webSnap

Description

Specifies how much the color table should be changed to match the web palette, where 100 is maximum. Default: 0.

Type
Number (long).

69.2 Example

69.2.1 Exporting to PNG8 format

// Exports current document to dest as a PNG8 file with specified options,
// dest contains the full path including the file name

function exportFileToPNG8(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsPNG8();
exportOptions.colorCount = 8;
exportOptions.transparency = false;

var type = ExportType.PNGS;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);

69.2. Example
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CHAPTER
SEVENTY

EXPORTOPTIONSSVG

exportOptionsSVG
Description

Options for exporting a document as a SVG file, used with the Document.exportFile() method. All properties are
optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

70.1 Properties

70.1.1 ExportOptionsSVG.artboardRange

exportOptionsSVG. artboardRange
Description

A range of artboards to save, if saveMultipleArtboards is true. A comma-delimited list of artboard names., or
the empty string to save all artboards. Default: empty String.

Type
String.

70.1.2 ExportOptionsSVG.compressed

exportOptionsSVG. compressed

Description

If true, the exported file should be compressed. Default: false.
Type

Boolean.
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70.1.3 ExportOptionsSVG.coordinatePrecision

exportOptionsSVG. coordinatePrecision

Description

The decimal precision for element coordinate values. Range: 1 to 7. Default: 3.
Type

Number (long)

70.1.4 ExportOptionsSVG.cssProperties

exportOptionsSVG.cssProperties

Description

How the CSS properties of the document should be included in the exported file.

SVGCSSPropertyLocation.STYLEATTRIBUTES.

Type
SVGCSSPropertyLocation

Default:

70.1.5 ExportOptionsSVG.documentEncoding

exportOptionsSVG.documentEncoding
Description
How the text in the document should be encoded. Default: SVGDocumentEncoding.ASCII.

Type
SVGDocumentEncoding

70.1.6 ExportOptionsSVG.DTD

exportOptionsSVG.DTD

Description

The SVG version to which the file should conform. Default: SVGDTDVersion.SVG1_1.
Type

SVGDTDVersion
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70.1.7 ExportOptionsSVG.embedRasterimages

exportOptionsSVG. embedRasterImages

Description

If true, the raster images contained in the document should be embedded in the exported file. Default: false.
Type

Boolean.

70.1.8 ExportOptionsSVG.fontSubsetting

exportOptionsSVG. fontSubsetting
Description
Which font glyphs should be included in the exported file. Default: SVGFontSubsetting.ALLGLYPHS.

Type
SVGFontSubsetting

70.1.9 ExportOptionsSVG.fontType

exportOptionsSVG. fontType
Description
The type of font to included in the exported file. Default: SVGFontType .CEFFONT.

Type
SVGFontType

70.1.10 ExportOptionsSVG.includeFilelnfo

exportOptionsSVG.includeFileInfo
Description
If true, file information should be saved in the exported file. Default: false.

Type

Boolean.
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70.1.11 ExportOptionsSVG.includeUnusedStyles

exportOptionsSVG.includeUnusedStyles

Description

If true, save unused styles in the exported file. Default: false.
Type

Boolean.

70.1.12 ExportOptionsSVG.includeVariablesAndDatasets

exportOptionsSVG.includeVariablesAndDatasets
Description
If true, variables and datasets should be saved in the exported file. Default: false.

Type

Boolean.

70.1.13 ExportOptionsSVG.optimizeForSVGViewer

exportOptionsSVG.optimizeForSVGViewer

Description

If true, the exported file should be optimized for the SVG Viewer. Default: false.
Type

Boolean.

70.1.14 ExportOptionsSVG.preserveEditability

exportOptionsSVG.preserveEditability
Description
If true, llustrator editing capabilities should be preserved when exporting the document. Default: false.

Type

Boolean.
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70.1.15 ExportOptionsSVG.saveMultipleArtboards

exportOptionsSVG.saveMultipleArtboards

Description

If true, save the artboards specified by artboardRange in the exported file. Default: false.

Type

Boolean.

70.1.16 ExportOptionsSVG.slices

exportOptionsSVG.slices
Description
If true, slice data should be exported with the file. Default: false.

Type

Boolean.

70.1.17 ExportOptionsSVG.sVGAutoKerning

exportOptionsSVG. sVGAutoKerning

Description

If true, SVG automatic kerning is allowed in the file. Default: false.
Type

Boolean.

70.1.18 ExportOptionsSVG.sVGTextOnPath

exportOptionsSVG. sVGTextOnPath

Description

If true, the SVG text-on-path construct is allowed in the file. Default: false.

Type

Boolean.

70.1. Properties
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70.1.19 ExportOptionsSVG.typename

exportOptionsSVG. typename
Description
The class name of the referenced object.

Type

String, read-only.

70.2 Example

70.2.1 Exporting to SVG format

// Exports current document to dest as an SVG file with specified options,
// dest contains the full path including the file name

function exportFileToSVG(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsSVG(Q);
exportOptions.embedRasterImages = true;
exportOptions.embedAllFonts = false;
exportOptions. fontSubsetting = SVGFontSubsetting.GLYPHSUSED;

var type = ExportType.SVG;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);
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CHAPTER
SEVENTYONE

EXPORTOPTIONSTIFF

exportOptionsTIFF
Description

Options for exporting a document as a TIFF file, used with the Document.exportFile() method. All properties are
optional.

When you export a document, the appropriate file extension is appended automatically. You should not include any file
extension in the file specification.

71.1 Properties

71.1.1 ExportOptionsTIFF.antiAliasing

exportOptionsTIFF.antiAliasing
Description
If true, the exported image should be anti-aliased. Default: true.

Type

Boolean.

71.1.2 ExportOptionsTIFF.artboardRange

exportOptionsTIFF.artboardRange
Description

If saveMultipleArtboards is true, this is considered for multi-asset extraction, which specifies the artboard range.
An empty string extracts all the artboards. Default: empty String.

Type
String.
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71.1.3 ExportOptionsTIFF.byteOrder

exportOptionsTIFF.byteOrder
Description

The byte order to use in the new file.
Type

TIFFByteOrder

71.1.4 ExportOptionsTIFF.imageColorSpace

exportOptionsTIFF.imageColorSpace

Description

The color space of the exported file. Default: ImageColorSpace.RGB.

Type

ImageColorSpace

71.1.5 ExportOptionsTIFF.IZWCompression

exportOptionsTIFF.IZWCompression
Description

If true, use IZW compression in the new file.
Type

Boolean.

71.1.6 ExportOptionsTIFF.resolution

exportOptionsTIFF.resolution

Description

Resolution of the exported file in dots per inch (dpi). Range: 72.0 to 2400.0. Default: 150.0.

Type
Number (double).
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71.1.7 ExportOptionsTIFF.saveMultipleArtboards

exportOptionsTIFF.saveMultipleArtboards
Description
If true, all artboards or range of artboards are saved. Default: false.

Type
Number (double).

71.2 Example

71.2.1 Exporting to TIFF format

// Exports current document to dest as a TIFF file with specified options,
// dest contains the full path including the file name

function exportFileToPSD(dest) {
if (app.documents.length > 0) {
var exportOptions = new ExportOptionsTIFF();
exportOptions.resolution = 150;
exportOptions.byteOrder = TIFFByteOrder.IBMPC;
exportOptions.IZWCompression = false;

var type = ExportType.TIFF;
var fileSpec = new File(dest);

app.activeDocument.exportFile(fileSpec, type, exportOptions);

71.2. Example
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CHAPTER
SEVENTYTWO

FXGSAVEOPTIONS

fxgSaveOptions
Description

Specifies options which may be supplied when saving a document as an FXG file. All properties are optional.

72.1 Properties

72.1.1 FXGSaveOptions.artboardRange

fxgSaveOptions.artboardRange
Description

If saveMultipleArtboards is true, this is considered for multi-asset extraction, which specifies the artboard range. An
empty string extracts all the artboards. Default: empty String.

Type
String.

72.1.2 FXGSaveOptions.blendsPolicy

fxgSaveOptions.blendsPolicy
Description
The policy used by FXG to expand blends. Default: BlendsExpandPolicy.AUTOMATICALLYCONVERTBLENDS.

Type
BlendsExpandPolicy
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72.1.3 FXGSaveOptions.downsampleLinkedimages

fxgSaveOptions.downsamplelLinkedImages

Description

If true, linked images are downsampled (at 72 dpi). Default: false.
Type

Boolean.

72.1.4 FXGSaveOptions.filtersPolicy

fxgSaveOptions.filtersPolicy

Description

The policy used by FXG to preserve filters. Default: FiltersPreservePolicy.KEEPFILTERSEDITABLE.

Type

FiltersPreservePolicy

72.1.5 FXGSaveOptions.gradientsPolicy

fxgSaveOptions.gradientsPolicy

Description

The policy wused by FXG to preserve gradients. Default:

AUTOMATICALLYCONVERTGRADIENTS.
Type

GradientsPreservePolicy

GradientsPreservePolicy.

72.1.6 FXGSaveOptions.includeUnusedSymbols

fxgSaveOptions.includeUnusedSymbols
Description

If true, unused symbols are included. Default: false.
Type

Boolean.
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72.1.7 FXGSaveOptions.preserveEditingCapabilities

fxgSaveOptions.preserveEditingCapabilities

Description

If true, the editing capabilities of FXG are preserved. Default: true.
Type

Boolean.

72.1.8 FXGSaveOptions.saveMultipleArtboards

fxgSaveOptions.saveMultipleArtboards
Description
If true, all artboards or range of artboards are saved. Default: false.

Type

Boolean.

72.1.9 FXGSaveOptions.textPolicy

fxgSaveOptions.textPolicy

Description

The policy used by FXG to preserve text. Default: TextPreservePolicy.AUTOMATICALLYCONVERTTEXT.
Type

TextPreservePolicy

72.1.10 FXGSaveOptions.version

fxgSaveOptions.version

Description

The version of the FXG file format to create. Default FXGVersion.VERSION2PT®.
Type

FXGVersion
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CHAPTER
SEVENTYTHREE

GRADIENT

gradient
Description

A gradient definition contained in a document. Scripts can create new gradients.

73.1 Properties

73.1.1 Gradient.gradientStops

gradient.gradientStops
Description
The gradient stops contained in this gradient.

Type

GradientStops, read-only.

73.1.2 Gradient.name

gradient.name
Description

The gradient’s name.
Type

String.
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73.1.3 Gradient.parent

gradient.parent

Description

The document that contains this gradient.
Type

Document, read-only.

73.1.4 Gradient.type

gradient.type
Description
The kind of the gradient, either radial or linear.

Type

GradientType

73.1.5 Gradient.typename

gradient.typename
Description
The class name of the referenced object.

Type

String, read-only.

73.2 Methods

73.2.1 Gradient.remove()

app.activeDocument.gradients[index] .remove()
Description

Removes the referenced object from the document.
Returns

Nothing.
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73.3 Example

73.3.1 Creating and applying a gradient

// Creates a new gradient in current document then applies the gradient to the frontmost.,
—path item

if (app.documents.length > 0) {
// Create a color for both ends of the gradient
var startColor = new RGBColor();
startColor.red 0;
startColor.green = 100;
startColor.blue = 255;

var endColor = new RGBColor();
endColor.red = 220;
endColor.green = 0;
endColor.blue = 100;

// Create a new gradient

// A new gradient always has 2 stops

var newGradient = app.activeDocument.gradients.add();
newGradient.name = "NewGradient";

newGradient.type = GradientType.LINEAR;

// Modify the first gradient stop
newGradient.gradientStops[0].rampPoint = 30;
newGradient.gradientStops[0].midPoint = 60;
newGradient.gradientStops[0].color = startColor;

// Modify the last gradient stop
newGradient.gradientStops[1].rampPoint = 80;
newGradient.gradientStops[1].color = endColor;

// construct an Illustrator.GradientColor object referring to the newly created.
—gradient

var colorOfGradient = new GradientColor();

colorOfGradient.gradient = newGradient;

// get first path item, apply new gradient as its fill
var topPath = app.activeDocument.pathItems[0];
topPath.filled = true;

topPath.fillColor = colorOfGradient;
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CHAPTER
SEVENTYFOUR

app.activeDocument.gradients

Description

A collection of Gradient objects in a document.

GRADIENTS

74.1 Properties

74.1.1 Gradients.length

app.activeDocument.gradients.length
Description
The number of objects in the collection.

Type

Number, read-only.

74.1.2 Gradients.parent

app.activeDocument.gradients.parent
Description

The parent of this object.

Type

Object, read-only.
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74.1.3 Gradients.typename

app.activeDocument.gradients.typename
Description

The class name of the referenced object.

Type

String, read-only.

74.2 Methods

74.2.1 Gradients.add()

app.activeDocument.gradients.add()
Description

Creates a new Gradient object.

Returns

Gradient

74.2.2 Gradients.getByName()

app.activeDocument.gradients.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters
Parameter | Type | Description
name String | Name of element to get
Returns
Gradient
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74.2.3 Gradients.index()

app.activeDocument.gradients.index(itemKey)

Description

Gets an element from the collection.

Type

Description

String, Number

String or number key

Parameters
Parameter
itemKey
Returns
Gradient

74.2.4 Gradients.removeAll()

app.activeDocument.gradients.removeAll()

Description
Deletes all elements in this collection.
Returns

Nothing.

74.3 Example

74.3.1 Removing a gradient

// Deletes the first gradient from the current document

if (app.documents.length > 0) {

app.activeDocument.gradients[0].remove();

}

74.3. Example
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CHAPTER
SEVENTYFIVE

GRADIENTSTOP

app.activeDocument.gradients[index].gradientStops[index
Description

A gradient stop definition that represents a point on a specific gradient defined in the document. Each gradient stop
specifies a color change in the containing gradient. See Changing a gradient stop color for an example.

75.1 Properties

75.1.1 GradientStop.color

app.activeDocument.gradients[index].gradientStops[index].color
Description

The color linked to this gradient stop.

Type

Color

75.1.2 GradientStop.midPoint

app.activeDocument.gradients[index] .gradientStops[index].midPoint
Description
The midpoint key value, specified as a percentage from 13.0 to 87.0.

Type
Number (double).
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75.1.3 GradientStop.opacity

app.activeDocument.gradients[index].gradientStops[index].opacity
Description

The opacity value for the gradient stop. Range: 0.0 to 100.0

Type

Number (double).

75.1.4 GradientStop.parent

app.activeDocument.gradients[index].gradientStops[index].parent
Description

The gradient that contains this gradient stop.

Type

Gradient, read-only.

75.1.5 GradientStop.rampPoint

app.activeDocument.gradients[index] .gradientStops[index].rampPoint
Description
The location of the color in the blend in a range from 0.0 to 100.0, where 100.0 is 100%.

Type
Number (double).

75.1.6 GradientStop.typename

app.activeDocument.gradients[index].gradientStops[index].typename
Description

The class name of the referenced object.

Type

String, read-only.
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75.2 Methods

75.2.1 GradientStop.remove()

app.activeDocument.gradients[index].gradientStops[index].remove()
Description

Deletes this object.

Returns

Nothing.
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CHAPTER
SEVENTYSIX

GRADIENTSTOPS

app.activeDocument.gradients[index].gradientStops
Description

A collection of GradientStop objects in a specific gradient. The elements are not named; you must access them by
index.

76.1 Properties

76.1.1 GradientStops.length

app.activeDocument.gradients[index].gradientStops.length
Description

The number of objects in the collection.

Type

Number, read-only.

76.1.2 GradientStops.parent

app.activeDocument.gradients[index].gradientStops.parent
Description
The parent of this object.

Type
Object, read-only.
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76.1.3 GradientStops.typename

app.activeDocument.gradients[index].gradientStops.typename
Description

The class name of the referenced object.

Type

String, read-only.

76.2 Methods

76.2.1 GradientStops.add()

app.activeDocument.gradients[index].gradientStops.add()
Description

Creates a new object.

Returns

GradientStop

76.2.2 GradientStops.getByName()

app.activeDocument.gradients[index].gradientStops.getByName (name)
Description

Gets the first element in the collection with the specified name.

Parameters
Parameter | Type | Description
name String | Name of element to get
Returns
GradientStop
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76.2.3 GradientStops.index()

app.activeDocument.gradients[index].gradientStops.index (itemKey)
Description
Gets an element from the collection.

Parameters

Parameter | Type Description
itemKey String, Number | String or number key

Returns

GradientStop

76.2.4 GradientStops.removeAll()

app.activeDocument.gradients[index].gradientStops.removeAll ()
Description

Deletes all objects in this collection.

Returns

Nothing.

76.3 Example

76.3.1 Adding a new gradient stop

// Adds a new gradient stop to a gradient, color of new stop is 70% gray
if (app.documents.length > 0 &% app.activeDocument.gradients.length > 0) {
// Get a reference to the gradient to change
var changeGradient = app.activeDocument.gradients[0];

// Get a reference to the last gradient stop
var origCount = changeGradient.gradientStops.length;
var lastStop = changeGradient.gradientStops[origCount - 1];

// add the new gradient stop
var newStop = changeGradient.gradientStops.add(Q);

// Set the values of the new gradient stop.

// Move the original last gradient stop a bit to the left and insert the new gradient.,
—stop at the old position

newStop.rampPoint = lastStop.rampPoint;

lastStop.rampPoint = lastStop.rampPoint - 10;

(continues on next page)
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(continued from previous page)

// Create a new color to apply to the newly created gradient stop
var newStopColor = new GrayColor();

newStopColor.gray = 70.0;

newStop.color = newStopColor;
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CHAPTER
SEVENTYSEVEN

GRAPHICSTYLE

app.activeDocument.graphicStyles[index
Description

A graphic style. Each graphic style defines a set of appearance attributes that you can apply non-destructively to page
items. Graphic styles are contained in documents. Scripts cannot create new graphic styles.

77.1 Properties

77.1.1 GraphicStyle.name

app.activeDocument .graphicStyles[index].name
Description

The graphic style name.

Type

String.

77.1.2 GraphicStyle.parent

app.activeDocument.graphicStyles[index].parent
Description
The document that contains this graphic style.

Type

Document, read-only.
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77.1.3 GraphicStyle.typename

app.activeDocument.graphicStyles[index] . typename

Description

The class name of the referenced object.

Type
String, read-only.

77.2 Methods

77.2.1 GraphicStyle.applyTo()

app.activeDocument.graphicStyles[index].applyTo(artItem)

Description

Applies this art style to a specified art item.

Parameters

Returns

Nothing.

Parameter

Type

Description

artItem

Pageltem

Target art item

77.2.2 GraphicStyle.mergeTo()

app.activeDocument.graphicStyles[index] .mergeTo(artItem)

Description

Merges this art style into the current styles of a specified art item.

Parameters
Parameter | Type Description
artItem Pageltem | Target art item
Returns
Nothing.
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77.2.3 GraphicStyle.remove()

app.activeDocument.graphicStyles[index].remove()
Description

Deletes this object.

Returns

Nothing.

77.3 Example

77.3.1 Applying a graphic style

// Duplicates each path item in the selection, places the duplicate into a new group,
// then applies a graphic style to the new groups items

if (app.documents.length > 0) {
var doc = app.activeDocument;
var selected = doc.selection;
var newGroup = doc.groupltems.add();
newGroup.name = "NewGroup";
newGroup .move(doc, ElementPlacement.PLACEATEND);

var endIndex = selected.length;
for (var i = 0; i < endIndex; i++) {
if (selected[i].typename == "PathItem")
selected[i].duplicate(newGroup, ElementPlacement.PLACEATEND);
}

for (i = 0; i < newGroup.pageltems.length; i++) {
doc.graphicStyles[1].applyTo(newGroup.pageItems[i]);
}
}
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CHAPTER
SEVENTYEIGHT

app.activeDocument.graphicStyles

Description

A collection of GraphicStyle objects in a document.

GRAPHICSTYLES

78.1 Properties

78.1.1 GraphicStyles.length

app.activeDocument.graphicStyles.length
Description
The number of graphic styles in the document.

Type

Number, read-only.

78.1.2 GraphicStyles.parent

app.activeDocument.graphicStyles.parent

Description

The document that contains this graphic styles collection.

Type
Object, read-only.
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78.1.3 GraphicStyles.typename

app.activeDocument.graphicStyles.typename

Description

The class name of the referenced object.

Type
String, read-only.

78.2 Methods

78.2.1 GraphicStyles.getByName()

app.activeDocument.graphicStyles.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Returns

String.

Parameter

Type

Description

name

String

Name of element to get

78.2.2 GraphicStyles.index()

app.activeDocument.graphicStyles.index (itemKey)

Description

Gets an element from the collection.

Parameters

Returns

String, Number.

Parameter | Type

Description

itemKey String, Number

String or number key
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78.2.3 GraphicStyles.removeAll()

app.activeDocument.graphicStyles.removeAll ()
Description

Removes all elements in the referenced collection.
Returns

Nothing.

78.3 Example

78.3.1 Counting graphics styles

// Counts the number of graphic styles in the active document
// and stores result in numberOfStyles

if (app.documents.length > 0) {
var numberOfStyles = app.activeDocument.graphicStyles.length;

}

78.3. Example
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CHAPTER
SEVENTYNINE

GRAPHITEM

app.activeDocument.graphItems[index
Description

Any graph artwork object. See example Rotating graph items.

79.1 Properties

79.1.1 Graphltem.artworkKnockout

app.activeDocument .graphItems[index].artworkKnockout
Description

Is this object used to create a knockout, and if so, what kind of knockout. You cannot set this value to KnockoutState.
Unknown.

Type

KnockoutState

79.1.2 Graphltem.blendingMode

app.activeDocument.graphItems[index].blendingMode
Description
The mode used when compositing an object.

Type
BlendModes
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79.1.3 Graphltem.contentVariable

app.activeDocument.graphItems[index].contentVariable
Description
The content variable bound to the graph item.

It is not necessary to set the type of the contentVariable before binding. Illustrator automatically
GRAPH.

Type
Variable

set the type to

79.1.4 Graphltem.controlBounds

app.activeDocument.graphItems[index].controlBounds
Description

The content variable bound to the graph item.

The bounds of the object including stroke width and controls.

Type

Array of 4 numbers, read-only.

79.1.5 Graphltem.editable

app.activeDocument.graphItems[index].editable
Description

If true, this graph item is editable.

Type

Boolean, read-only.

79.1.6 Graphltem.geometricBounds

app.activeDocument.graphItems[index].geometricBounds
Description
The bounds of the object excluding stroke width.

Type

Array of 4 numbers, read-only.
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79.1.7 Graphltem.height

app.activeDocument.graphItems[index] .height
Description

The height of the graph item.

Type

Number (double), read-only.

79.1.8 Graphltem.hidden

app.activeDocument.graphItems[index].hidden
Description
If true, this graph item is hidden.

Type

Boolean.

79.1.9 Graphltem.islsolated

app.activeDocument.graphItems[index].isIsolated

Description
If true, this object is isolated.
Type

Boolean.

79.1.10 Graphltem.layer

app.activeDocument.graphItems[index].layer
Description

The layer to which this graph item belongs.

Type

Layer, read-only.

79.1. Properties
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79.1.11 Graphltem.left

app.activeDocument.graphItems[index].left

Description

The offset (in points) of the left side of the graph item from the left side of the page.

Type

Number.

79.1.12 Graphltem.locked

app.activeDocument.graphItems[index].locked
Description
If true, this graph item is locked.

Type

Boolean.

79.1.13 Graphltem.name

app.activeDocument.graphItems[index] .name
Description

The name of this graph item.

Type

String.

79.1.14 Graphltem.note

app.activeDocument .graphItems[index] .note
Description
The note assigned to this item.

Type
String.
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79.1.15 Graphltem.opacity

app.activeDocument.graphItems[index].opacity
Description

The opacity of the object; the value is between 0.0 and 100.0.
Type

Number (double)

79.1.16 Graphltem.parent

app.activeDocument.graphItems[index].parent
Description

The parent of this object.

Type

Layer or Groupltem

79.1.17 Graphltem.position

app.activeDocument.graphIltems[index].position
Description

The position (in points) of the top left corner of the graphItem object in the format [X, y]. Does not include stroke
weight.

Type

Array of 2 numbers.

79.1.18 Graphltem.selected

app.activeDocument.graphItems[index].selected
Description

If true, this object is selected.

Type

Boolean.
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79.1.19 Graphltem.sliced

app.activeDocument.graphItems[index].sliced
Description

If true, the graph item is sliced. Default: false.

Type

Boolean.

79.1.20 Graphltem.tags

app.activeDocument .graphItems[index].tags
Description
The tags contained in this graph item.

Type
Tags, read-only.

79.1.21 Graphltem.top

app.activeDocument.graphItems[index].top

Description

The offset (in points) of the top of the graph item from the bottom of the page.

Type
Number (double).

79.1.22 Graphltem.typename

app.activeDocument.graphItems[index] . typename
Description
The type of the graph item.

Type
String, read-only.
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79.1.23 Graphltem.uRL

app.activeDocument.graphItems[index].uRL
Description

The value of the Adobe URL tag assigned to this graph item.
Type

String.

79.1.24 Graphltem.visibilityVariable

app.activeDocument.graphItems[index].visibilityVariable
Description
The visibility variable bound to the graph item.

It is not necessary to set the type of the visibilityVariable before binding. Illustrator automatically set the type to
VISIBILITY.

Type
Variable

79.1.25 Graphltem.visibleBounds

app.activeDocument.graphItems[index].visibleBounds
Description
The visible bounds of the graph item including stroke width.

Type

Array of 4 numbers, read-only.

79.1.26 Graphltem.width

app.activeDocument.graphItems[index].width
Description

The width of the graph item. Range: 0.0 to 16348.0.
Type

Number (double).
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79.1.27 Graphltem.wraplinside

app.activeDocument.graphItems[index] .wrapInside
Description

If true, the text frame object should be wrapped inside this object.
Type

Boolean.

79.1.28 Graphltem.wrapOffset

app.activeDocument.graphItems[index].wrapOffset
Description
The offset to use when wrapping text around this object.

Type
Number (double).

79.1.29 Graphltem.wrapped

app.activeDocument .graphItems[index] .wrapped

Description

If true, wrap text frame objects around this object. (Text frame must be above the object.)
Type

Boolean.

79.1.30 Graphltem.zOrderPosition

app.activeDocument.graphItems[index].zOrderPosition
Description
The position of this art item within the stacking order of the group or layer (parent) that contains the art item.

Type
Number (long).
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79.2 Methods

79.2.1 Graphltem.duplicate()

app.activeDocument.graphItems[index].duplicate([relativeObject] [,insertionLocation])
Description

Creates a duplicate of the selected object.

Parameters
Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element

Returns

Graphltem

79.2.2 Graphltem.move()

app.activeDocument.graphItems[index] .move(relativeObject, insertionLocation)
Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionLocation | ElementPlacement, optional | Location to move element to

Returns

Graphltem

79.2.3 Graphltem.remove()

app.activeDocument.graphItems[index] .remove()
Description

Deletes this object.

Returns

Nothing.
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79.2.4 Graphltem.resize()

app.activeDocument.graphItems[index].resize(scaleX, scaleY
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,scaleAbout])

)

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =
100%.

Parameters
Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

79.2.5 Graphltem.rotate()

app.activeDocument.graphItems[index].rotate(angle
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,rotateAbout]

)

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
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Nothing.

79.2.6 Graphltem.transform()

app.activeDocument.graphItems[index].transform(transformationMatrix
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,transformAbout]

)

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

79.2.7 Graphltem.translate()

app.activeDocument.graphItems[index].translate([deltaX] [,deltaY]
[,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltaY is the vertical
offset.

Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects

transformFillPatterns

Boolean, optional

Whether to transform Fill Patterns

transformFillGradients

Boolean, optional

Whether to transform Fill Gradients

transformStrokePatterns

Boolean, optional

Whether to transform Stroke Patterns

79.2. Methods
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Returns

Nothing.

79.2.8 Graphltem.zOrder()

app.activeDocument.graphIltems[index].zOrder (zOrderCmd)

Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters
Parameter | Type Description
zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.
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CHAPTER
EIGHTY

GRAPHITEMS

app.activeDocument.graphltems
Description

A collection GraphItems objects, which gives you access to all the graph art items in an Illustrator document.

80.1 Properties

80.1.1 Graphltems.length

app.activeDocument.graphItems.length
Description
The number of objects in the collection.

Type

Number, read-only.

80.1.2 Graphltems.parent

app.activeDocument.graphIltems.parent
Description

The parent of this object.

Type

Object, read-only.
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80.1.3 Graphltems.typename

app.activeDocument.graphItems.typename

Description

The class name of the referenced object.

Type
String, read-only.

80.2 Methods

80.2.1 Graphltems.getByName()

app.activeDocument.graphItems.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Returns

Graphltems

Parameter | Type | Description

name

String | Name of element to get

80.2.2 Graphltems.index()

app.activeDocument.graphItems.index (itemKey)

Description

Gets an element from the collection.

Parameters

Returns

Graphltems

Parameter

Type

Description

itemKey

String, Number

String or number key
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80.2.3 Graphltems.removeAll()

app.activeDocument.graphItems.removeAll ()
Description

Deletes all elements in the collection.

Returns

Nothing.

80.3 Example

80.3.1 Rotating graph items

// Rotates each graph item in the current document 90 degrees.

// Verify a document with a graph item is open
var ok = false;

if (documents.length > 0) {
var docRef = activeDocument;
var iCount = docRef.graphltems.length;
if (iCount > 0) {
ok = true;
for (var i = 0; i < iCount; i++) {
var graphRef = docRef.graphItems[i];
graphRef.selected = true;
graphRef.rotate(90); //rotate clockwise 90 degrees
}
redraw();

}

80.3. Example
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CHAPTER
EIGHTYONE

GROUPITEM

app.activeDocument.groupIltems[index
Description

A grouped set of art items. Group items can contain all of the same page items that a layer can contain, including other
nested groups.

Paths contained in a group or compound path in a document are returned as individual paths when a script asks for
the paths contained in the document. However, paths contained in a group or compound path are not returned when a
script asks for the paths in a layer which contains the group or compound path.

81.1 Properties

81.1.1 Groupltem.artworkKnockout

app.activeDocument .groupItems[index].artworkKnockout
Description
Is this object used to create a knockout, and if so, what kind of knockout.

Type

KnockoutState

81.1.2 Groupltem.blendingMode

app.activeDocument.groupIltems[index].blendingMode
Description

The blend mode used when compositing an object.

Type

BlendModes
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81.1.3 Groupltem.clipped

app.activeDocument.groupIltems[index].clipped
Description

If true, the group is clipped to the clipping mask.

Type

Boolean.

81.1.4 Groupltem.compoundPathltems

app.activeDocument .groupItems[index].compoundPathItems
Description
The compound path items contained in this group.

Type

CompoundPathltems, read-only.

81.1.5 Groupltem.controlBounds

app.activeDocument.groupIltems[index].controlBounds
Description

The bounds of the object including stroke width and controls.
Type

Array of 4 numbers, read-only.

81.1.6 Groupltem.editable

app.activeDocument.groupItems[index].editable
Description
If true, this item is editable.

Type

Boolean, read-only.
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81.1.7 Groupltem.geometricBounds

app.activeDocument .groupItems[index].geometricBounds
Description

The bounds of the object excluding stroke width.

Type

Array of 4 numbers, read-only.

81.1.8 Groupltem.graphltems

app.activeDocument.groupIltems[index].graphItems
Description
he graph items contained in this group.

Type

Graphltems, read-only.

81.1.9 Groupltem.groupltems

app.activeDocument.groupIltems[index].groupItems
Description

The group items contained in this group.

Type

Groupltems, read-only.

81.1.10 Groupltem.height

app.activeDocument.groupItems[index].height
Description
The height of the group item.

Type
Number (double).

81.1. Properties
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81.1.11 Groupltem.hidden

app.activeDocument.groupItems[index].hidden
Description

If true, this group item is hidden.

Type

Boolean.

81.1.12 Groupltem.islsolated

app.activeDocument.groupItems[index].isIsolated
Description
If true, this object is isolated.

Type

Boolean.

81.1.13 Groupltem.layer

app.activeDocument.groupIltems[index].layer
Description

The layer to which this group item belongs.

Type

Layer, read-only.

81.1.14 Groupltem.left

app.activeDocument.groupItems[index].left
Description
The position of the left side of the item (in points, measured from the left side of the page).

Type
Number (double).
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81.1.15 Groupltem.legacyTextltems

app.activeDocument.groupItems[index].legacyTextItems
Description

The legacy text items in the group.

Type

LegacyTextltems, read-only.

81.1.16 Groupltem.locked

app.activeDocument.groupIltems[index].locked
Description
If true, this group item is locked.

Type

Boolean.

81.1.17 Groupltem.meshltems

app.activeDocument.groupIltems[index] .meshItems
Description

The mesh items contained in this group.

Type

Meshltems, read-only.

81.1.18 Groupltem.name

app.activeDocument .groupItems[index] .name
Description
The name of this group item.

Type
String.
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81.1.19 Groupltem.nonNativeltems

app.activeDocument.groupItems[index].nonNativeItems
Description

The non-native art items in this group.

Type

NonNativeltems

81.1.20 Groupltem.note

app.activeDocument.groupItems[index] .note
Description
The note assigned to this item.

Type
String.

81.1.21 Groupltem.opacity

app.activeDocument.groupIltems[index].opacity
Description

The opacity of the object. Range: 0.0 to 100.0.

Type

Number (double).

81.1.22 Groupltem.pageltems

app.activeDocument.groupIltems[index].pageltems
Description
The page items (all art item classes) contained in this group.

Type

Pageltems, read-only.
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81.1.23 Groupltem.parent

app.activeDocument.groupItems[index].parent
Description

The parent of this object.

Type

Layer or Groupltem, read-only.

81.1.24 Groupltem.pathltems

app.activeDocument.groupIltems[index].pathItems
Description
The path items contained in this group.

Type

Pathltems, read-only.

81.1.25 Groupltem.placedltems

app.activeDocument.groupIltems[index].placedItems
Description

The placed items contained in this group.

Type

Placedltems, read-only.

81.1.26 Groupltem.pluginltems

app.activeDocument.groupItems[index].pluginItems
Description
The plug-in items contained in this group.

Type

Pluginltems, read-only.

81.1. Properties
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81.1.27 Groupltem.position

app.activeDocument.groupIltems[index].position
Description

The position (in points) of the top left corner of the groupItem object in the format [x, y]. Does not include stroke
weight.

Type

Array of 2 numbers.

81.1.28 Groupltem.rasterltems

app.activeDocument.groupItems[index].rasterItems
Description
The raster items contained in this group.

Type

Rasterltems, read-only.

81.1.29 Groupltem.selected

app.activeDocument.groupIltems[index].selected
Description

If true, this group item is selected.

Type

Boolean.

81.1.30 Groupltem.sliced

app.activeDocument.groupItems[index].sliced
Description

If true, the item sliced. Default: false.

Type

Boolean.
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81.1.31 Groupltem.symbolltems

app.activeDocument .groupItems[index].symbolItems
Description

The symbol item objects in this group.

Type

Symbolltems, read-only.

81.1.32 Groupltem.tags

app.activeDocument.groupIltems[index].tags
Description
The tags contained in this group.

Type
Tags, read-only.

81.1.33 Groupltem.textFrames

app.activeDocument.groupIltems[index].textFrames
Description

The text art items contained in this group.

Type

TextFrameltems, read-only.

81.1.34 Groupltem.top

app.activeDocument.groupItems[index] .top
Description
The position of the top of the item (in points, measured from the bottom of the page).

Type
Number (double).
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81.1.35 Groupltem.typename

app.activeDocument.groupItems[index].typename
Description

The class name of the referenced object.

Type

String, read-only.

81.1.36 Groupltem.uRL

app.activeDocument.groupIltems[index].uRL
Description
The value of the Adobe URL tag assigned to this group item.

Type
String.

81.1.37 Groupltem.visibilityVariable

app.activeDocument.groupIltems[index].visibilityVariable
Description

The visibility variable bound to the item.

Type

Variable

81.1.38 Groupltem.visibleBounds

app.activeDocument .groupItems[index].visibleBounds
Description
The visible bounds of the group item including stroke width.

Type

Array of 4 numbers, read-only.
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81.1.39 Groupltem.width

app.activeDocument.groupIltems[index].width
Description

The width of the group item.

Type

Number (double).

81.1.40 Groupltem.wraplnside

app.activeDocument.groupIltems[index].wrapInside
Description

If true, the text frame object should be wrapped inside this object.
Type

Boolean.

81.1.41 Groupltem.wrapOffset

app.activeDocument.groupItems[index].wrapOffset
Description

The offset to use when wrapping text around this object.
Type

Number (double).

81.1.42 Groupltem.wrapped

app.activeDocument.groupIltems[index] .wrapped

Description

If true, wrap text frame objects around this object (text frame must be above the object).

Type

Boolean.

81.1. Properties
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81.1.43 Groupltem.zOrderPosition

app.activeDocument .groupItems[index].zOrderPosition

Description

The position of this group object within the stacking order of the group or layer (parent) that contains the group object.
Type

Number (long).

81.2 Methods

81.2.1 Groupltem.duplicate()

app.activeDocument.groupIltems[index].duplicate([relativeObject] [,insertionLocation])
Description

Creates a duplicate of the selected object.

Parameters
Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element

Returns

Groupltem

81.2.2 Groupltem.move()

app.activeDocument.groupIltems[index].move(relativeObject, insertionLocation)
Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionLocation | ElementPlacement, optional | Location to move element to

Returns

Groupltem
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81.2.3 Groupltem.remove()

app.activeDocument.groupIltems[index].remove()

Description
Deletes this object.
Returns

Nothing.

81.2.4 Groupltem.resize()

app.activeDocument.groupItems[index].resize(scaleX, scaleY
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,scaleAbout]

)

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =

100%.
Parameters
Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

81.2.5 Groupltem.rotate()

app.activeDocument.groupIltems[index].rotate(angle
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,rotateAbout]

)

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

81.2. Methods
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Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
Nothing.

81.2.6 Groupltem.transform()

app.activeDocument.groupIltems[index].transform(transformationMatrix
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,transformAbout]

)

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern | Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

81.2.7 Groupltem.translate()

app.activeDocument.groupIltems[index].translate([deltaX] [,deltaY]
[,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

)
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Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltaY is the vertical
offset.

Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects
transformFillPatterns Boolean, optional Whether to transform Fill Patterns
transformFillGradients Boolean, optional Whether to transform Fill Gradients
transformStrokePatterns | Boolean, optional Whether to transform Stroke Patterns
Returns
Nothing.

81.2.8 Groupltem.zOrder()

app.activeDocument.groupltems[index].zOrder (zOrderCmd)
Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters

Parameter | Type Description

zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.

81.3 Example

81.3.1 Modifying all objects in a group

It is easy to modify all of the objects contained in a group. This example demonstrates how to simplify your operations
on multiple objects by creating group to contain them.

// Creates a new group item, adds a new path item, of triangle shape, to the group,
// then adds a new text item to the group and sets the fill color of the text to red

if (app.documents.length > 0) {
var triangleGroup = app.activeDocument.groupItems.add();

(continues on next page)
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(continued from previous page)

// Create a triangle and add text, the new art is created inside the group

var trianglePath = triangleGroup.pathItems.add();

trianglePath.setEntirePath(Array(Array (100, 100), Array(300, 100), Array(200, Math.
—tan(1.0471975) * 100 + 100)));

trianglePath.closed = true;

trianglePath.stroked = true;

trianglePath.filled = false;

trianglePath.strokeWidth = 3;

var captionText = triangleGroup.textFrames.add();
captionText.position = Array(100, 150);
captionText.textRange.size = 48;
captionText.contents = "A triangle";

var fillColor = new RGBColor();

fillColor.red = 255;

fillColor.green = 0;

fillColor.blue = 0;
captionText.characters.fillColor = fillColor;
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CHAPTER
EIGHTYTWO

app.activeDocument.groupltems

Description

The collection of grouped art items in a document.

GROUPITEMS

82.1 Properties

82.1.1 Groupltems.length

app.activeDocument.groupItems.length
Description
The number of objects in the collection.

Type

Number, read-only.

82.1.2 Groupltems.parent

app.activeDocument.groupltems.parent
Description

The parent of this object.

Type

Object, read-only.
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82.1.3 Groupltems.typename

app.activeDocument.groupIltems.typename
Description

The class name of the referenced object.

Type

String, read-only.

82.2 Methods

82.2.1 Groupltems.add()

app.activeDocument.groupIltems.add()
Description

Creates a new object.

Returns

Groupltem

82.2.2 Groupltems.createFromFile()

app.activeDocument.groupltems.createFromFile(imageFile)
Description

Places an external vector art file as a group item in the document.

Parameters
Parameter | Type | Description
imageFile | File Vector art file to place
Returns
Groupltem
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82.2.3 Groupltems.getByName()

app.activeDocument.groupltems.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Returns

Groupltem

Parameter | Type | Description

name

String | Name of element to get

82.2.4 Groupltems.index()

app.activeDocument.groupItems.index(itemKey)

Description

Gets an element from the collection.

Parameters

Returns

Groupltem

Parameter

Type

Description

itemKey

String, Number

String or number key

82.2.5 Groupltems.removeAll()

app.activeDocument.groupItems.removeAll ()

Description

Deletes all elements in this collection.

Returns

Nothing.

82.2. Methods
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82.3 Example

82.3.1 Importing a PDF as a group item

The following script shows how you can import a PDF document using the Groupltems.createFromFile() function.

Note: Before running this script you must create a one page PDF file and put it in the location /temp/testfilel.pdf.

// Embeds a new group item in to the current document from a file specified by dest
// dest should contain the full path and file name

function embedPDF(dest) {
var embedDoc = new File(dest);
if (app.documents.length > 0 && embedDoc.exists) {
var doc = app.activeDocument;
var placed = doc.groupIltems.createFromFile(embedDoc);
}
}
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CHAPTER
EIGHTYTHREE

ILLUSTRATORSAVEOPTIONS

illustratorSaveOptions
Description

Options for saving a document as an Illustrator file, used with the Document.saveAs() method. All properties are
optional.

83.1 Properties

83.1.1 lllustratorSaveOptions.artboardRange

illustratorSaveOptions.artboardRange
Description

If saveMultipleArtboards is true (which is valid only for Illustrator 13 or earlier), the document is considered
for multi-asset extraction, which specifies an artboard range. An empty string extracts all artboards. Default: empty
String.

Type

String.

83.1.2 lllustratorSaveOptions.compatibility

illustratorSaveOptions.compatibility

Description

Specifies the version of Illustrator file format to create. Default: Compatibility.ILLUSTRATOR19.
Type

Compatibility
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83.1.3 lllustratorSaveOptions.compressed

illustratorSaveOptions.compressed

Description

(Illustrator version 10 or later.) If true, the saved file is compressed. Default: true.
Type

Boolean.

83.1.4 lllustratorSaveOptions.embedICCProfile

illustratorSaveOptions.embedICCProfile
Description
(Illustrator version 9 or later.) If true, the document’s ICC profile is embedded in the saved file. Default: false.

Type

Boolean.

83.1.5 lllustratorSaveOptions.embedLinkedFiles

illustratorSaveOptions.embedLinkedFiles

Description

(Illustrator version 7 or later.) If true, the linked image files is embedded in the saved file. Default: false.
Type

Boolean.

83.1.6 lllustratorSaveOptions.flattenOutput

illustratorSaveOptions. flattenOutput
Description

(Versions before Illustrator 9.) How transparency should be flattened for older file format versions. Default:
OutputFlattening.PRESERVEAPPEARANCE.

Type
OutputFlattening
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83.1.7 lllustratorSaveOptions.fontSubsetThreshold

illustratorSaveOptions.fontSubsetThreshold
Description

(Illustrator version 9 or later.) Include a subset of fonts when less than this percentage of characters is used in the
document. Range: 0.0 to 100.0. Default: 100.0.

Type
Number (double).

83.1.8 lllustratorSaveOptions.pdfCompatible

illustratorSaveOptions.pdfCompatible

Description

(Illustrator version 10 or later.) If true, the file is saved as a PDF compatible file. Default: true.
Type

Boolean.

83.1.9 lllustratorSaveOptions.saveMultipleArtboards

illustratorSaveOptions.saveMultipleArtboards

Description

If true, all artboards or range of the artboards are saved. Valid for Illustrator 13 or earlier.
Type

Boolean.

83.1.10 lllustratorSaveOptions.typename

illustratorSaveOptions.typename
Description
The class name of the referenced object.

Type
String, read-only.
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83.2 Example

83.2.1 Saving with options

// Saves the current document to dest as an AI file with specified options,
// dest specifies the full path and file name of the new file

function exportFileToAI(dest) {
if (app.documents.length > 0) {
var ai8Doc = new File(dest);
var saveOptions = new IllustratorSaveOptions();
saveOptions.compatibility = Compatibility.ILLUSTRATORS;
saveOptions.flattenOutput = OutputFlattening.PRESERVEAPPEARANCE;

app.activeDocument.saveAs(ai8Doc, saveOptions);
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CHAPTER
EIGHTYFOUR

imageCaptureOptions

Description

IMAGECAPTUREOPTIONS

Options for image capture, used with the Document.imageCapture() method. All properties are optional.

84.1 Properties

84.1.1 ImageCaptureOptions.antiAliasing

imageCaptureOptions.antiAliasing
Description
If true, the image result is anti-aliased. Default: false.

Type

Boolean

84.1.2 ImageCaptureOptions.matte

imageCaptureOptions.matte

Description

If true, the artboard is matted with a color. Default: false.

Type

Boolean
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84.1.3 ImageCaptureOptions.matteColor

imageCaptureOptions.matteColor

Description

The color to use for the artboard matte. Default: white.
Type

RGBColor

84.1.4 ImageCaptureOptions.resolution

imageCaptureOptions.resolution
Description
The resolution of the captured image file in points-per-inch (PPI), in the range [72.0 ... 2400.0]. Default: 150.

Type
Number (double).

84.1.5 ImageCaptureOptions.transparency

imageCaptureOptions.transparency
Description
If true, the image result is transparent. Default: false.

Type

Boolean.

84.1.6 ImageCaptureOptions.typename

imageCaptureOptions. typename
Description
The class name of the referenced object.

Type

String, read-only.
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CHAPTER
EIGHTYFIVE

app.activeDocument.inkLisk[index

Description

Associates a document ink name with ink information.

INK

85.1 Properties

85.1.1 Ink.inkinfo

app.activeDocument.inkLisk[index].inkInfo
Description
The ink information

Type
InkInfo

85.1.2 Ink.name

app.activeDocument.inkLisk[index] .name
Description
The ink’s name.

Type
String.
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85.1.3 Ink.typename

app.activeDocument.inkLisk[index].typename
Description

The class name of the object.

Type

String, read-only.
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CHAPTER
EIGHTYSIX

INKINFO

app.activeDocument.inkList[index].inkInfo
Description

Ink information for printing a document.

86.1 Properties

86.1.1 Inkinfo.angle

app.activeDocument.inkList[index].inkInfo.angle
Description
The ink’s screen angle in degrees. Range: -360 to 360.

Type
Number (double).

86.1.2 Inkinfo.customColor

app.activeDocument.inkList[index].inkInfo.customColor
Description

The color of the custom ink.

Type

Color
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86.1.3 Inkinfo.density

app.activeDocument.inklList[index].inkInfo.density
Description

The neutral density. Minimum: 0.0.

Type

Number (double).

86.1.4 Inkinfo.dotShape

app.activeDocument.inkList[index].inkInfo.dotShape
Description

The dot shape name.

Type

String.

86.1.5 Inkinfo.frequency

app.activeDocument.inkList[index] .inkInfo. frequency
Description
The ink’s frequency. Range: 0.0 to 1000.0.

Type
Number (double).

86.1.6 Inkinfo.kind

app.activeDocument.inkList[index].inkInfo.kind
Description

The ink type.

Type

InkType
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86.1.7 Inkinfo.printingStatus

app.activeDocument.inklList[index].inkInfo.printingStatus
Description

The ink printing status.

Type

InkPrintStatus

86.1.8 Inkinfo.trapping

app.activeDocument.inkList[index].inkInfo.trapping
Description

The trapping type.

Type

TrappingType

86.1.9 Inkinfo.trappingOrder

app.activeDocument.inkList[index].inkInfo.trappingOrder
Description
The order of trapping for the ink. Range: 1 to 4 for CMYK.

Type
Number (long).

86.1.10 Inkinfo.typename

app.activeDocument.inkList[index].inkInfo.typename
Description
The class name of the object.

Type

String, read-only.

86.1. Properties
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86.2 Example

86.2.1 Getting ink information

// Displays the current documents inks in a text frame
var docRef = documents.add();

// assemble a string of the inks in this document

var sInks = "";

var ilength = activeDocument.inkList.length;

for (var i = 0; i < ilLength; i++) {
sInks += docRef.inkList[i].name;
sInks += "\r\t";
sInks += "Frequency =
sInks += "\r\t";
sInks += "Density =
sInks += "\r";

+ docRef.inkList[i].inkInfo.frequency;

+ docRef.inkList[i].inkInfo.density;

}

var textRef = docRef.textFrames.add();
textRef.contents = sInks;

textRef.top = 600;

textRef.left = 200;

redraw();
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CHAPTER
EIGHTYSEVEN

INSERTIONPOINT

app.activeDocument. textFrames[index].insertionPoints[index
Description

A location between characters that is used to insert new text objects. An insertion point is contained in an
InsertionPoints collection.

87.1 Properties

87.1.1 InsertionPoint.characters

app.activeDocument.textFrames[index].insertionPoints[index].characters
Description
All the characters in this text range.

Type

Characters, read-only.

87.1.2 InsertionPoint.lines

app.activeDocument.textFrames[index].insertionPoints[index].lines
Description

All the lines in this text range.

Type

Lines, read-only.
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87.1.3 InsertionPoint.paragraphs

app.activeDocument .textFrames[index].insertionPoints[index] .paragraphs
Description

All the paragraphs in this text range.

Type

Paragraphs, read-only.

87.1.4 InsertionPoint.parent

app.activeDocument.textFrames[index].insertionPoints[index] .parent
Description
The object’s container.

Type

TextRange, read-only.

87.1.5 InsertionPoint.story

app.activeDocument.textFrames[index].insertionPoints[index].story
Description

The story to which the text range belongs.

Type

Story, read-only.

87.1.6 InsertionPoint.textRanges

app.activeDocument .textFrames[index].insertionPoints[index].textRanges
Description
All of the text in this text range.

Type

TextRanges, read-only.
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87.1.7 InsertionPoint.typename

app.activeDocument.textFrames[index].insertionPoints[index] . typename
Description

The class name of the object.

Type

String, read-only.

87.1.8 InsertionPoint.words

app.activeDocument.textFrames[index].insertionPoints[index] .words
Description
All the words contained in this text range.

Type
Words, read-only.
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CHAPTER
EIGHTYEIGHT

INSERTIONPOINTS

app.activeDocument.textFrames[index].insertionPoints
Description

A collection of InsertionPoint objects.

88.1 Properties

88.1.1 InsertionPoints.length

app.activeDocument.textFrames[index].insertionPoints.length
Description
Number of elements in the collection.

Type

Number, read-only.

88.1.2 InsertionPoints.parent

app.activeDocument.textFrames[index].insertionPoints.parent
Description

The object’s container.

Type

Object, read-only.
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88.1.3 InsertionPoints.typename

app.activeDocument .textFrames[index] .insertionPoints.typename

Description

The class name of the object.

Type

String, read-only.

88.2 Methods

88.2.1 InsertionPoints.index()

app.activeDocument.textFrames[index].insertionPoints.index (itemKey)

Description
Gets an element from the collection.

Parameters

Parameter

Type

Description

itemKey

String, Number

String or number key

Returns

InsertionPoint

88.3 Example

88.3.1 Using insertion points to add spaces

// Creates a new document, adds text then inserts a
// space between each character using insertion points

var docRef = documents.add();

var textRef = docRef.textFrames.add();
textRef.contents = "Wouldn't you rather be scripting?";

textRef.top = 400;
textRef.left = 100;

textRef.textRange.characterAttributes.size = 20;

redraw();

// Add a space between each character using insertion points.

var ip;

(continues on next page)
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(continued from previous page)

for (var i = 0; i < textRef.insertionPoints.length; i += 2) {
ip = textRef.insertionPoints[i];
ip.characters.add(" ");

}
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CHAPTER
EIGHTYNINE

LAYER

app.activeDocument.layers[index
Description
A layer in an Illustrator document. Layers may contain nested layers, which are called sublayers in the user interface.

The layer object contains all of the page items in the specific layer as elements. Your script can access page items as
elements of either the Layer object or as elements of the Document object. When accessing page items as elements
of a layer, only objects in that layer can be accessed. To access page items throughout the entire document, be sure to
refer to them as contained by the document.

89.1 Properties

89.1.1 Layer.artworkKnockout

app.activeDocument.layers[index] .artworkKnockout
Description

Is this object used to create a knockout, and if so, what kind of knockout. You cannot set this value to KnockoutState.
Unknown.

Type

KnockoutState

89.1.2 Layer.blendingMode

app.activeDocument.layers[index].blendingMode
Description

The mode used when compositing an object.

Type

BlendModes

427



lllustrator Scripting Guide, Release 0.0.1

89.1.3 Layer.color

app.activeDocument.layers[index].color
Description

The layer’s selection mark color.

Type

RGBColor

89.1.4 Layer.compoundPathltems

app.activeDocument.layers[index].compoundPathItems
Description
The compound path items contained in this layer.

Type

CompoundPathltems, read-only.

89.1.5 Layer.dimPlacedimages

app.activeDocument.layers[index].dimPlacedImages

Description

If true, placed images should be rendered as dimmed in this layer.

Type

Boolean.

89.1.6 Layer.graphltems

app.activeDocument.layers[index] .graphItems
Description
The graph items contained in this layer.

Type
Graphltems, read-only.

428

Chapter 89. Layer



lllustrator Scripting Guide, Release 0.0.1

89.1.7 Layer.groupltems

app.activeDocument.layers[index] .groupItems
Description

The group items contained in this layer.

Type

Groupltems, read-only.

89.1.8 Layer.hasSelectedArtwork

app.activeDocument.layers[index] .hasSelectedArtwork
Description
If true, an object in this layer has been selected; set to false to deselect all objects in the layer.

Type

Boolean.

89.1.9 Layer.islsolated

app.activeDocument.layers[index].isIsolated
Description

If true, this object is isolated.

Type

Boolean.

89.1.10 Layer.layers

app.activeDocument.layers[index].layers
Description
The layers contained in this layer.

Type

Layers, read-only.

89.1. Properties
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89.1.11 Layer.legacyTextltems

app.activeDocument.layers[index] .legacyTextItems

Description
The legacy text items in this layer.
Type

LegacyTextltems, read-only.

89.1.12 Layer.locked

app.activeDocument.layers[index].locked
Description
If true, this layer is editable; set to false to lock the layer.

Type

Boolean.

89.1.13 Layer.meshltems

app.activeDocument.layers[index] .meshItems
Description

The mesh items contained in this layer.

Type

Meshltems, read-only.

89.1.14 Layer.name

app.activeDocument.layers[index] .name
Description
The name of this layer.

Type
String.
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89.1.15 Layer.nonNativeltems

app.activeDocument.layers[index] .nonNativeItems
Description

The non-native art items in this layer.

Type

NonNativeltems

89.1.16 Layer.opacity

app.activeDocument.layers[index].opacity
Description
The opacity of the layer. Range: 0.0 to 100.0.

Type
Number (double).

89.1.17 Layer.pageltems

app.activeDocument.layers[index] .pageltems
Description

The page items (all art item classes) contained in this layer.
Type

Pageltems

89.1.18 Layer.parent

app.activeDocument.layers[index].parent
Description

The document or layer that contains this layer.
Type

Document or Layer, read-only.
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89.1.19 Layer.pathltems

app.activeDocument.layers[index] .pathItems
Description

The path items contained in this layer.

Type

Pathltems, read-only.

89.1.20 Layer.placedlitems

app.activeDocument.layers[index].placedItems
Description
The placed items contained in this layer.

Type

Placedltems, read-only.

89.1.21 Layer.pluginltems

app.activeDocument.layers[index].pluginItems
Description

The plug-in items contained in this layer.

Type

Pluginltems, read-only.

89.1.22 Layer.preview

app.activeDocument.layers[index].preview

Description

If true, this layer should be displayed using preview mode.

Type

Boolean.
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89.1.23 Layer.printable

app.activeDocument.layers[index] .printable
Description

If true, this layer should be printed when printing the document.
Type

Boolean.

89.1.24 Layer.rasterltems

app.activeDocument.layers[index].rasterItems
Description
The raster items contained in this layer.

Type

Rasterltems, read-only.

89.1.25 Layer.sliced

app.activeDocument.layers[index].sliced
Description

If true, the layer item is sliced. Default: false.
Type

Boolean.

89.1.26 Layer.symbolltems

app.activeDocument.layers[index] .symbolItems
Description
The symbol items contained in the layer.

Type

Symbolltems, read-only.
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89.1.27 Layer.textFrames

app.activeDocument.layers[index] .textFrames
Description

The text art items contained in this layer.

Type

TextFrameltems, read-only.

89.1.28 Layer.typename

app.activeDocument.layers[index] .typename
Description
The class name of the referenced object.

Type

String, read-only.

89.1.29 Layer.visible

app.activeDocument.layers[index].visible
Description

If true, this layer is visible.

Type

Boolean.

89.1.30 Layer.zOrderPosition

app.activeDocument.layers[index].zOrderPosition

Description

The position of this layer within the stacking order of layers in the document.

Type
Number (long), read-only.
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89.2 Methods

89.2.1 Layer.move()

app.activeDocument.layers[index] .move(relativeObject, insertionLocation)

Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionLocation | ElementPlacement, optional | Location to move element to

Returns

Layer

89.2.2 Layer.remove()

app.activeDocument.layers[index].remove()

Description
Deletes this object.
Returns

Nothing.

89.2.3 Layer.zOrder()

app.activeDocument.layers[index] .zOrder (ZOrderCmd)

Description

Arranges the layer’s position in the stacking order of the containing layer or document (parent) of this object.

Parameters

Parameter | Type Description

zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.

89.2. Methods
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89.3 Example

89.3.1 Bringing a layer to the front

// Moves the bottom layer to become the topmost layer

if (documents.length > 0) {
var countOfLayers = activeDocument.layers.length;
if (countOfLayers > 1) {
var bottomLayer = activeDocument.layers[countOfLayers - 1];
bottomLayer.zOrder (ZOrderMethod.BRINGTOFRONT) ;
} else {
alert("The active document only has only 1 layer");

}
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CHAPTER
NINETY

app.activeDocument.layers
Description

The collection of layers in the document.

LAYERS

90.1 Properties

90.1.1 Layers.length

app.activeDocument.layers.length
Description
The number of objects in the collection.

Type

Number, read-only.

90.1.2 Layers.parent

app.activeDocument.layers.parent
Description

The parent of this object.

Type

Object, read-only.

437



lllustrator Scripting Guide, Release 0.0.1

90.1.3 Layers.typename

app.activeDocument.layers.typename
Description

The class name of the referenced object.
Type

String, read-only.

90.2 Methods

90.2.1 Layers.add()

app.activeDocument.layers.add()
Description

Creates a new layer in the document.
Returns

Layer

90.2.2 Layers.getByName()

app.activeDocument.layers.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters
Parameter | Type | Description
name String | Name of element to get
Returns
Layer
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90.2.3 Layers.index()

app.activeDocument.layers.index (itemKey)
Description

Gets an element from the collection.

Parameters
Parameter | Type Description
itemKey String, Number | String or number key
Returns
Layer

90.2.4 Layers.removeAll()

app.activeDocument.layers.removeAll ()
Description

Deletes all elements in this collection.

Returns

Nothing.

90.3 Example

90.3.1 Finding and deleting layers

// Deletes all layers whose name begins with "Temp" in all open documents

var layersDeleted = 0;

for (var i = 0; i < app.documents.length; i++) {
var targetDocument = app.documents[i];
var layerCount = targetDocument.layers.length;

// Loop through layers from the back, to preserve index
// of remaining layers when we remove one
for (var ii = layerCount - 1; ii >= 0; ii--) {
var targetlayer = targetDocument.layers[ii];
var layerName = new String(targetLayer.name);
if (layerName.indexOf("Temp") == 0) {
targetDocument.layers[ii].remove();
layersDeleted++;
}
}
}
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CHAPTER
NINETYONE

LEGACYTEXTITEM

legacyTextItems[index
Description

A text object created in Illustrator CS (version 10) or earlier, which is uneditable until converted. To convert legacy
text, see LegacyTextltems.convertTloNative().

You can view, move, and print legacy text, but you cant edit it. Legacy text has an “x” through its bounding box when
selected.

91.1 Properties

91.1.1 LegacyTextltem.artworkKnockout

legacyTextItems[index] .artworkKnockout
Description
Is this object used to create a knockout, and if so, what kind of knockout.

Type

KnockoutState

91.1.2 LegacyTextltem.blendingMode

legacyTextItems[index].blendingMode
Description

The blend mode used when compositing an object.
Type

BlendModes
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91.1.3 LegacyTextltem.controlBounds

legacyTextItems[index].controlBounds

Description

The bounds of the object including stroke width and controls.
Type

Array of 4 numbers, read-only.

91.1.4 LegacyTextltem.converted

legacyTextItems[index].converted

Description

If true, the legacy text item has been updated to a native text frame item.

Type

Boolean, read-only.

91.1.5 LegacyTextltem.editable

legacyTextItems[index].editable
Description

If true, this item is editable.

Type

Boolean, read-only.

91.1.6 LegacyTextltem.geometricBounds

legacyTextItems[index] .geometricBounds
Description

The bounds of the object excluding stroke width.
Type

Array of 4 numbers, read-only.
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91.1.7 LegacyTextltem.height

legacyTextItems[index] .height
Description

The height of the group item.

Type

Number (double).

91.1.8 LegacyTextltem.hidden

legacyTextItems[index].hidden
Description

If true, this item is hidden.

Type

Boolean.

91.1.9 LegacyTextltem.islsolated

legacyTextItems[index].isIsolated
Description

If true, this object is isolated.

Type

Boolean.

91.1.10 LegacyTextltem.layer

legacyTextItems[index].layer
Description
The layer to which this item belongs.

Type

Layer, read-only.

91.1. Properties
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91.1.11 LegacyTextltem.left

legacyTextItems[index].left

Description

The position of the left side of the item (in points, measured from the left side of the page).
Type

Number (double).

91.1.12 LegacyTextltem.locked

legacyTextItems[index].locked
Description

If true, this item is locked.

Type

Boolean.

91.1.13 LegacyTextltem.name

legacyTextItems[index] .name
Description

The name of this item.

Type

String.

91.1.14 LegacyTextltem.note

legacyTextItems[index].note
Description
The note assigned to this item.

Type
String.
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91.1.15 LegacyTextltem.opacity

legacyTextItems[index].opacity
Description

The opacity of the object. Range: 0.0 to 100.0.
Type

Number (double).

91.1.16 LegacyTextltem.parent

legacyTextItems[index].parent
Description

The parent of this object.

Type

Layer or Groupltem, read-only.

91.1.17 LegacyTextltem.position

legacyTextItems[index].position
Description

The position (in points) of the top left corner of the legacyTextItems[index object in the format [x, y]. Does not
include stroke weight.

Type

Array of 2 numbers.

91.1.18 LegacyTextltem.selected

legacyTextItems[index].selected
Description
If true, this item is selected.

Type

Boolean.
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91.1.19 LegacyTextltem.sliced

legacyTextItems[index].sliced
Description

If true, the item sliced. Default: false.
Type

Boolean.

91.1.20 LegacyTextltem.tags

legacyTextItems[index].tags
Description
The tags contained in this item.

Type
Tags, read-only.

91.1.21 LegacyTextltem.top

legacyTextItems[index] . top

Description

The position of the top of the item (in points, measured from the bottom of the page).
Type

Number (double).

91.1.22 LegacyTextltem.typename

legacyTextItems[index].typename
Description
The class name of the referenced object.

Type
String, read-only.
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91.1.23 LegacyTextltem.uRL

legacyTextItems[index].uRL

Description

The value of the Adobe URL tag assigned to this item.
Type

String.

91.1.24 LegacyTextltem.visibilityVariable

legacyTextItems[index].visibilityVariable
Description
The visibility variable bound to the item.

Type

Variable

91.1.25 LegacyTextltem.visibleBounds

legacyTextItems[index].visibleBounds
Description

The visible bounds of the item including stroke width.
Type

Array of 4 numbers, read-only.

91.1.26 LegacyTextltem.width

legacyTextItems[index].width
Description
The width of the item.

Type
Number (double).
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91.1.27 LegacyTextltem.wraplinside

legacyTextItems[index] .wrapInside

Description

If true, the text frame object should be wrapped inside this object.
Type

Boolean.

91.1.28 LegacyTextltem.wrapOffset

legacyTextItems[index] .wrapOffset
Description
The offset to use when wrapping text around this object.

Type
Number (double).

91.1.29 LegacyTextltem.wrapped

legacyTextItems[index] .wrapped

Description

If true, wrap text frame objects around this object (text frame must be above the object).
Type

Boolean.

91.1.30 LegacyTextltem.zOrderPosition

legacyTextItems[index].zOrderPosition
Description
The position of this item within the stacking order of the group or layer (parent) that contains the item.

Type
Number (long), read-only.
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91.2 Methods

91.2.1 LegacyTextltem.convertToNative()

legacyTextItems[index].convertToNative()

Description

Converts the legacy text item to a text frame and deletes the original legacy text.

Returns

Groupltem

91.2.2 LegacyTextltem.duplicate()

legacyTextItems[index].duplicate([relativeObject] [,insertionLocation])

Description

Creates a duplicate of the selected object.

Parameters
Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element
Returns

LegacyTextltem

91.2.3 LegacyTextltem.move()

legacyTextItems[index].move(relativeObject, insertionlLocation)

Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionLocation | ElementPlacement, optional | Location to move element to

Returns

LegacyTextltem

91.2. Methods
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91.2.4 LegacyTextltem.remove()

legacyTextItems[index].remove()
Description

Deletes this object.

Returns

Nothing.

91.2.5 LegacyTextltem.resize()

legacyTextItem.resize(scaleX, scaleY
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,scaleAbout]

)

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 = 100%.

Parameters
Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

91.2.6 LegacyTextltem.rotate()

legacyTextItem.rotate(angle [,changePositions] [,changeFillPatterns]
[,changeFillGradients] [,changeStrokePattern] [,rotateAbout]
)

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
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Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
Nothing.

91.2.7 LegacyTextltem.transform()

legacyTextItem.transform(transformationMatrix
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,transformAbout]

)

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

91.2.8 LegacyTextltem.translate()

legacyTextItem.translate([deltaX] [,deltaY]
[,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltay is the vertical
offset.
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Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects

transformFillPatterns

Boolean, optional

Whether to transform Fill Patterns

transformFillGradients

Boolean, optional

Whether to transform Fill Gradients

transformStrokePatterns

Boolean, optional

Whether to transform Stroke Patterns

Returns

Nothing.

91.2.9 LegacyTextltem.zOrder()

legacyTextItems[index] .zOrder (zOrderCmd)

Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters
Parameter | Type Description
zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.
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CHAPTER
NINETYTWO

legacyTextItems
Description

A collection of LegacyTextltem objects.

LEGACYTEXTITEMS

92.1 Properties

92.1.1 LegacyTextltems.length

legacyTextItems.length
Description
Number of elements in the collection.

Type

Number, read-only.

92.1.2 LegacyTextltems.parent

legacyTextItems.parent
Description
The object’s container.

Type
Object, read-only.
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92.1.3 LegacyTextltems.typename

legacyTextItems. typename
Description

The class name of the object.
Type

String, read-only.

92.2 Methods

92.2.1 LegacyTextltems.convertToNative()

legacyTextItems.convertToNative()

Description

Creates text frames from all legacy text items; the original legacy text items are deleted. Returns true on success.

Returns

Boolean.

92.2.2 LegacyTextltems.getByName()

legacyTextItems.getByName (name)

Description

Get the first element in the collection with the specified name.

Parameters
Parameter | Type | Description
name String | Name of element to get
Returns
LegacyTextltem
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92.2.3 LegacyTextltems.index()

legacyTextItems. index(itemKey)

Description

Gets an element from the collection.

Parameters

Returns

LegacyTextltem

Parameter

Type

Description

itemKey

String, Number

String or number key

92.2.4 LegacyTextltems.removeAll()

legacyTextItems.removeAll ()

Description

Deletes all elements in this collection.

Returns

Nothing.

92.2. Methods
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CHAPTER
NINETYTHREE

lines

Description

LINES

A collection of TextRange objects representing lines of text in a text frame. The elements are not named; you must

access them by index.

93.1 Properties

93.1.1 Lines.length

lines.length

Description

Number of elements in the collection.

Type

Number, read-only.

93.1.2 Lines.parent

lines.parent
Description
The object’s container.

Type
Object, read-only.
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93.1.3 Lines.typename

lines.typename
Description

The class name of the object.
Type

String, read-only.

93.2 Methods

93.2.1 Lines.index()

lines.index(itemKey)
Description

Gets an element from the collection.

Type

Description

String, Number

String or number key

Parameters
Parameter
itemKey
Returns
TextRange

93.2.2 Lines.removeAll()

lines.removeAll()

Description

Deletes all elements in this collection.
Returns

Nothing.
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CHAPTER
NINETYFOUR

MATRIX

matrix
Description

A transformation matrix specification, used to transform the geometry of objects. Use it to specify and retrieve matrix
information from an Illustrator document or from page items in a document.

Matrices are used in conjunction with the transform method and as a property of a number of objects. A matrix
specifies how to transform the geometry of an object. You can generate an original matrix using the Application object
methods Application.getTranslationMatrix(), Application. getScaleMatrix(), or Application.getRotationMatrix().

A Matrix is a record containing the matrix values, not a reference to a matrix object. The matrix commands operate
on the values of a matrix record. If a command modifies a matrix, a modified matrix record is returned as the result of
the command. The original matrix record passed to the command is not modified.

94.1 Properties

94.1.1 Matrix.mValueA

matrix.mValueA
Description
Matrix property a.
Type

Number (double).

94.1.2 Matrix.mValueB

matrix.mValueB
Description
Matrix property b.

Type
Number (double).
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94.1.3 Matrix.mValueC

matrix.mValueC
Description
Matrix property c.
Type

Number (double).

94.1.4 Matrix.mValueD

matrix.mValueD
Description
Matrix property d.
Type

Number (double).

94.1.5 Matrix.mValueTX

matrix.mValueTX
Description
Matrix property tx.

Type
Number (double).

94.1.6 Matrix.mValueTY

matrix.mValueTY
Description
Matrix property ty.
Type

Number (double).
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94.1.7 Matrix.typename

matrix.typename
Description
The class name of the referenced object.

Type

String, read-only.

94.2 Example

94.2.1 Combining matrices to apply multiple transformations

To apply multiple transformations to objects, it is more efficient to use the matrix suite than to apply the transformations
one at a time. The following script demonstrates how to combine multiple matrices.

// Tranforms all art in a document using translation and rotation matrices,
// moves art half an inch to the right and 1.5 inches up on the page
if (app.documents.length > 0) {

var moveMatrix = app.getTranslationMatrix(0.5, 1.5);

// Add a rotation to the translation, 10 degrees counter clockwise
var totalMatrix = concatenateRotationMatrix(moveMatrix, 10);

// apply the transformation to all art in the document
var doc = app.activeDocument;
for (var i = 0; i < doc.pageltems.length; i++) {
doc.pageltems[i].transform(totalMatrix);
}
}
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CHAPTER
NINETYFIVE

MESHITEM

app.activeDocument .meshItems[index
Description

A gradient mesh art item. You cannot create mesh items from a script. However, you can copy an existing mesh item
with the duplicate method, then use the one of the move methods to place the copy at the proper location.

95.1 Properties

95.1.1 Meshltem.artworkKnockout

app.activeDocument .meshItems[index] .artworkKnockout
Description

Is this object used to create a knockout, and if so, what kind of knockout.
Type

KnockoutState

95.1.2 Meshltem.blendingMode

app.activeDocument .meshItems[index] .blendingMode
Description
The blend mode used when compositing an object.

Type
BlendModes

463



lllustrator Scripting Guide, Release 0.0.1

95.1.3 Meshltem.controlBounds

app.activeDocument .meshItems[index].controlBounds
Description

The bounds of the object including stroke width and controls.
Type

Array of 4 numbers, read-only.

95.1.4 Meshltem.editable

app.activeDocument .meshItems[index].editable
Description
If true, this item is editable.

Type

Boolean, read-only.

95.1.5 Meshltem.geometricBounds

app.activeDocument .meshItems[index].geometricBounds
Description

The bounds of the object excluding stroke width.

Type

Array of 4 numbers, read-only.

95.1.6 Meshltem.height

app.activeDocument .meshItems[index] .height
Description
The height of the group item.

Type
Number (double).
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95.1.7 Meshltem.hidden

app.activeDocument .meshItems[index].hidden
Description

If true, this item is hidden.

Type

Boolean.

95.1.8 Meshltem.islsolated

app.activeDocument . .meshItems[index].isIsolated
Description
If true, this object is isolated.

Type

Boolean.

95.1.9 Meshltem.layer

app.activeDocument.meshItems[index].layer
Description

The layer to which this item belongs.

Type

Layer, read-only.

95.1.10 Meshltem.left

app.activeDocument .meshItems[index].left

Description

The position of the left side of the item (in points, measured from the left side of the page).

Type
Number (double).

95.1. Properties
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95.1.11 Meshltem.locked

app.activeDocument .meshItems[index].locked
Description

If true, this item is locked.

Type

Boolean.

95.1.12 Meshltem.name

app.activeDocument.meshItems[index] .name
Description
The name of this item.

Type
String.

95.1.13 Meshltem.note

app.activeDocument.meshItems[index] .note
Description

The note assigned to this item.

Type

String.

95.1.14 Meshltem.opacity

app.activeDocument.meshItems[index].opacity
Description
The opacity of the object. Range: 0.0 to 100.0.

Type
Number (double).

466 Chapter 95. Meshltem



lllustrator Scripting Guide, Release 0.0.1

95.1.15 Meshltem.parent

app.activeDocument .meshItems[index] .parent
Description

The parent of this object.

Type

Layer or Groupltem, read-only.

95.1.16 Meshltem.position

app.activeDocument .meshItems[index].position
Description

The position (in points) of the top left corner of the Meshitem object in the format [x, y]. Does not include stroke
weight.

Type

Array of 2 numbers.

95.1.17 Meshltem.selected

app.activeDocument.meshItems[index].selected
Description
If true, this item is selected.

Type

Boolean.

95.1.18 Meshltem.sliced

app.activeDocument .meshItems[index].sliced
Description

If true, the item sliced. Default: false.

Type

Boolean.
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95.1.19 Meshltem.tags

app.activeDocument .meshItems[index].tags
Description

The tags contained in this item.

Type

Tags, read-only.

95.1.20 Meshltem.top

app.activeDocument .meshItems[index].top

Description

The position of the top of the item (in points, measured from the bottom of the page).

Type
Number (double).

95.1.21 Meshltem.typename

app.activeDocument .meshItems[index] . typename
Description
The class name of the referenced object.

Type

String, read-only.

95.1.22 Meshltem.uRL

app.activeDocument.meshItems[index].uRL
Description
The value of the Adobe URL tag assigned to this item.

Type
String.
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95.1.23 Meshltem.visibilityVariable

app.activeDocument .meshItems[index].visibilityVariable
Description

The visibility variable bound to the item.

Type

Variable

95.1.24 Meshltem.visibleBounds

app.activeDocument .meshItems[index].visibleBounds
Description
The visible bounds of the item including stroke width.

Type

Array of 4 numbers, read-only.

95.1.25 Meshltem.width

app.activeDocument.meshItems[index].width
Description

The width of the item.

Type

Number (double).

95.1.26 Meshltem.wraplnside

app.activeDocument .meshItems[index].wrapInside
Description
If true, the text frame object should be wrapped inside this object.

Type

Boolean.
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95.1.27 Meshltem.wrapOffset

app.activeDocument .meshItems[index] .wrapOffset
Description

The offset to use when wrapping text around this object.
Type

Number (double).

95.1.28 Meshltem.wrapped

app.activeDocument .meshItems[index] .wrapped

Description

If true, wrap text frame objects around this object (text frame must be above the object).
Type

Boolean.

95.1.29 Meshltem.zOrderPosition

app.activeDocument .meshItems[index] .zOrderPosition

Description

The position of this item within the stacking order of the group or layer (parent) that contains the item.
Type

Number (long), read-only.

95.2 Methods

95.2.1 Meshltem.duplicate()

app.activeDocument.meshItems[index].duplicate([relativeObject] [,insertionLocation])
Description
Creates a duplicate of the selected object.

Parameters

Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element
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Returns

Meshltem

95.2.2 Meshltem.move()

app.activeDocument.meshItems[index] .move(relativeObject, insertionLocation)
Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionlLocation | ElementPlacement, optional | Location to move element to

Returns

Meshltem

95.2.3 Meshltem.remove()

app.activeDocument .meshItems[index].move()
Description

Deletes this object.

Returns

Nothing.

95.2.4 Meshltem.resize()

app.activeDocument.meshItems[index].resize(scaleX, scaleY
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,scaleAbout]

)

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =
100%.

Parameters
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Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

95.2.5 Meshltem.rotate()

app.activeDocument .meshItems[index].rotate(angle [,changePositions]
[,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,rotateAbout]

)

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
Nothing.
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95.2.6 Meshltem.transform()

app.activeDocument .meshItems[index].transform(transformationMatrix
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,transformAbout]

)

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern | Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

95.2.7 Meshltem.translate()

app.activeDocument.meshItems[index].translate([deltaX] [,deltaY]
[,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltaY is the vertical

offset.
Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects
transformFillPatterns Boolean, optional Whether to transform Fill Patterns
transformFillGradients Boolean, optional Whether to transform Fill Gradients
transformStrokePatterns | Boolean, optional Whether to transform Stroke Patterns
Returns
Nothing.

95.2. Methods
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95.2.8 Meshltem.zOrder()

app.activeDocument .meshItems[index].zOrder (zOrderCmd)
Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters

Parameter | Type Description

zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.

95.3 Example

95.3.1 Example name

// Locks all mesh items in the current document
if (app.documents.length > 0) {
var doc = app.activeDocument;
for (var i = 0; i < doc.meshItems.length; i++) {
doc.meshItems[i].locked = true;
}
}
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CHAPTER
NINETYSIX

MESHITEMS

app.activeDocument .meshItems
Description

A collection of Meshltem objects.

96.1 Properties

96.1.1 Meshltems.length

app.activeDocument.meshItems.length
Description
The number of objects in the collection.

Type

Number, read-only.

96.1.2 Meshltems.parent

app.activeDocument.meshItems.parent
Description

The parent of this object.

Type

Object, read-only.
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96.1.3 Meshltems.typename

app.activeDocument .meshItems. typename

Description

The class name of the referenced object.

Type
String, read-only.

96.2 Methods

96.2.1 Meshltems.getByName()

app.activeDocument .meshItems.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Returns

Meshltem

Parameter | Type

Description

name

String

Name of element to get

96.2.2 Meshltems.index()

app.activeDocument .meshItems.index (itemKey)

Description

Gets an element from the collection.

Parameters
Parameter | Type Description
itemKey String, Number | String or number key
Returns
Meshltem
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96.2.3 Meshltems.removeAll()

app.activeDocument .meshItems.removeAll()
Description

Deletes all elements in this collection.

Returns

Nothing.

96.3 Example

96.3.1 Copying mesh items to another document

To run this script, have two open documents. One document should contain at least one mesh item, the other document
can be empty. Make the empty document the frontmost before running the script.

// Copies all mesh items from one document to a new document
if (app.documents.length > 0) {
var srcDoc = documents[0];
var locationOffset = 0;
var targetDoc = documents.add();
for (var i = 0; i < srcDoc.meshItems.length; i++) {
var srcItem = srcDoc.meshItems[i];
var dupltem = srcDoc.meshItems[i].duplicate(targetDoc, ElementPlacement.PLACEATEND);

// offset the copied items' position on the y axis
dupItem.position = Array(100, 50 + locationOffset);
locationOffset += 50;
}
3
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CHAPTER
NINETYSEVEN

nonNativeItems[index
Description

A non-native artwork item.

NONNATIVEITEM

97.1 Properties

97.1.1 NonNativeltem.artworkKnockout

nonNativeItems[index] .artworkKnockout

Description

Is this object used to create a knockout, and if so, what kind of knockout.

Type

KnockoutState

97.1.2 NonNativeltem.blendingMode

nonNativeItems[index].blendingMode
Description
The blend mode used when compositing an object.

Type
BlendModes
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97.1.3 NonNativeltem.controlBounds

nonNativeItems[index].controlBounds

Description

The bounds of the object including stroke width and controls.

Type

Array of 4 numbers, read-only.

97.1.4 NonNativeltem.editable

nonNativeItems[index].editable
Description
If true, this item is editable.

Type

Boolean, read-only.

97.1.5 NonNativeltem.geometricBounds

nonNativeItems[index].geometricBounds
Description

The bounds of the object excluding stroke width.
Type

Array of 4 numbers, read-only.

97.1.6 NonNativeltem.height

nonNativeIltems[index].height
Description
The height of the group item.

Type
Number (double).
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97.1.7 NonNativeltem.hidden

nonNativeItems[index].hidden
Description

If true, this item is hidden.

Type

Boolean.

97.1.8 NonNativeltem.islsolated

nonNativeItems[index].isIsolated
Description
If true, this object is isolated.

Type

Boolean.

97.1.9 NonNativeltem.layer

nonNativeItems[index].layer
Description

The layer to which this item belongs.
Type

Layer, read-only.

97.1.10 NonNativeltem.left

nonNativeItems[index].left
Description
The position of the left side of the item (in points, measured from the left side of the page).

Type
Number (double).
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97.1.11 NonNativeltem.locked

nonNativeItems[index].locked
Description

If true, this item is locked.

Type

Boolean.

97.1.12 NonNativeltem.name

nonNativeItems[index] .name
Description
The name of this item.

Type
String.

97.1.13 NonNativeltem.note

nonNativeItems[index].note
Description

The note assigned to this item.
Type

String.

97.1.14 NonNativeltem.opacity

nonNativeItems[index].opacity
Description
The opacity of the object. Range: 0.0 to 100.0.

Type
Number (double).

482

Chapter 97. NonNativeltem



lllustrator Scripting Guide, Release 0.0.1

97.1.15 NonNativeltem.parent

nonNativeItems[index].parent
Description

The parent of this object.

Type

Document, Layer or Groupltem, read-only.

97.1.16 NonNativeltem.position

nonNativeItems[index].position
Description

The position (in points) of the top left corner of the NonNativeItems[index object in the format [x, y]. Does not
include stroke weight.

Type

Array of 2 numbers.

97.1.17 NonNativeltem.selected

nonNativeItems[index].selected
Description
If true, this item is selected.

Type

Boolean.

97.1.18 NonNativeltem.sliced

nonNativeItems[index].sliced
Description

If true, the item sliced. Default: false.
Type

Boolean.
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97.1.19 NonNativeltem.tags

nonNativeItems[index].tags
Description

The tags contained in this item.
Type

Tags, read-only.

97.1.20 NonNativeltem.top

nonNativeItems[index].top

Description

The position of the top of the item (in points, measured from the bottom of the page).

Type
Number (double).

97.1.21 NonNativeltem.typename

nonNativeItems[index].typename
Description
The class name of the referenced object.

Type

String, read-only.

97.1.22 NonNativeltem.uRL

nonNativeItems[index].uRL
Description
The value of the Adobe URL tag assigned to this item.

Type
String.
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97.1.23 NonNativeltem.visibilityVariable

nonNativeItems[index].visibilityVariable
Description

The visibility variable bound to the item.

Type

Variable

97.1.24 NonNativeltem.visibleBounds

nonNativeItems[index].visibleBounds
Description
The visible bounds of the item including stroke width.

Type

Array of 4 numbers, read-only.

97.1.25 NonNativeltem.width

nonNativeItems[index].width
Description

The width of the item.

Type

Number (double).

97.1.26 NonNativeltem.wrapinside

nonNativeIltems[index].wrapInside

Description

If true, the non-native-item object should be wrapped inside this object.

Type

Boolean.

97.1. Properties
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97.1.27 NonNativeltem.wrapOffset

nonNativeItems[index].wrapOffset

Description

The offset to use when wrapping text around this object.
Type

Number (double).

97.1.28 NonNativeltem.wrapped

nonNativeItems[index] .wrapped

Description

If true, wrap non-native-item objects around this object (non-native-item object must be above the object).
Type

Boolean.

97.1.29 NonNativeltem.zOrderPosition

nonNativeItems[index].zOrderPosition

Description

The position of this item within the stacking order of the group or layer (parent) that contains the item.
Type

Number, read-only.

97.2 Methods

97.2.1 NonNativeltem.duplicate()

nonNativeItems[index].duplicate([relativeObject] [,insertionLocation])
Description
Creates a duplicate of the selected object.

Parameters

Parameter Type Description
relativeObject Object, optional Object to duplicate to
insertionLocation | ElementPlacement, optional | Location to insert element
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Returns

NonNativeltem

97.2.2 NonNativeltem.move()

nonNativeItems[index] .move(relativeObject, insertionLocation)

Description

Moves the object.

Parameters
Parameter Type Description
relativeObject Object Object to move element within
insertionlLocation | ElementPlacement, optional | Location to move element to

Returns

NonNativeltem

97.2.3 NonNativeltem.remove()

nonNativeItems[index].remove()
Description

Deletes this object.

Returns

Nothing.

97.2.4 NonNativeltem.removeAll()

nonNativeItems[index].removeAll()

Description
Deletes all elements in this collection.
Returns

Nothing.

97.2. Methods
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97.2.5 NonNativeltem.resize()

nonNativeItem.resize(scaleX, scaleY
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,scaleAbout]

)

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =
100%.

Parameters
Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

97.2.6 NonNativeltem.rotate()

nonNativeItem.rotate(angle
[,changePositions] [,changeFillPatterns]
[,changeFillGradients] [,changeStrokePattern] [,rotateAbout]

)

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout Transformation, optional | The point to use as anchor, to transform about
Returns
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Nothing.

97.2.7 NonNativeltem.transform()

nonNativeItem.transform(transformationMatrix
[,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changeLineWidths] [,transformAbout]

)

Description

Transforms the art item by applying a transformation matrix.

Parameters
Parameter Type Description
transformationMatrix | Matrix Transformation matrix to apply
changePositions Boolean, optional Whether to change Positions
changeFillPatterns Boolean, optional Whether to change Fill Patterns
changeFillGradients Boolean, optional Whether to change Fill Gradients
changeStrokePattern Boolean, optional Whether to change Stroke Pattern
changeLineWidths Number (double), optional | The amount to scale line widths
transformAbout Transformation, optional The point to use as anchor, to transform about

Returns

Nothing.

97.2.8 NonNativeltem.translate()

nonNativeItem.translate([deltaX] [,deltaY]
[,transformObjects] [,transformFillPatterns]
[,transformFillGradients] [,transformStrokePatterns]

Description

Repositions the art item relative to the current position, where deltaX is the horizontal offset and deltaY is the vertical

offset.
Parameters
Parameter Type Description
deltaX Number (double), optional | Horizontal offset
deltaY Number (double), optional | Vertical offset
transformObjects Boolean, optional Whether to transform Objects

transformFillPatterns

Boolean, optional

Whether to transform Fill Patterns

transformFillGradients

Boolean, optional

Whether to transform Fill Gradients

transformStrokePatterns

Boolean, optional

Whether to transform Stroke Patterns

97.2. Methods
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Returns

Nothing.

97.2.9 NonNativeltem.zOrder()

nonNativeItems[index].zOrder (zOrderCmd)

Description

Arranges the art item’s position in the stacking order of the group or layer (parent) of this object.

Parameters
Parameter | Type Description
zOrderCmd | ZOrderMethod | Stacking order arrangement method
Returns
Nothing.
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CHAPTER
NINETYEIGHT

nonNativeItems
Description

A collection of NonNativeltem objects.

NONNATIVEITEMS

98.1 Properties

98.1.1 NonNativeltems.length

nonNativeltems.length
Description
The number of objects in the collection.

Type

Number, read-only.

98.1.2 NonNativeltems.parent

nonNativeItems.parent
Description
The parent of this object.

Type
Object, read-only.
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98.1.3 NonNativeltems.typename

nonNativeIltems.typename
Description

The class name of the referenced object.
Type

String, read-only.

98.2 Methods

98.2.1 NonNativeltems.getByName()

nonNativeItems.getByName (name)

Description

Gets the first element in the collection with the specified name.

Parameters

Parameter | Type | Description

name String | Name of element to get

Returns

NonNativeltem, Symbolltem
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CHAPTER
NINETYNINE

OPENOPTIONS

openOptions
Description

Options for opening a document, used with the Application.open() method.

99.1 Properties

99.1.1 OpenOptions.convertCropAreaToArboard

openOptions.convertCropAreaToArboard
Description

Optional. Convert crop areas to artboards when opening a legacy document in Illustrator CS4 or later. When false,
crop areas are discarded. Default: true.

Type

Boolean.

99.1.2 OpenOptions.convertTilesToArboard

openOptions.convertTilesToArboard
Description
Optional. Convert print tiles to artboards when opening a legacy document in Illustrator CS4 or later. Default: false.

Type

Boolean.
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99.1.3 OpenOptions.createArtboardWithArtworkBoundingBox

openOptions.createArtboardWithArtworkBoundingBox
Description

Optional. Create an artboard with the dimensions of the bounding box of the artwork when opening a legacy document
in Illustrator CS4 or later. Default: false.

Type

Boolean.

99.1.4 OpenOptions.openAs

openOptions.openAs
Description
Optional. Open the file as an Illustrator library of this type. Default: LibraryType.IllustratorArtwork.

Type
LibraryType

99.1.5 OpenOptions.preservelLegacyArtboard

openOptions.preservelLegacyArtboard
Description
Optional. Preserve legacy artboards when opening a legacy document in Illustrator CS4 or later. Default: true.

Type

Boolean.

99.1.6 OpenOptions.updateLegacyGradientMesh

openOptions.updatelLegacyGradientMesh
Description

If true, preserves the spot colors in the gradient mesh objects for legacy documents (pre-Illustrator CS4). Default:
true.

Type

Boolean.
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99.1.7 OpenOptions.updateLegacyText

openOptions.updatelLegacyText

Description

Optional. If true, update all legacy text items (from previous versions of Illustrator). Default: false.

Type

Boolean.

99.2 Example

99.2.1 Automatically updating legacy text on open

// Opens a file with legacy text (AI 10 or older), using
// OpenOptions to automatically update the legacy text.

var fileRef = filePath;

if (fileRef !'= null) {
var openOptions = new OpenOptions();
openOptions.updatelLegacyText = true;

var docRef = open(fileRef, DocumentColorSpace.RGB, openOptions);

}

99.2. Example
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CHAPTER

OPENOPTIONSAUTOCAD

openOptionsAutoCAD
Description

Options for opening an AutoCAD drawing, used with the Application.open() method.

100.1 Properties

100.1.1 OpenOptionsAutoCAD.centerArtwork

openOptionsAutoCAD.centerArtwork

Description

If true, the artwork is centered on the artboard. Default: true.
Type

Boolean.

100.1.2 OpenOptionsAutoCAD.globalScaleOption

openOptionsAutoCAD.globalScaleOption

Description

How to scale the drawing on import. Default: AutoCADGlobalScaleOption.FitArtboard.
Type

AutoCADGlobalScaleOption
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100.1.3 OpenOptionsAutoCAD.globalScalePercent

openOptionsAutoCAD.globalScalePercent
Description

The value when globalScaleOption is AutoCADGlobalScaleOption.ScaleByValue, expressed as a percentage.
Range: 0.0 to 100.0. Default is 100.0.

Type
Number (double).

100.1.4 OpenOptionsAutoCAD.mergelLayers

openOptionsAutoCAD.mergelayers

Description

If true, the layers of the artwork are merged. Default: false.
Type

Boolean.

100.1.5 OpenOptionsAutoCAD.parent

openOptionsAutoCAD.parent
Description

The object’s container.

Type

Object, read-only.

100.1.6 OpenOptionsAutoCAD.scaleLineweights

openOptionsAutoCAD.scaleLineweights
Description
If true, line weights are scaled by the same factor as the rest of the drawing. Default: false.

Type

Boolean.
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100.1.7 OpenOptionsAutoCAD.selectedLayoutName

openOptionsAutoCAD.selectedLayoutName
Description
The name of the layout in the drawing to import.

Type
String.

100.1.8 OpenOptionsAutoCAD.typename

openOptionsAutoCAD. typename
Description
The class name of the object.

Type

String, read-only.

100.1.9 OpenOptionsAutoCAD.unit

openOptionsAutoCAD.unit

Description

The unit to map to. Default: AutoCADUnit.Millimeters.
Type

AutoCADUnit

100.1.10 OpenOptionsAutoCAD.unitScaleRatio

openOptionsAutoCAD.unitScaleRatio
Description
The ratio by which to scale while mapping units. Default: 1.0.

Type
Number (double).

100.1. Properties
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CHAPTER
ONE

OPENOPTIONSFREEHAND

openOptionsFreeHand
Description

Options for opening a FreeHand file.

101.1 Properties

101.1.1 OpenOptionsFreeHand.convertTextToOutlines

openOptionsFreeHand.convertTextToOutlines
Description
If true, all text is converted to vector paths; preserves the visual appearance of type. Default: false.

Type

Boolean.

101.1.2 OpenOptionsFreeHand.importSinglePage

openOptionsFreeHand. importSinglePage

Description

If true, imports only the page specified in the pageToOpen property. Default: true.
Type

Boolean.
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101.1.3 OpenOptionsFreeHand.pageToOpen

openOptionsFreeHand.pageToOpen

Description

The number of the page to import when opening a multipage document. Valid only when importSinglePage is true.
Type

Number (long).

101.1.4 OpenOptionsFreeHand.parent

openOptionsFreeHand.parent
Description
The parent of this object.

Type
Object, read-only.

101.1.5 OpenOptionsFreeHand.typename

openOptionsFreeHand. typename
Description

The class name of the referenced object.
Type

String, read-only.
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CHAPTER
TWO

OPENOPTIONSPHOTOSHOP

openOptionsPhotoshop
Description

Options for opening a Photoshop document, used with the Application.open() method.

102.1 Properties

102.1.1 OpenOptionsPhotoshop.layerComp

openOptionsPhotoshop.layerComp
Description
The name of the layer comp to use when the document is converted.

Type
String.

102.1.2 OpenOptionsPhotoshop.preserveHiddenLayers

openOptionsPhotoshop.preserveHiddenLayers
Description
If true, preserve hidden layers when the document is converted. Default: false.

Type

Boolean.
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102.1.3 OpenOptionsPhotoshop.preservelmageMaps

openOptionsPhotoshop.preserveImageMaps

Description

If true, preserve image maps when the document is converted. Default: true.
Type

Boolean.

102.1.4 OpenOptionsPhotoshop.preservelLayers

openOptionsPhotoshop.preservelLayers
Description
If true, preserve layers when the document is converted. Default: true.

Type

Boolean.

102.1.5 OpenOptionsPhotoshop.preserveSlices

openOptionsPhotoshop.preserveSlices

Description

If true, preserve slices when the document is converted. Default: true.
Type

Boolean.

102.1.6 OpenOptionsPhotoshop.typename

openOptionsPhotoshop.typename
Description
The class name of the object.

Type

String, read-only.
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CHAPTER
THREE

PAGEITEM

app.activeDocument.pageltems[index
Description

Any art item. Every art item and group in a document is a page item. You may refer to a page item as an element of a
document, layer, or group item.

The PageItem class gives you complete access to every art item contained in an Illustrator document. The PageItem
class is the superclass of all artwork objects in a document. The CompoundPathltem, Groupltem, Meshltem, Pathltem,
Placedltem, Pluginltem, Rasterltem, and TextFrameltem classes each inherit a set of properties from the PageItem
class.

You cannot create a PageItem directly, you must create one of the specific PageItem subclasses, such as Pathltem.

103.1 Properties

103.1.1 Pageltem.artworkKnockout

app.activeDocument.pageltems[index].artworkKnockout
Description

Is this object used to create a knockout.

Type

KnockoutState

103.1.2 Pageltem.blendingMode

app.activeDocument.pageltems[index].blendingMode
Description

The mode to use when compositing this object. An object is considered composited when its opacity is set to less than
100.0 (100%).

Type
BlendModes
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103.1.3 Pageltem.controlBounds

app.activeDocument .pageltems[index].controlBounds
Description

The bounds of the object including stroke width and controls.
Type

Rect, read-only.

103.1.4 Pageltem.editable

app.activeDocument.pageltems[index].editable
Description
If true, this page item is editable.

Type

Boolean, read-only.

103.1.5 Pageltem.geometricBounds

app.activeDocument.pageltems[index].geometricBounds
Description

The object’s bounds excluding the stroke width.

Type

Array of 4 numbers, read-only.

103.1.6 Pageltem.height

app.activeDocument.pageltems[index] .height

Description

The height of the page item, calculated from the geometric bounds. Range: 0.0 to 16348.0.

Type
Number (double).
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103.1.7 Pageltem.hidden

app.activeDocument .pageItems[index] .hidden
Description

If true, this page item is hidden.

Type

Boolean.

103.1.8 Pageltem.islsolated

app.activeDocument.pageltems[index].isIsolated
Description
If true, this object is isolated.

Type

Boolean.

103.1.9 Pageltem.layer

app.activeDocument.pageltems[index].layer
Description

The layer to which this page item belongs.

Type

Layer, read-only.

103.1.10 Pageltem.left

app.activeDocument.pageltems[index].left
Description
The left position of the art item.

Type
Number (double).
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103.1.11 Pageltem.locked

app.activeDocument .pageItems[index].locked
Description

If true, this page item is locked.

Type

Boolean.

103.1.12 Pageltem.name

app.activeDocument .pageltems[index] .name
Description
The name of this page item.

Type

String.

103.1.13 Pageltem.note

app.activeDocument.pageltems[index].note
Description

The note assigned to this item.

Type

String.

103.1.14 Pageltem.opacity

app.activeDocument .pageltems[index] .opacity
Description
The opacity of this object, where 100.0 is completely opaque and 0.0 is completely transparent.

Type
Number (double).
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103.1.15 Pageltem.parent

app.activeDocument .pageltems[index] .parent
Description

The parent of this object.

Type

Object, read-only.

103.1.16 Pageltem.pixelAligned

app.activeDocument.pageltems[index].pixelAligned
Description
True if this item is aligned to the pixel grid.

Type

Boolean.

103.1.17 Pageltem.position

app.activeDocument.pageltems[index].position

Description

The position (in points) of the top left corner of the item in the format {x, y}. Does not include stroke weight.
Type

Array of 2 numbers.

103.1.18 Pageltem.selected

app.activeDocument .pageltems[index].selected
Description
If true, this object is selected.

Type

Boolean.
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103.1.19 Pageltem.sliced

app.activeDocument.pageItems[index].sliced
Description

If true, preserve slices.

Type

Boolean.

103.1.20 Pageltem.tags

app.activeDocument.pageltems[index].tags
Description
The collection of tags associated with this page item.

Type
Tags

103.1.21 Pageltem.top

app.activeDocument.pageltems[index] .top
Description
The top position of the art item.

Type
Number (double).

103.1.22 Pageltem.typename

app.activeDocument.pageltems[index] . typename
Description

The class name of the object.

Type

String, read-only.
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103.1.23 Pageltem.uRL

app.activeDocument .pageItems[index] .uRL
Description

The value of the Adobe URL tag assigned to this page item.
Type

String.

103.1.24 Pageltem.uuid

app.activeDocument.pageltems[index].uuid

Note: This functionality was added in [llustrator 24.0. (CC2020)

Description

The unique identifier for this pageltem
Type

String, read-only.

103.1.25 Pageltem.visibilityVariable

app.activeDocument.pageltems[index].visibilityVariable
Description
The visibility variable to which this page item path is bound.

Type
Variable

103.1.26 Pageltem.visibleBounds

app.activeDocument.pageltems[index].visibleBounds

Description

The object’s visible bounds, including stroke width of any objects in the illustration.

Type

Array of 4 numbers, read-only.

103.1. Properties
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103.1.27 Pageltem.width

app.activeDocument .pageltems[index] .width

Description

The width of the page item, calculated from the geometric bounds. Range: 0.0 to 16348.0.
Type

Number (double).

103.1.28 Pageltem.wraplnside

app.activeDocument.pageltems[index].wrapInside
Description

If true, the text frame object should be wrapped inside this object.
Type

Boolean.

103.1.29 Pageltem.wrapOffset

app.activeDocument.pageltems[index] .wrapOffset
Description

The offset to use when wrapping text around this object.
Type

Number (double).

103.1.30 Pageltem.wrapped

app.activeDocument.pageltems[index].wrapped

Description

If true, wrap text frame objects around this object (text frame must be above the object).
Type

Boolean.
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103.1.31 Pageltem.zOrderPosition

app.activeDocument .pageltems[index].zOrderPosition
Description

The drawing order of the art within its group or layer.

Type

Number (long), read-only.

103.2 Methods

103.2.1 Pageltem.bringinPerspective()

app.activeDocument.pageltems[index].bringInPerspective(posX, posY, perspectiveGridPlane)
Description

Places art object(s) in a perspective grid at a specified position and grid plane.

Parameters
Parameter Type Description
posX Number X position to place art at
posY Number Y position to place art at
perspectiveGridPlane | PerspectiveGridPlaneType | Perspective grid plane type to use

Returns

Returns.

103.2.2 Pageltem.resize()

app.activeDocument.pageltems[index].resize(
scaleX, scaleY [,changePositions] [,changeFillPatterns] [,changeFillGradients]
[,changeStrokePattern] [,changelLineWidths] [,scaleAbout]

Description

Scales the art item where scaleX is the horizontal scaling factor and scaleY is the vertical scaling factor. 100.0 =
100%.

Parameters
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Parameter Type Description
scaleX Number (double) Horizontal scaling factor
scaleY Number (double) Vertical scaling factor
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
changeLineWidths Number (double), optional | The amount to scale line widths
scaleAbout Transformation, optional The point to use as anchor, to transform about
Returns
Nothing.

103.2.3 Pageltem.rotate()

app.activeDocument.pageltems[index].rotate(
angle [,changePositions] [,changeFillPatterns]
[,changeFillGradients] [,changeStrokePattern] [,rotateAbout]

Description

Rotates the art item relative to the current rotation. The object is rotated counter-clockwise if the angle value is
positive, clockwise if the value is negative.

Parameters
Parameter Type Description
angle Number (double) The angle amount to rotate the element
changePositions Boolean, optional Whether to effect art object positions and orientations
changeFillPatterns Boolean, optional Whether to transform fill patterns
changeFillGradients | Boolean, optional Whether to transform fill gradients
changeStrokePattern | Boolean, optional Whether to transform stroke patterns
rotateAbout 